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Audience

Preface

Oracle TopLink Developer’s Guide explains how to use Oracle TopLink to design,
implement, deploy, and optimize an advanced persistence or object-to-XML
transformation layer for a wide range of Java 2 Enterprise Edition (J2EE) and Java
applications. It describes TopLink mapping metadata, sessions, data access, queries,
transactions (both with and without an external transaction controller), and cache.

It describes how to use TopLink application development tools and how to integrate
TopLink with a variety of J2EE containers. It also introduces the concepts with which
you should be familiar to get the most out of TopLink.

Oracle TopLink Developer’s Guide is intended for application developers creating
applications that use TopLink to manage persistence.

This document assumes that you are familiar with the concepts of object-oriented
programming, the Enterprise JavaBeans (E]B) specification, and your own particular
Java development environment.

The document also assumes that you are familiar with your particular operating
system (such as Windows, UNIX, or other). The general operation of any operating
system is described in the user documentation for that system, and is not repeated in
this manual.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation
accessible, with good usability, to the disabled community. To that end, our
documentation includes features that make information available to users of assistive
technology. This documentation is available in HTML format, and contains markup to
facilitate access by the disabled community. Accessibility standards will continue to
evolve over time, and Oracle is actively engaged with other market-leading
technology vendors to address technical obstacles so that our documentation can be
accessible to all of our customers. For more information, visit the Oracle Accessibility
Program Web site at

http://www.oracle.com/accessibility/
Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
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otherwise empty line; however, some screen readers may not always read a line of text
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or
organizations that Oracle does not own or control. Oracle neither evaluates nor makes
any representations regarding the accessibility of these Web sites.

TTY Access to Oracle Support Services

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services
within the United States of America 24 hours a day, seven days a week. For TTY
support, call 800.446.2398.

Related Documentation
For more information, see the following documents:
»  Oracle TopLink Release Notes
= Oracle Application Server Release Notes
»  Oracle TopLink Getting Started Guide
»  Oracle TopLink API Reference

Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.




Part |

Building a TopLink Application

This part describes the architecture of TopLink and how TopLink fits into your
development process. It contains the following chapters:

Chapter 1, "Understanding TopLink"

This chapter contains general information on TopLink. It discusses the TopLink
application space, development process, components, and the TopLink
metamodel.

Chapter 2, "Understanding TopLink Application Development"

This chapter contains an overview of the key stages in the TopLink development
process including choosing an application architecture and platform, object and
relational mapping, building the persistence layer, and deploying and maintaining
a TopLink application.






1

Understanding TopLink

Oracle TopLink is an advanced, object-persistence and object-transformation
framework that provides development tools and run-time capabilities that reduce
development and maintenance efforts, and increase enterprise application
functionality.

This chapter describes the following topics:

What is TopLink?

Solving the Object-Persistence Impedance Mismatch
TopLink Key Features

TopLink Application Architectures

What is TopLink?

Oracle TopLink builds high-performance applications that store persistent
object-oriented data in a relational database. It successfully transforms object-oriented
data into either relational data or Extensible Markup Language (XML) elements.

Figure 1-1 TopLink Runtime Architecture
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Solving the Object-Persistence Impedance Mismatch

Using TopLink, you can integrate persistence and object-transformation into your
application, while staying focused on your primary domain problem by taking
advantage of an efficient, flexible, and field-proven solution (see "Solving the
Object-Persistence Impedance Mismatch" on page 1-2).

TopLink is suitable for use with a wide range of Java 2 Enterprise Edition (J2EE) and
Java application architectures (see "TopLink Application Architectures" on page 1-4).
Use TopLink to design, implement, deploy, and optimize an advanced,
object-persistence and object-transformation layer that supports a variety of data
sources and formats, including the following:

= Relational-for transactional persistence of Java objects to a relational database
accessed using Java Database Connectivity (JDBC) drivers.

= Object-Relational-for transactional persistence of Java objects to special purpose
structured data source representations optimized for storage in object-relational
databases such as Oracle Database.

= Enterprise information system (EIS)—for transactional persistence of Java objects to
a nonrelational data source accessed using a J2EE Connector architecture (J2C)
adapter, and any supported EIS record type, including indexed, mapped, or XML.

s XML—-for nontransactional, nonpersistent (in-memory) conversion between Java
objects and XML Schema Document (XSD)-based XML documents using Java
Architecture for XML Binding (JAXB).

TopLink includes support for container-managed persistence (CMP) containers from a
variety of vendors—such as Oracle Containers for J2EE (OC4J), IBM WebSphere
application server, and BEA WebLogic Server-and support for base classes that
simplify bean-managed persistence (BMP) development.

The extensive suite of development tools that TopLink provides, including Oracle
TopLink Workbench, lets you quickly capture and define object-to-data source and
object-to-data representation mappings in a flexible, efficient metadata format (see
"Understanding TopLink Metadata" on page 2-19).

The TopLink runtime lets your application exploit this mapping metadata with a
simple session facade that provides in-depth support for data access, queries,
transactions (both with and without an external transaction controller), and caching.

For more information about TopLink, see "TopLink Key Features" on page 1-4.

Solving the Object-Persistence Impedance Mismatch

Java-to-data source integration is a widely underestimated problem when creating
enterprise Java applications. This complex problem involves more than simply reading
from and writing to a data source. The data source elements include tables, rows,
columns, and primary and foreign keys. The Java and J2EE include entity classes
(regular Java classes or Enterprise JavaBeans (E]B) entity beans), business rules,
complex relationships, and inheritance. In a nonrelational data source, you must
match your Java entities with EIS records or XML elements and schemas. These
differences (as shown in Figure 1-2) are known as the object-persistence impedance
mismatch.
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Solving the Object-Persistence Impedance Mismatch

Figure 1-2 Solving Object-Persistence Impedance Mismatch
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Successful solution requires bridging these different technologies, and solving the
object-persistence impedance mismatch—a challenging and resource-intensive
problem. To solve this problem, you must resolve the following issues between J2EE
and data source elements:

= Fundamentally different technologies

»  Different skill sets

= Different staff and ownership for each of the technologies
s Different modeling and design principles

Application developers need a product that enables them to integrate Java
applications with any data source, without compromising ideal application design or
data integrity. In addition, Java developers need the ability to store (that is, persist)
and retrieve business domain objects using a relational database or a nonrelational
data source as a repository.

TopLink Solution

TopLink addresses the disparity between Java objects and data sources. TopLink is a
persistence framework that manages relational, object-relational, EIS, and XML
mappings in a seamless manner. This allows developers to rapidly build applications
that combine the best aspects of object technology and the specific data source.

TopLink lets you do the following:

»  Persist Java objects to virtually any relational database supported by a
JDBC-compliant driver.

= Persist Java objects to virtually any nonrelational data source supported by a J2EE
Connector architecture (J2C) adapter using indexed, mapped, or XML enterprise
information system (EIS) records.

s Perform in-memory conversions between Java objects and XML Schema (XSD)
based XML documents using JAXB.

= Map any object model to any relational or nonrelational schema, using the Oracle
TopLink Workbench graphical mapping tool.

= Use TopLink successfully, even if you are unfamiliar with SQL or JDBC, because
TopLink offers a clear, object-oriented view of data sources.
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TopLink Key Features

TopLink provides an extensive and thorough set of features. Java developers can use
these features to rapidly build high-performance enterprise applications that are both
scalable and maintainable.

Some of the primary features of TopLink are the following:

= Nonintrusive, flexible, metadata-based architecture (see "Understanding TopLink
Metadata" on page 2-19)

= Comprehensive visual TopLink Workbench

= Advanced mapping support and flexibility (relational, object-relational, EIS, and
XML)

= Object caching support

s Query flexibility

= Just-in-time reading

= Caching

= Object-level transaction support and integration

= Locking

= Multiple performance tuning options

= Architectural flexibility

For additional information, see the TopLink page on OTN:

http://www.oracle.com/technology/products/ias/toplink/index.html

TopLink Application Architectures

You can use TopLink in a variety of application architectures, including three- and
two-tier architectures, with or without J2EE, to access a variety of data types on both
relational and nonrelational data sources.

Figure 1-3 TopLink and Your Application Architecture
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For more information on strategies for incorporating TopLink into your application
architecture, see "Designing Your Application With TopLink" on page 2-3.

This section introduces some of the following common enterprise architectures used
by TopLink applications:

s Three-Tier

The three-tier (or J2EE Web) application is one of the most common TopLink
architectures. This architecture is characterized by a server-hosted environment in
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TopLink Application Architectures

which the business logic, persistent entities, and the Oracle TopLink Foundation
Library all exist in a single Java Virtual Machine (JVM). See "Understanding the
Three-Tier Architecture” on page 2-22 for more information.

The most common example of this architecture is a simple three-tier application in
which the client browser accesses the application through servlets, JavaServer
Pages (JSP) and HTML. The presentation layer communicates with TopLink
through other Java classes in the same JVM, to provide the necessary persistence
logic. This architecture supports multiple servers in a clustered environment, but
there is no separation across JVMs from the presentation layer and the code that
invokes the persistence logic against the persistent entities using TopLink.

EJB Session Bean Facade

A popular variation on the three-tier application involves wrapping the business
logic, including the TopLink access, in E]B session beans. This architecture
provides a scalable deployment and includes integration with transaction services
from the host application server. See "Understanding the EJB Session Bean Facade
Architecture" on page 2-25 for more information.

Communication from the presentation layer occurs through calls to the EJB session
beans. This architecture separates the application into different tiers for the
deployment. The session bean architecture can persist either Java objects or EJB
entity beans.

EJB 3.0 Entities with JPA

The E]JB 3.0 specification includes an additional persistence specification called the
Java Persistence API (JPA). You can use this API for creating, removing and
querying across lightweight Java objects both within a compliant EJB 3.0 container
and a standard Java SE 5 environment.

TopLink Essentials is the open-source community edition of TopLink. It provides
the JPA functionality for the EJB 3.0 reference implementation.

Note: TopLink Essentials is the default JPA implementation in OC4J.

When using TopLink JPA, you can access the API through extensions. The
extensions allow you to reach down to the TopLink API and modify the JPA
implementation.

To obtain more information, see the following;:

— http://www.oracle.com/technology/products/ias/toplink/jpa/in
dex.html.

- "Understanding the E]JB 3.0 JPA Entity Architecture" on page 2-33.
EJB Entity Beans with CMP

TopLink provides CMP support for applications that require the use of EJB entity
beans. This support is available on the leading application servers. TopLink CMP
support provides you with an EJB 1.0, 1.1, 2.0 and 2.1 CMP solution transparent to
the application code, but still offers all the TopLink run-time benefits. See
"Understanding the E]JB Entity Beans With CMP Architecture" on page 2-27 for
more information.

Applications can access TopLink-enabled entity beans with container-managed
persistence directly from the client, or from within a session bean layer. TopLink
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also offers the ability to use regular Java objects in relationships with enterprise
entity beans.

Note: Even though TopLink fully supports EJB 1.0, 1.1, 2.0, 2.1 and,
preliminarily EJB 3.0, this version of Oracle TopLink Developer’s
Guide only focuses on EJB 2.0 and 2.1. For detailed information on
TopLink support for EJB 1.0 and 1.1, refer to the earlier versions of
Oracle TopLink Developer’s Guide.

= EJB Entity Beans with BMP

Another option for using E]JB entity beans is to use TopLink BMP in the
application. This architecture enables developers to access the persistent data
through the EJB application programming interface (API), but is platform
independent. See "Understanding the EJB Entity Beans With BMP Architecture” on
page 2-31 for complete information.

The BMP approach is portable-that is, after you create an application, you can
move it from one application server platform to another.

s Web Services

A Web services architecture is similar to the three-tier or session-bean architecture.
However, in a Web services architecture you encapsulate business logic (the
service) in a Web service instead of (or in addition to) using session beans. In a
Web services architecture, clients communicate with your application using XML.

As in any architecture, you can use TopLink to persist objects to relational or EIS
data sources. However, in a Web services architecture you can also use TopLink to
map your object model to an XML schema for use with the Web service or as the
Web service XML serializer.

See "Understanding the Web Services Architecture" on page 2-35 for more
information

s Two-Tier

A two-tier (or client/server) application is one in which the TopLink application
accesses the database directly. Although less common than the other architectures
discussed here, TopLink supports this architecture for smaller or embedded data
processing applications. See "Understanding the Two-Tier Architecture" on

page 2-24 for more information.

1-6 Oracle TopLink Developer’s Guide



2

Understanding TopLink
Application Development

This chapter describes how to build a TopLink application, including suggested
development processes, architectures, and technologies.

This chapter includes information on the following topics:

Developing Your Application With TopLink

Designing Your Application With TopLink

Selecting an Architecture With TopLink

Building and Using the Persistence Layer

Deploying the Application

Optimizing and Customizing the Application
Troubleshooting the Application

Understanding Object Persistence

Understanding TopLink Metadata

Understanding the Three-Tier Architecture

Understanding the Two-Tier Architecture

Understanding the EJB Session Bean Facade Architecture
Understanding the EJB Entity Beans With CMP Architecture
Understanding the EJB Entity Beans With BMP Architecture
Understanding the Web Services Architecture

Developing Your Application With TopLink

To ensure the best design for your TopLink application, Oracle recommends that you
follow an iterative step-by-step development process. The flexibility of TopLink lets
you use any development tool.

This section describes following recommended development process:

Typical Development Stages
Oracle Development Support
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Typical Development Stages

This section describes the general development stages of a TopLink application.
Figure 21 illustrates the TopLink development process.

Figure 2—1 TopLink Development Process

1 Define the application requirements.

Create an object model.

2 Create Java classes.

Create new or integrate existing data source.

3 Import classes and data source into
Cracle TopLink Mapping Workbench.

Create descriptors and mappings.

4 Create database sessions.

Query and update data source information.

5 Generate deployment files.
Package and deploy the application.
|ﬂ 6 Customize and optimize.

Design the Application (1)

Define your application requirements, select an architecture, and determine the target
platform. See "Designing Your Application With TopLink" on page 2-3 for more
information. Remember, TopLink works with any architecture and any platform.

When designing the application, you should also create an object model for the
application. See "Understanding Object Persistence" on page 2-16 for more
information. It is important to create the object model before using TopLink to map
objects, because defining persistent mappings for an incorrect or rapidly changing
model can be very difficult.

Develop the Application (2, 3, 4)

Create the Java classes and decide how the classes should be implemented by the data
source. When working with a legacy system, decide how the classes relate to the
existing data. If there is no legacy data source to integrate, decide how to store each
class in the data source and create the required schema. Alternatively, you may use
TopLink to create your initial tables.

Using TopLink Workbench, create descriptors and mappings for the persistent classes.
Use TopLink sessions to manipulate the persistent classes, including querying and
changing data. See Part II, "Using TopLink Development Tools" for more information.

Avoid building all your model's descriptors in a single iteration. Start with a small
subset of your classes. Build and test their descriptors, then gradually add new
descriptors and relationships. This lets you catch common problems before they
proliferate through your entire design.
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Write Java code to use database sessions. Sessions are used to query for database
objects and write objects to the database. See Chapter 72, "Understanding TopLink
Sessions" for more information.

Deploy the Application (5)

Generate, package, then deploy the necessary files to your application server. The
required information will vary, depending on your environment and architecture. See
Part I1I, "Deploying a TopLink Application" for more information.

Maintain the Application (6)

TopLink includes many options that can enhance application performance. You can
customize most aspects of TopLink to suit your requirements. Use advanced TopLink
features or write custom querying routines to access the database in specific ways, and
to optimize performance. See Part IV, "Optimizing and Customizing a TopLink
Application” for more information.

Oracle Development Support

Oracle provides additional support for you as a TopLink developer on the Oracle
Technology Network (OTN), including the following:

= Metalink support

= Discussion forums
=  How-to documents
= Examples

You must register online before using OTN; registration is free of charge and can be
done at

http://www.oracle.com/technology/membership

If you already have a user name and password for OTN, then you can go directly to
the documentation section of the OTN Web site at
http://www.oracle.com/technology/docs

Using your OTN user name and password, you can also access the TopLink
developer’s forum to post questions and get answers about using TopLink at

http://forums.oracle.com/forums/forum.jsp?forum=48

Designing Your Application With TopLink

When you design your application, you must choose how and where to use TopLink.
You can use TopLink to perform a variety of persistence and data transformation
functions (see "Understanding TopLink Usage" on page 2-3) on a variety of
Java-supporting platforms (see "Understanding Target Platforms" on page 2-5). When
you design your application architecture, keep these capabilities in mind (see
"Selecting an Architecture With TopLink" on page 2-5).

Understanding TopLink Usage

This section describes the basic ways in which you can use TopLink, including the
following usage types:
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= Relational Database Usage

s Object-Relational Database Usage

= Oracle XML Database (XDB) Usage

= Enterprise Information System (EIS) Usage
s XML Usage

Relational Database Usage
You can use TopLink to persist Java objects to relational databases that support SQL
data types accessed using JDBC.

For more information, see "Building Relational Projects for a Relational Database" on
page 17-6.

Object-Relational Database Usage

You can use TopLink to persist Java objects to object-relational databases that support
data types specialized for object storage (such as Oracle Database) accessed using
JDBC.

For more information, see "Building Relational Projects for a Relational Database" on
page 17-6.

Oracle XML Database (XDB) Usage
You can use TopLink to persist XML documents to an Oracle XML database using
TopLink direct-to-XMLType mappings.

For more information, see "Relational Projects" on page 17-6 and "Direct-to-XMLType
Mapping" on page 33-4.

Enterprise Information System (EIS) Usage

You can use TopLink to persist Java objects to an EIS data source using a J2C adapter.
In this scenario, the application invokes EIS data source-defined operations by sending
EIS interactions to the J2C adapter. Operations can take (and return) EIS records.

Using TopLink EIS descriptors and mappings, you can easily map Java objects to the
EIS record types supported by your J2C adapter and EIS data source.

This usage is common in applications that connect to legacy data sources and is also
applicable to Web services.

For more information, see "EIS Projects" on page 17-7.

XML Usage

You can use TopLink for in-memory, nonpersistent Java object-to-XML transformation
with XML Schema (XSD) based XML documents and JAXB.

You can use the TopLink JAXB compiler with your XSD to generate both JAXB-specific
artifacts (such as content and element interfaces, implementation classes, and object
factory class) and TopLink-specific artifacts (such as sessions and project XML files
and TopLink Workbench project). For more information, see "TopLink Support for Java
Architecture for XML Binding (JAXB)" on page 17-10.

This usage has many applications, including messaging and Web services.

For more information, see "XML Projects" on page 17-9.
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Understanding Target Platforms

TopLink supports any enterprise architecture that uses Java, including the following:

= Java application servers and J2EE containers, such as Oracle Application Server
and Oracle Containers for J2EE (OC4]J)

» Java-supporting databases, such as Oracle Database
= Java-compatible browsers, such as Netscape and Internet Explorer
»  Server Java platforms, such as AS/400, OS/390, and UNIX

Application packaging requirements of the specific target platform (for deployment in
the host Java or J2EE environment) influences how you use and configure TopLink.
For example, you package a J2EE application in an Enterprise Archive (EAR) file.
Within the EAR file, there are several ways to package persistent entities within Web
Archive (WAR) and Java Archive (JAR). How you configure TopLink depends, in part,
on how you package the application and how you use the host application server class
loader.

In addition, TopLink provides custom CMP integration for a variety of application
servers.

For detailed information about supported application server versions, custom
integration, and configuration requirements, see "Integrating TopLink With an
Application Server" on page 7-1.

Selecting an Architecture With TopLink

Tiers

This section describes some of the key aspects of application architecture that apply to
TopLink and discusses the various options available for each, including the following:

s Tiers

m  Service Layer
s Data Access
s Caching

s Locking

This section describes choices you need to make when deciding on how to separate
client and server functionality in your application architecture.

These choices can be summarized as follows:
n  Three Tier
— J2EE or Non-J2EE
— Client
*  Web client
*  XML/Web service client
*  Java (fat) client

s Two Tier
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Three Tier

Oracle recommends a three-tier application architecture. With a three-tier architecture,
Oracle recommends using TopLink server sessions and client sessions (see "Server and
Client Sessions" on page 72-14) and the TopLink unit of work (see Chapter 97,
"Understanding TopLink Transactions").

For more information, see "Understanding the Three-Tier Architecture" on page 2-22.

J2EE or Non-J2EE You can use TopLink in a J2EE or non-J2EE application architecture.
Oracle recommends that you use a J2EE application architecture.

With a J2EE application, you should use external connection pools (see "External
Connection Pools" on page 81-8). You may consider using Java Transaction API (JTA)
integration (see "JTA Controlled Transactions" on page 97-3), EJB session and /or entity
beans.

With a non-J2EE application, you should use internal connection pools (see "Internal
Connection Pools" on page 81-7).

Client In a three-tier application architecture, you can implement any of the following
types of client:

= Web client-Oracle recommends that you implement a Web client.

= XML/Web service client-With this client type, you can use TopLink XML (see
"XML Usage" on page 2-4).

= Java (fat) client-With this client type, you can choose the means of communicating
with the server:

- EJB session beans—Oracle recommends this approach. You may consider using
the UnitOfWork method mergeClone to handle merging deserialized
objects (see "Merging Changes in Working Copy Clones" on page 99-13). The
disadvantage of this approach is that your application must handle
serialization. Avoid serializing deep object graphs. You should use indirection
(see "Configuring Indirection" on page 32-3). Consider using the
data-transfer-object pattern.

- XML/Web service-Use TopLink XML (see "XML Usage" on page 2-4).

- EJB entity bean-Use TopLink CMP integration or BMP support. The
disadvantage of this approach is that remote entity beans may not perform or
scale well.

- RMI-You may consider using a TopLink remote session (see "Remote
Sessions" on page 72-30). The disadvantage of this approach is that a remote
session is stateful and may not scale well.

See also "Service Layer" on page 2-7.

Two Tier

With a two-tier application architecture, Oracle recommends using TopLink database
sessions (see "Database Sessions" on page 72-29) and the TopLink unit of work (see
Chapter 97, "Understanding TopLink Transactions"). The disadvantages of this
architecture are that it is not Web-enabled and does not scale well to large
deployments.

For more information, see "Understanding the Two-Tier Architecture" on page 2-24.
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Service Layer

This section describes choices you need to make when deciding on how to encapsulate
your application’s business logic (or service).

These choices can be summarized as follows:
=  EJB Session Beans
— Stateful
— Stateless
= EJB Entity Beans
- Container-Managed Persistence (CMP)
— Bean-Managed Persistence (BMP)
= EJB 3.0 JPA Entities
= Plain Old Java Objects (POJO)
See also:
s "Data Access" on page 2-9
s "Caching" on page 2-9.

EJB Session Beans
Oracle recommends using EJB session beans.

With EJB session beans, you should use JTA integration (see "JTA Controlled
Transactions" on page 97-3) and external connection pools (see "External Connection
Pools" on page 81-8). You should acquire a unit of work using Server method
getActiveUnitOfWork (see "Acquiring a Unit of Work With an External Transaction
Service" on page 99-21). If your session bean and data source are not in the same JVM,
you may consider using UnitOfWork method mergeClone to handle merging
deserialized objects (see "Merging Changes in Working Copy Clones" on page 99-13).

For more information, see "Understanding the E]B Session Bean Facade Architecture”
on page 2-25.

Stateful If you are using stateful session beans, then note that a reference to a client
session cannot be passivated. In this case, you must reacquire a client session (see
"Acquiring a Session at Run Time With the Session Manager" on page 72-5) on activate
or per request.

Stateless If you are using stateless session beans, you must acquire new client session
(see "Acquiring a Session at Run Time With the Session Manager" on page 72-5) for
each request.

EJB Entity Beans

EJB entity bean architectures are slightly different from other TopLink architectures,
because the EJB entity bean interfaces hide TopLink functionality completely from the
client application developer.

You can use entity beans in almost any J2EE application. For TopLink, how the
application uses the entity beans is not important; how entity beans are mapped and
implemented is important to TopLink.
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Container-Managed Persistence (CMP) Oracle recommends using entity beans with
container-managed persistence. In this case, you should use the TopLink CMP
integration for your application server. You must ensure that you are using a J2EE
server that TopLink supports (see "Integrating TopLink With an Application Server" on
page 7-1).

For more information, see "Understanding the EJB Entity Beans With CMP
Architecture" on page 2-27.

Bean-Managed Persistence (BMP) If you are using entity beans with bean-managed
persistence, you should use the TopLink BMP integration. The disadvantages of this
architecture are that the BMP architecture is restrictive and may not provide good
performance.

For more information, see "Understanding the E]JB Entity Beans With BMP
Architecture" on page 2-31.

EJB 3.0 JPA Entities

EJB 3.0 Java Persistence API (JPA) is a specification for persistence in Java EE and SE
applications. In JPA, a persistent class is referred to as an entity. An entity is a plain
old Java object (POJO) class (see "Plain Old Java Objects (POJO)" on page 2-8) that is
mapped to the database and configured for usage through JPA using annotations
and/or XML.

With JPA, when your application is running inside a container, all of the benefits of
the container support and ease of use apply. Note that you can configure the same
application to run outside the container.

You can use session beans (see "E]JB Session Beans" on page 2-7) as the means for your
application to interact with JPA.

If you choose to use JPA for your application development, consider the following
options:

= TopLink Essentials—the open-source community edition of TopLink. TopLink
Essentials is derived from TopLink providing core object-relational mapping
functionality necessary for the reference implementation of JPA in E]B 3.0.
TopLink Essentials is available in source and binary distributions as the
entity-persistence module of GlassFish Open Source Java EE 5 Application Server.

s  TopLink-a commercial implementation that provides the preview functionality of
JPA.

Both options provide excellent support for this new standard, as well as additional
functionality and performance benefits.

For more information, see "Understanding the EJB 3.0 JPA Entity Architecture” on
page 2-33 and "TopLink Application Architectures" on page 1-4.

Plain Old Java Objects (POJO)

If you choose to build your service layer with non-EJB Java objects with a J2EE
application server, you should use external connection pools (see "External Connection
Pools" on page 81-8). If you use a non-J2EE Web server, you should use internal
connection pools (see "Internal Connection Pools" on page 81-7). In either case, you
may consider using JTA integration (see "JTA Controlled Transactions" on page 97-3).
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Data Access

Caching

This section describes choices you need to make when deciding on what type of data
your application architecture must support.

These choices can be summarized as follows:
= Data Type

= Multiple Data Sources

= Isolating Data Access

»  Historical Data Access

See also "Locking" on page 2-11.

Data Type

You can use TopLink to manage any of the following types of data:

= relational (see "Relational Database Usage" on page 2-4)

= object-relational (see "Object-Relational Database Usage" on page 2-4)
= Oracle XDB (see "Oracle XML Database (XDB) Usage" on page 2-4)

»  EIS, nonrelational, legacy data (see "Enterprise Information System (EIS) Usage"
on page 2-4)

= XML and Web service data (see "XML Usage" on page 2-4)

Multiple Data Sources

If your application architecture must access more than one data source, Oracle
recommends that you use a session broker (see "Session Broker and Client Sessions" on
page 72-26) and JTA integration (see "JTA Controlled Transactions" on page 97-3) for
two-phase commit.

Alternatively, you may use multiple sessions.

Isolating Data Access

If your application architecture requires that some data be restricted to a private cache
and isolated from the TopLink shared session cache, Oracle recommends that you use
an isolated session (see "Isolated Client Sessions" on page 72-19). You can also use an
isolated session with the Oracle Virtual Private Database (VPD) feature (see "Isolated
Client Sessions and Oracle Virtual Private Database (VPD)" on page 72-21).

Historical Data Access

If your data source maintains past or historical versions of objects, Oracle recommends
that you use a TopLink historical session (see "Historical Sessions" on page 72-25) to
access this historical data so that you can express read queries conditional on how
your objects are changing over time.

This section describes choices you need to make when deciding on how to use the
TopLink cache (see Chapter 87, "Understanding the Cache") in your application
architecture.

These choices can be summarized as follows:

»s  Cache Type
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= Refreshing

»  Cache Coordination
— Protocol
- Synchronization

See also "Locking" on page 2-11.

Cache Type

Choose a cache type (see "Cache Type and Object Identity" on page 87-3) appropriate
for the type of data your application processes. For example, consider a weak identity
map for volatile data (see "Guidelines for Configuring the Cache and Identity Maps"
on page 87-4).

Refreshing

Consider how your application architecture may be affected by stale data (see
"Handling Stale Data" on page 87-6): for example, consider using query or descriptor
refresh options (see "Refreshing" on page 2-10) or cache invalidation (see "Cache
Invalidation" on page 87-8). Consider using an isolated session’s cache (see "Isolated
Client Sessions" on page 72-19) for volatile data.

Avoid using no identity map (see"No Identity Map" on page 87-4) for objects that are
involved in relationships or that require object identity.

Cache Coordination

TopLink provides a distributed cache coordination feature that allows multiple,
possibly distributed, instances of a session to broadcast object changes among each
other so that each session’s cache is kept up to date (see "Understanding Cache
Coordination" on page 87-10). Before using cache coordination, ensure that it is
appropriate for your application (see "When to use Cache Coordination" on

page 87-11).

Protocol You can configure a coordinated cache to broadcast changes using any of the
following communication protocols:

» Java Message Service (JMS)-Oracle recommends using a JMS coordinated cache
(see "JMS Coordinated Cache" on page 87-12).

= Remote Method Invocation (RMI)-Oracle recommends that you use RMI cache
coordination only if you require synchronous change propagation (see
"Configuring the Synchronous Change Propagation Mode" on page 88-2). For
more information, see "RMI Coordinated Cache" on page 87-12.

= Common Object Request Broker Architecture (CORBA)-Currently, TopLink
provides support for the Sun ORB (see "CORBA Coordinated Cache" on
page 87-13).

Synchronization You can configure synchronization strategy that a coordinated cache
uses to determine what it broadcasts when an object changes. You can configure this at
the project (see "Configuring Cache Coordination Change Propagation at the Project
Level" on page 19-17) or descriptor ("Configuring Cache Coordination Change
Propagation at the Descriptor Level" on page 25-40) level as follows:

» invalidate changed objects—Propagate an object invalidation that marks the object
as invalid in all other sessions. This tells other sessions that they must update their
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Locking

cache from the data source the next time this object is read. Oracle recommends
using this synchronization strategy.

= synchronize changes-Propagate a change notification that contains each changed
attribute.

= synchronize changes and new objects—Propagate a change notification that
contains each changed attribute. For new objects, propagate an object creation
(along with all the new instance’s attributes).

This section describes choices you need to make when deciding on how to use
TopLink locking options in your application architecture. Oracle strongly recommends
always using a locking policy in a concurrent system (see "Configuring Locking
Policy" on page 25-64).

These choices can be summarized as follows:
s Optimistic Locking
s Pessimistic Locking

If you are building a three-tier application, be aware of how that architecture affects
the way you use locking (see "Locking in a Three-Tier Application" on page 23-22).

For more information, see "Understanding Descriptors and Locking" on page 23-18.

Optimistic Locking

Oracle recommends using TopLink optimistic locking. With optimistic locking, all
users have read access to the data. When a user attempts to write a change, the
application checks to ensure the data has not changed since the user read the data.

You can use version (see "Optimistic Version Locking Policies” on page 23-18) or field
(see "Optimistic Field Locking Policies" on page 23-20) locking policies. Oracle
recommends using version locking policies.

Pessimistic Locking

With pessimistic locking, the first user who accesses the data with the purpose of
updating it locks the data until completing the update. The disadvantage of this
approach is that it may lead to reduced concurrency and deadlocks.

Consider using pessimistic locking support at the query level (see "Configuring
Named Query Options" on page 25-22).

If are using CMP, you may consider using bean-level pessimistic locking support (see
"Configuring Named Query Options" on page 25-22).

Building and Using the Persistence Layer

Oracle TopLink requires that classes must meet certain minimum requirements before
they can become persistent. TopLink also provides alternatives to most requirements.
TopLink uses a nonintrusive approach by employing a metadata architecture that
allows for minimal object model intrusions.

This section includes the following information:
= Implementation Options

»  Persistent Class Requirements
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»  Persistence Layer Components

= Using the Persistence Layer

Implementation Options

Persistence layer components may be generated as metadata (see "Understanding
TopLink Metadata" on page 2-19) from TopLink Workbench, or expressed as Java
classes.

Oracle recommends using TopLink Workbench to create the necessary metadata
(stored as XML). You can easily export and update the project .xml and
sessions.xml files. This reduces development effort by eliminating the need to
regenerate and recompile Java code each time you change the project. With TopLink
Workbench, you write Java code only for your own application classes and any
necessary amendment methods. For information about the XML structure of the
project.xml and sessions.xmnl files, refer to the appropriate XML schemas (XSD)
in the <TOPLINK_ HOME>\config\xsds directory.

To use Java code, you must manually write code for each element of the TopLink
project including: project, login, platform, descriptors, and mappings. This may be
more efficient if your application is model-based and relies heavily on code
generation. Depending on the type of project you are creating, TopLink Workbench
can export Java code for projects, tables, and your model source (see "Exporting Project
Information" on page 18-13).

Persistent Class Requirements

The following requirements apply to plain Java objects.

Note: for EJB 2.0 entity beans with container-managed persistence,
the bean requirements are defined by the EJB 2.0 specification; for E]B
2.1 entity beans with container-managed persistence, the bean
requirements are defined by the EJB 2.1 specification.

You can use direct access on private or protected attributes. For more information on
direct and method access, see "Configuring Method Accessing" on page 32-14.

When using nontransparent indirection, the attributes must be of the type
ValueHolderInterface rather than the original attribute type. The value holder
does not instantiate a referenced object until it is needed.

TopLink provides transparent indirection for Collection, List, Set, and Map
attribute types for any collection mappings. Using transparent indirection does not
require the use of the ValueHolderInterface or any other object model
requirements.

See "Indirection" on page 30-5 for more information on indirection and transparent
indirection.

Persistence Layer Components

Typically, the TopLink persistence layer contains the following components:
=  Mapping Metadata
= Session Metadata

m  Cache
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s Queries and Expressions

s Transactions

Mapping Metadata

The TopLink application metadata model is based on the TopLink project. The project
includes descriptors, mappings, and various policies that customize the run-time
capabilities. You associate this mapping and configuration information with a
particular data source and application by referencing the project from a session.

For more information, see the following:

s "Creating Project Metadata" on page 2-20
s Chapter 17, "Understanding Projects"

s Chapter 23, "Understanding Descriptors"
s Chapter 30, "Understanding Mappings"

Session Metadata

A session is the primary interface between the client application and TopLink, and
represents the connection to the underlying data source.

TopLink offers several different session types (see Chapter 72, "Understanding
TopLink Sessions"), each optimized for different design requirements and
architectures. The most commonly used session is the server session, a session that
clients access on the server through a client session. The server session provides a
shared cache and shared connection resources. You define a session with session
metadata.

For CMP projects, the TopLink run-time creates and uses a session internally, but your
application does not acquire or use this session directly. Depending on the application
server you use, you can specify some of the parameters for this internal session.

For more information, see the following:
= "Creating Session Metadata" on page 2-21

= "Using the Persistence Layer" on page 2-14

Cache

By default, a TopLink session provides an object-level cache that guarantees object
identity and enhances performance by reducing the number of times the application
needs to access the data source. TopLink provides a variety of cache options, including
locking, refresh, invalidation, isolation, and coordination. Using cache coordination,
you can configure TopLink to synchronize changes with other instances of the
deployed application. You configure most cache options at the session level. You can
also configure cache options on a per-query basis or on a descriptor to apply to all
queries on the reference class.

For more information, see Chapter 87, "Understanding the Cache".

Queries and Expressions

TopLink provides several object and data query types, and offers flexible options for
query selection criteria, including the following:

s TopLink expressions

= EJB Query Language (QL)
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= SQL
»  Stored procedures
= Query by example

With these options, you can build any type of query. Oracle recommends using
predefined queries to define application queries. Predefined queries are held in the
project metadata and referenced by name. This simplifies application development
and encapsulates the queries to reduce maintenance costs.

When using entity beans, you can code finders completely using EJB QL (in addition
to any of the other TopLink query options), enabling the application to comply with
the J2EE specification.

Regardless of the architecture or persistent entity type, you are free to use any of the
query options. TopLink Workbench provides the simplest way to define queries.
Alternatively, you can build queries in code, using the TopLink APL

For more information, see Chapter 93, "Understanding TopLink Queries" and
Chapter 95, "Understanding TopLink Expressions".

Transactions

TopLink provides the ability to write transactional code isolated from the underlying
database and schema by using a unit of work, a specific transactional session.

The unit of work isolates changes in a transaction from other threads until it
successfully commits the changes to the database. Unlike other transaction
mechanisms, the unit of work automatically manages changes to the objects in the
transaction, the order of the changes, and changes that might invalidate other TopLink
caches. The unit of work manages these issues by calculating a minimal change set,
ordering the database calls to comply with referential integrity rules and deadlock
avoidance, and merging changed objects into the shared cache. In a clustered
environment, the unit of work also synchronizes changes with the other servers in the
coordinated cache.

If an application uses entity beans, you do not access the unit of work API directly, but
you still benefit from its features: the integration between the TopLink runtime and
the J2EE container automatically uses the unit of work to the application’s best
advantage.

For more information, see Chapter 93, "Understanding TopLink Queries".

Using the Persistence Layer

At run time, your application uses the TopLink metadata (see "Understanding TopLink
Metadata" on page 2-19).

For a non-CMP project, your application loads a session.xml file at run time using
the session manager (see Chapter 75, "Acquiring and Using Sessions at Run Time").
The session.xml file contains a reference to the mapping metadata project .xml
file. Using the session, your application accesses the TopLink runtime and the
project.xml mapping metadata.

For a CMP project, the metadata required is dependent upon the J2EE application
server you deploy your application to (see "Creating TopLink Files for Deployment" on
page 8-1). All application servers require an ejb-jar.xml and a TopLink project
XML file. The session configuration is dependent on the specific J2EE application
server.
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Deploying the Application

Application packaging (for deployment in the host Java or J2EE environment)
influences TopLink use and configuration. For example, you package a J2EE
application in an EAR file. Within the EAR file, there are several ways to package
persistent entities within WAR and JAR. How you configure TopLink depends, in
part, on how you package the application and how you use the class loader of the host
application server.

This section discusses packaging and deployment from a TopLink perspective.
However, if you deploy your application to a J2EE container, you must configure
elements of your application to enable TopLink container support.

This section includes the following information:
= Understanding Deployments
= TopLinkin a J2EE Application

For more information, see Part III, "Deploying a TopLink Application".

Understanding Deployments

The TopLink approach to deployment involves packaging application files into a
single file, such as aJAR file, or an EAR file. This approach lets you create clean and
self-contained deployments that do not require significant file management.

After creating these files, deploy the project.

TopLink in a J2EE Application

Although TopLink is an integral part of a J2EE application, in most cases the client
does not interact with TopLink directly. Instead, TopLink features are invoked
indirectly by way of E]B container callbacks.

As a result, the typical deployment process involves the following steps:

1. Build the project elements, including beans, classes, and data sources.

2. Define the application mappings in TopLink Workbench.

3. Build the application deployment files. Use TopLink Workbench to create the files.
4. Package and deploy the application.

5. Add code to the client application to enable it to access the TopLink application.

Optimizing and Customizing the Application

TopLink provides a diverse set of features to optimize performance including the
following:

= Enhancing queries
s Tuning the cache
= Scaling to multiple server configuration

You enable or disable most features in the descriptors or session, making any resulting
performance gains global.

Using TopLink EIS (see "Enterprise Information System (EIS) Usage" on page 2-4), you
can integrate a TopLink application with legacy data sources using a J2C adapter. This
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is the most efficient way to customize a TopLink application to accommodate unusual
or nonstandard systems.

Using TopLink XML (see "XML Usage" on page 2-4), you can integrate a TopLink
application with legacy data sources using a Web service.

See Part IV, "Optimizing and Customizing a TopLink Application" for details on
optimizing and customizing TopLink.

Troubleshooting the Application

See Part V, "Troubleshooting a TopLink Application" for detailed information on
troubleshooting all aspects of a TopLink application including development and
deployment.

Understanding Object Persistence

This section includes a brief description of relational mapping and provides important
information and restrictions to guide object and relational modeling. This information
is useful when building TopLink applications.

This section includes information on the following:
= Application Object Model

= Data Storage Schema

= Primary Keys and Object Identity

= Mappings

= Foreign Keys and Object Relationships
= Inheritance

= Concurrency

= Caching

= Nonintrusive Persistence

= Indirection

These sections contain additional detail on these features, and explain how to
implement and use them with TopLink.

Application Object Model

Object modeling refers to the design of the Java classes that represent your application
objects. With TopLink, you can use your favorite integrated development environment
(IDE) or Unified Modeling Language (UML) modeling tool to define and create your
application object model.

Any class that registers a descriptor with a TopLink database session is called a
persistent class. TopLink does not require that persistent classes provide public
accessor methods for any private or protected attributes stored in the database. Refer
to "Persistent Class Requirements" on page 2-12 for more information.
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Data Storage Schema

Your data storage schema refers to the design that you implement to organize the
persistent data in your application. This schema refers to the data itself-not the actual
data source (such as a relational database or nonrelational legacy system).

During the design phase of the TopLink application development process (see "Typical
Development Stages" on page 2-2), you should decide how to implement the classes in
the data source. When integrating existing data source information, you must
determine how the classes relate to the existing data. If no legacy information exists to
integrate, decide how you will store each class, then create the necessary schema.

You can also use TopLink Workbench (see Chapter 4) or database schema manager (see
Chapter 5) to create the necessary information.

Primary Keys and Object Identity

When making objects persistent, each object requires an identity to uniquely identify it
for storage and retrieval. Object identity is typically implemented using a unique
primary key. This key is used internally by TopLink to identify each object, and to
create and manage references. Violating object identity can corrupt the object model.

In a Java application, object identity is preserved if each object in memory is
represented by one, and only one, object instance. Multiple retrievals of the same
object return references to the same object instance-not multiple copies of the same
object.

TopLink supports multiple identity maps to maintain object identity (including
composite primary keys). Refer to "Cache Type and Object Identity" on page 87-3 for
additional information.

Mappings
TopLink uses the metadata produced by TopLink Workbench (see "Understanding
TopLink Metadata" on page 2-19) to describe how objects and beans map to the data

source. This approach isolates persistence information from the object model-you are
free to design their ideal object model, and DBAs are free to design their ideal schema.

You use TopLink Workbench to create and manage the mapping information. At run
time, TopLink uses the metadata to seamlessly and dynamically interact with the data
source, as required by the application.

TopLink provides an extensive mapping hierarchy that supports the wide variety of
data types and references that an object model might contain. For more information,
see Chapter 30, "Understanding Mappings".

Foreign Keys and Object Relationships

A foreign key is a combination of columns that reference a unique key, usually the
primary key, in another table. Foreign keys can be any number of fields (similar to
primary key), all of which are treated as a unit. A foreign key and the primary parent
key it references must have the same number and type of fields.

Foreign keys represents relationships from a column or columns in one table to a
column or columns in another table. For example, if every Employee has an attribute
address that contains an instance of Address (which has its own descriptor and
table), the one-to-one mapping for the address attribute would specify foreign key
information to find an address for a particular Employee.
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Inheritance

Concurrency

Caching

Refer to "Configuring Table and Field References (Foreign and Target Foreign Keys)"
on page 34-8 for more information.

Object-oriented systems allow classes to be defined in terms of other classes. For
example: motorcycles, sedans, and vans are all kinds of vehicles. Each of the vehicle
types is a subclass of the Vehicle class. Similarly, the Vehicle class is the superclass
of each specific vehicle type. Each subclass inherits attributes and methods from its
superclass (in addition to having its own attributes and methods).

Inheritance provides several application benefits, including the following:

= Using subclasses to provide specialized behaviors from the basis of common
elements provided by the superclass. By using inheritance, you can reuse the code
in the superclass many times.

= Implementing abstract superclasses that define generic behaviors. This abstract
superclass may define and partially implement behavior, while allowing you to
complete the details with specialized subclasses.

Refer to "Configuring Inheritance for a Child (Branch or Leaf) Class Descriptor” on
page 25-51 and "Configuring Inherited Attribute Mapping in a Subclass" on page 25-58
for detailed information on using inheritance with TopLink.

To have concurrent clients logged in at the same time, the server must spawn a
dedicated thread of execution for each client. J2EE application servers do this
automatically. Dedicated threads enable each client to work without having to wait for
the completion of other clients. TopLink ensures that these threads do not interfere
with each other when they make changes to the identity map or perform database
transactions.

Using the TopLink UnitOfWork class, your client can make transactional changes in
an isolated and thread safe manner. The unit of work manages clones for the objects
you modify to isolate each client’s work from other concurrent clients and threads. The
unit of work is essentially an object-level transaction mechanism that maintains all of
the ACID (Atomicity, Consistency, Isolation, Durability) transaction principles as a
database transaction. For more information on the unit of work, see Chapter 97,
"Understanding TopLink Transactions".

TopLink supports configurable optimistic and pessimistic locking strategies to let you
customize the type of locking that the TopLink concurrency manager uses. For more
information, see "Understanding Descriptors and Locking" on page 23-18.

TopLink caching improves application performance by automatically storing data
returned as objects from the database for future use. This caching provides several
advantages:

= Reusing Java objects that have been previously read from the database minimizes
database access

»  Minimizing SQL calls to the database when objects already exist in the cache
= Minimizing network access to the database

= Setting caching policies a class-by-class and bean-by-bean basis
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= Basing caching options and behavior on Java garbage collection

TopLink supports several caching polices to provide extensive flexibility. You can
fine-tune the cache for maximum performance, based on individual application
performance. Refer to Part XVII, "Cache" for complete information.

Nonintrusive Persistence

Indirection

The TopLink nonintrusive approach of achieving persistence through a metadata
architecture (see "Understanding TopLink Metadata" on page 2-19) means that there
are almost no object model intrusions.

To persist Java objects, TopLink does not require any of the following:
s Persistent superclass or implementation of persistent interfaces

»  Store, delete, or load methods required in the object model

= Special persistence methods

= Generating source code into or wrapping the object model

When using entity beans with container-managed persistence, TopLink does not
require any additional intrusion to the object model, other than the CMP specification
requirements.

See "Building and Using the Persistence Layer" on page 2-11 for additional information
on this nonintrusive approach.

An indirection object takes the place of an application object so the application object is
not read from the database until it is needed. Using indirection allows TopLink to
create stand-ins for related objects. This results in significant performance
improvements, especially when the application requires the contents of only the
retrieved object rather than all related objects.

Without indirection, each time the application retrieves a persistent object, it also
retrieves all the objects referenced by that object. This may result in lower performance
for some applications.

Note: Oracle strongly recommends that you use indirection in all
situations.

TopLink provides several indirection models, such as proxy indirection, transparent
indirection, and value holder indirection. TopLink also provides indirection support
for EJB (see "Indirection and EJB" on page 30-9).

See "Indirection" on page 30-5 for more information.

Understanding TopLink Metadata

The TopLink metadata is the bridge between the development of an application and
its deployed run-time environment. Capture the metadata using TopLink Workbench
(see "Creating Project Metadata" on page 2-20 and "Creating Session Metadata" on
page 2-21), and pass the metadata to the run-time environment using deployment
XML files (such as project .xml and sessions.xml). You could also manually
code these files using Java and the TopLink API, but this approach is more
labor-intensive.
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The metadata, encapsulated in deployment XML files, lets you pass configuration
information into the run-time environment. The run-time environment uses the
information in conjunction with the persistent entities (Java objects or E]B entity
beans) and the code written with the TopLink API, to complete the application.

Figure 2-2 TopLink Metadata

Employee

- address

[EMP_ID F_NAME [ L_MAME | ADDR_ID | B_DATE

ADDR_ID CITY STATE ZIF

- postalCode
- province

This section describes the following:

= Advantages of the TopLink Metadata Architecture
»  Creating Project Metadata

»  Creating Session Metadata

= Deploying Metadata

Advantages of the TopLink Metadata Architecture

The TopLink metadata architecture provides many important benefits, including the
following:

= Stores mapping information in XML descriptors—not in the domain model objects

» By using the metadata, TopLink does not intrude in the object model or the
database schema

= Allows you to design the object model as needed, without forcing any specific
design

= Allows DBAs to design the database as needed, without forcing any specific
design

= Does not rely on code-generation (which can cause serious design,
implementation, and maintenance issues)

s Is unintrusive: adapts to the object model and database schema, rather than
requiring you to design their object model or database schema to suit TopLink

Creating Project Metadata

A TopLink project contains the mapping metadata that the TopLink runtime uses to
map objects to a data source. The project is the primary object used by the TopLink
runtime.

This section describes the principal contents of project metadata, including the
following:

s Descriptors and Mappings

= Data Source Login Information
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For more information about creating project . xml metadata, see "project.xml File"
on page 8-2.

Descriptors and Mappings

TopLink maps persistent entities to the database in the application, using the
descriptors and mappings you build with TopLink Workbench. TopLink Workbench
supports several approaches to project development, including the following:

= Importing classes and tables for mapping

= Importing classes and generating tables and mappings
= Importing tables and generating classes and mappings
s Creating both class and table definitions

TopLink Workbench supports all these options. The most common solution is to
develop the persistent entities using a development tool, such as an integrated
development environment (IDE) like Oracle JDeveloper, or a modeling tool, and to
develop the relational model through appropriate relational design tools. You then use
TopLink Workbench to construct mappings that relate these two models.

Although TopLink Workbench does offer the ability to generate persistent entities or
the relational model components for an application, these utilities are intended only to
assist in rapid initial development strategies—not complete round-trip application
development.

For more information, see Chapter 23, "Understanding Descriptors" and Chapter 30,
"Understanding Mappings".

Amending Descriptors An amendment method lets you implement a TopLink feature
that is not currently supported by TopLink Workbench. Simply write a Java method to
amend the descriptor after it is loaded, and specify the method in TopLink Workbench
for inclusion in the project metadata. See "Configuring Amendment Methods" on
page 25-81 for detailed information on implementing an amendment method for a
TopLink descriptor.

Data Source Login Information

For non-CMP projects, you configure a session login in the session metadata that
specifies the information required to access the data source (see "Creating Session
Metadata" on page 2-21).

For CMP projects, the project contains a deployment login that specifies the
information required to access the data source.

For more information, see "Projects and Login" on page 17-3.

Creating Session Metadata

A TopLink session contains a reference to a particular project . xml file, plus the
information required to access the data source. The session is the primary object used
by your application to access the features of the TopLink runtime.

The agent responsible for creating and accessing session metadata differs depending
on whether or not you are creating a CMP project. In a non-CMP project, your
application acquires and accesses a session directly (see "Non-CMP Applications and
Session Metadata" on page 8-4). In a CMP project, your application indirectly accesses
a session acquired internally by the TopLink runtime (see "CMP Applications and
Session Metadata" on page 8-4).
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Deploying Metadata
The project .xml and sessions.xml file are packaged for deployment differently
according to the type of application you are deploying.
For more information, see the following;:

s "Creating TopLink Files for Deployment" on page 8-1
s '"Packaging a TopLink Application" on page 9-1

Understanding the Three-Tier Architecture

The three-tier Web application architecture generally includes the connection of a
server-side Java application to the database through a JDBC connection (see

Figure 2-3). In this pattern, TopLink resides within a Java server (a J2EE server or a
custom server), with several possible server integration points. The application can
support Web clients such as servlets, Java clients, and generic clients using XML or
Common Object Request Broker Architecture (CORBA).

The three-tier application is a common architecture in which TopLink resides within a
Java server (either a J2EE server or a custom server). In this architecture, the server
session provides clients with shared access to JDBC connections and a shared object
cache. Because it resides on a single JVM, this architecture is simple and easily
scalable. The TopLink persistent entities in this architecture are generally Java objects.

This architecture often supports Web-based applications in which the client
application is a Web client, a Java client, or a server component.

Figure 2-3 Three Tier Architecture
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Although not all three-tier applications are Web-based, this architecture is ideally
suited to distributed Web applications. In addition, although it is also common to use
EJB in a Web application, this TopLink architecture does not.

Example Implementations

Examples of three-tier architecture implementation include the following;:

= A Model-View-Controller Model 2 architectural design pattern that runs in a J2EE
container with servlets and JSP that uses TopLink to access data without EJB.

= A Swing or Abstract Window Toolkit (AWT) client that connects to a server-side
Java application through RMI, without an application server or container.

Advantages and Disadvantages

The three-tier Web application architecture offers the following advantages:

= High performance, lightweight persistent objects
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High degree of flexibility in deployment platform and configuration

The disadvantage of this architecture is it is less standard than EJB.

Variation Using Remote Sessions

TopLink includes a session type called remote session. The session offers the full
session API and contains a cache of its own, but exists on the client system rather than
on the TopLink server. Communications can be configured to use RMI or RMI-Internet
Inter-Object Request Broker Protocol (IIOP).

Remote session operations require a corresponding client session on the server.

Although this is an excellent option for you if you wish to simplify the access from the
client tier to the server tier, it is less scalable than using a client session and does not
easily allow changes to server-side behavior.

For more information, see "Remote Sessions" on page 72-30.

Technical Challenges

The three-tier application with a stateless client presents several technical challenges,
including the following;:

Transaction management in a stateless environment

A common design practice is to delimit client requests within a single unit of work
(transactional session). In a stateless environment, this may affect how you design
the presentation layer. For example, if a client requires multiple pages to collect
information for a transaction, then the presentation layer must retain the
information from page to page until the application accumulates the full set of
changes or requests. At that point, the presentation layer invokes the unit of work
to modify the database.

Optimistic locking in a stateless environment

In a stateless environment, take care to avoid processing out-of-date (stale) data. A
common strategy for avoiding stale data is to implement optimistic locking, and
store the optimistic lock values in the object.

This solution requires careful implementation if the stateless application serializes
the objects, or sends the contents of the object to the client in an alternative format.
In this case, transport the optimistic lock values to the client in the HTTP contents

of an edit page. You must then use the returned values in any write transaction to

ensure that the data did not change while the client was performing its work.

For more information about locking, see "Configuring Locking Policy" on
page 25-64.

External JDBC pools

By default, TopLink manages its own connection pools. You can also configure
TopLink to use connection pooling offered by the host application server. This
feature is useful for shared connection pools and is required for JTA/JTS
integration (see "Configuring External Connection Pooling" on page 82-2).

JTA/JTS Integration

JTA and JTS are standard Java components that enable sessions to participate in
distributed transactions. You must configure TopLink to use JTA/JTS to use
session beans in the architecture (see "Integrating the Unit of Work With an
External Transaction Service" on page 99-21).
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s Cache coordination

If you choose to use multiple servers to scale your application, you may require
TopLink cache coordination (see Chapter 87, "Understanding the Cache").

Understanding the Two-Tier Architecture

A two-tier application generally includes a Java client that connects directly to the
database through TopLink. The two-tier architecture is most common in complex user
interfaces with limited deployment. The database session provides TopLink support
for two-tier applications.

For more information, see Chapter 72, "Understanding TopLink Sessions".

Figure 2-4 Two-Tier Architecture

o]

Although the two-tier architecture is the simplest TopLink application pattern, it is
also the most restrictive, because each client application requires its own session. As a
result, two-tier applications do not scale as easily as other architectures.

Two-tier applications are often implemented as user interfaces that directly access the
database (see Figure 2—-4). They can also be non-interface processing engines. In either
case, the two-tier model is not as common as the three-tier model.

The following are key elements of an efficient two-tier (client-server) architecture with
TopLink:

s Minimal dedicated connections from the client to the database

= Anisolated object cache

Example Implementations

An example of a two-tier architecture implementation is a Java user interface
(Swing/AWT) and batch data processing.

Advantages and Disadvantages

The advantage of the two-tier design is its simplicity. The TopLink database session
that builds the two-tier architecture provides all the TopLink features in a single
session type, thereby making the two-tier architecture simple to build and use.

The most important limitation of the two-tier architecture is that it is not scalable,
because each client requires its own database session.

Technical Challenges

The current trend toward multitiered Web applications makes the two-tier
architecture less common in production systems, but no less viable. Because there is no
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shared cache in a two-tier system, you risk encountering stale data if you run multiple
instances of the application. This risk increases as the number of individual database
sessions increases.

To minimize this problem, TopLink offers support for several data locking strategies.
These include pessimistic locking and several variations of optimistic locking. For
more information, see "Configuring Locking Policy" on page 25-64.

Understanding the EJB Session Bean Facade Architecture

This architecture is an extension of the three-tier pattern, with the addition of EJB
session beans wrapping the access to the application tier. Session beans provide public
API access to application operations, enabling you to separate the presentation tier
from the application tier. The architecture also lets you use session beans within a J2EE
container.

This type of architecture generally includes JTA integration, and serialization of data
to the client.

Figure 2-5 Three-Tier Architecture Using Session Beans and Java Objects
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A common extension to the three-tier architecture is to combine session beans and
persistent Java objects managed by TopLink. The resulting application includes
session beans and Java objects on a TopLink three-tier architecture (see Figure 2-5).

The three-tier architecture creates a server session and shares it between the session
beans in the application. When a session bean needs to access a TopLink session, the
bean obtains a client session from the shared server session. This architecture has the
following key features:

»  Session beans delimit transactions.
Configure TopLink to work with a JTA system and its associated connection pool.
»  Accessing the persistent objects on the client side causes them to be serialized.

Ensure that when the objects re-emerge on the server-side, they properly merge
into the cache to maintain identity.

Example Implementation

An example of the EJB session bean facade architecture implementation is a
Model-View-Controller Model 2 architectural design pattern that runs in a J2EE
container with servlets and JSP and uses the session bean enabled by TopLink to
access data without EJB.
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Advantages and Disadvantages

The E]B session bean facade architecture is a popular and effective compromise
between the performance of persistent Java objects, and the benefits of E]B for
standardized client development and server scalability. It offers the following
advantages:

= Less overhead than an E]B entity bean application

TopLink shares access to the project, descriptor, and login information across the
beans in the application.

= Future compatibility with other servers

This design isolates login and E]B server-specific information from the beans,
which lets you migrate the application from one application server to another
without major recoding or rebuilding.

s Shared read cache

This design offers increased efficiency by providing a shared cache for reading
objects.

The key disadvantage of this model is the need to transport the persistent model to the
client. If the model involves complex object graphs in conjunction with indirection,
this can present many challenges with inheritance, indirection, and relationships.

For more information about managing inheritance, indirection and relationships, see
Part IX, "Mappings".

Understanding Session Beans

Session beans model a process, operation, or service and as such, are not persistent
entities. However, session beans can use persistence mechanisms to perform the
services they model.

Under the session bean model, a client application invokes methods on a session bean
that, in turn, performs operations on Java objects enabled by TopLink. Session beans
execute all operations related to TopLink on behalf of the client.

The EJB specifications describe session beans as either stateless or stateful.

Stateful beans maintain a conversational state with a client; that is, they retain
information between method calls issued by a particular client. This enables the client
to use multiple method calls to manipulate persistent objects.

Stateless beans do not retain data between method calls. When the client interacts
with stateless session beans, it must complete any object manipulations within a single
method call.

Technical Challenges

Your application can use both stateful and stateless session beans with a TopLink
client session or database session. When you use session beans with a TopLink session,
the type of bean used affects how it interacts with the session.

m  Stateless session beans and the TopLink session

Stateless beans store no information between method calls from the client. As a
result, reestablish the connection of the bean to the session for each client method
call. Each method call through TopLink obtains a client session, makes the
appropriate calls, and releases the reference to the client session.
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»  Stateful session beans and the TopLink session

Your EJB server configuration includes settings that affect the way it manages
beans-settings designed to increase performance, limit memory footprint, or set a
maximum number of beans. When you use stateful beans, the server may
deactivate a stateful session bean enabled by TopLink out of the JVM memory
space between calls to satisfy one of these settings. The server then reactivates the
bean when required, and brings it back into memory.

This behavior is important, because a TopLink session instance does not survive
passivation. To maintain the session between method calls, release the session
during the passivation process and re-obtain it when you reactivate the bean.

= External JDBC pools

By default, TopLink manages its own connection pools. For the session bean
architecture, you must configure TopLink to use connection pooling offered by the
host application server. This feature is useful for shared connection pools and is
required for JTA/]JTS integration (see "Configuring External Connection Pooling"
on page 82-2).

s JTA/JTS integration

JTA and JTS are standard Java components that enable sessions to participate in
distributed transactions. You must configure TopLink to use JTA/JTS to use
session beans in the architecture (see "Integrating the Unit of Work With an
External Transaction Service" on page 99-21).

s Cache coordination

If you choose to use multiple servers to scale your application, you may require
TopLink cache coordination (see "Understanding Cache Coordination" on
page 87-10).

Unit of Work Merge

You can use a unit of work to enable your client application to modify objects on the
database. The unit of work merge functions employ mappings to copy the values from
the serialized object into the unit of work, and to calculate changes.

For more information, see "Merging Changes in Working Copy Clones" on page 99-13.

Understanding the EJB Entity Beans With CMP Architecture

CMP is the part of the J2EE component model that provides an object persistence
service that an EJB container uses to persist entity beans. CMP provides distributed,
transactional, secure access to persistent data, with a guaranteed portable interface.

This architecture is an extension of the three-tier architecture, in which the
implementation of persistence methods is handled by the container at runtime. As a
bean provider, you only need to specify in a deployment descriptor those persistent
fields and relationships for which the container must handle data access and,
optionally, an abstract representation of the database schema.

TopLink CMP is an extension of the TopLink persistence framework that provides
custom integration to E]JB containers of various application servers (see "Application
Server Support" on page 7-1). For more information about choosing an application
server, see "Understanding Target Platforms" on page 2-5. TopLink integrates with the
EJB container in this architecture to augment (or, in the case of OC4J, become) the
container’s persistence manager.
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Note: When using OC4J and Java 1.5, TopLink supports a subset of
the persistence features anticipated in the final EJB 3.0 specification.
For more information on EJB 3.0 support, see Oracle Containers for J2EE
Enterprise JavaBeans Developer’s Guide.

EJB 3.0 feature support is subject to change and dependent upon the
contents of the final specification.

TopLink CMP integration is nonintrusive (see Figure 2-6). Through a combination of
run-time integration and code generation, the container uses TopLink internally and
the bean user interacts with entity beans with container-managed persistence
according to their standard API. This lets you combine the standard interfaces and
power of CMP and a container with TopLink flexibility, performance, and
productivity.

Figure 2-6 Three-Tier CMP Architecture
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For more information, see the following:

s '"Integrating TopLink With an Application Server" on page 7-1
= "Creating TopLink Files for Deployment" on page 8-1

= "Packaging a TopLink Application" on page 9-1

= "Deploying a TopLink Application" on page 10-1

s "Configuring Persistence Type" on page 19-5

Example Implementation

An example of the entity beans with container-managed persistence implementation is
a Model-View-Controller Model 2 architectural design pattern that runs in a J2EE
container, with servlets and JSP that access either session beans or entity beans with
container-managed persistence enhanced by TopLink.

Advantages and Disadvantages

A three-tier architecture using entity beans with container-managed persistence offers
the following advantages:

= It allows for entity beans with container-managed persistence supplied with
sophisticated TopLink features such as caching and mapping support, storing
bean data across more than one table, composite primary keys, and data
conversion.

» It presents a standard method to access data, which lets you create standardized,
reusable business objects.
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s Itis well-suited to create coarse-grained objects, which TopLink relates to
dependent, lightweight, regular Java objects (TopLink can also manage
container-managed relationships to lightweight dependent Java objects).

= TopLink provides for lazy initialization of referenced objects and beans (see
"Indirection" on page 30-5).

s TopLink provides functionality for transactional copies of beans, allowing
concurrent access by several clients, rather than relying on individual serialization.

s TopLink provides advanced query capabilities, as well as dynamic querying,
including the ability to define queries at the bean-level rather than the data source
level and to use a rich set of querying and finder options.

s TopLink maintains bean and object identity.

The disadvantage of this architecture is that pure entity bean with container-managed
persistence architectures can impose a high overhead cost. This is especially true when
a data model has a large number of fine-grained classes with complex relationships.

Technical Challenges

The key technical challenge in this architecture lies in integrating components into a
cohesive system. For example, this architecture requires a specific TopLink integration
with the application server or J2EE container.

Other issues include the following:

s External JDBC Pools

s JTA/JTS Integration

s Cache Coordination

»  Maintaining Bidirectional Relationships

= Managing Dependent Objects

= Managing Collections of EJBObject Objects

External JDBC Pools

By default, TopLink manages its own connection pools. You can also configure
TopLink to use connection pooling offered by the host application server. This feature
is useful for shared connection pools and is required for JTA/JTS integration (see
"Configuring External Connection Pooling" on page 82-2).

JTANJTS Integration

JTA and JTS are standard Java components that enable sessions to participate in
distributed transactions. You must configure TopLink to use JTA/JTS to use session
beans in the architecture (see "Integrating the Unit of Work With an External
Transaction Service" on page 99-21).

Cache Coordination

If you choose to use multiple servers to scale your application, you may require
TopLink cache coordination (see "Understanding Cache Coordination" on page 87-10).

Maintaining Bidirectional Relationships

When one-to-one or many-to-many relationship is bidirectional, you must maintain
the back pointers as the relationships change.

Understanding TopLink Application Development 2-29



Understanding the EJB Entity Beans With CMP Architecture

TopLink automatically maintains the relationship between two entity beans.
To set the back pointer manually, do one of the following:

s Code the entity bean to maintain the back pointer when the relationship is
established or modified (recommended).

s Code the client to explicitly set the back pointer.

If you code the entity bean to set back pointers, the client is freed of this responsibility.
This has the advantage of encapsulating this maintenance implementation in the bean.

In a one-to-many relationship, a source bean might have several dependent target
objects. For example, an EmployeeBean might own several dependent PhoneNumber
instances. When you add a new dependent object (a PhoneNumber, in this example)
to an employee, you must set the PhoneNumber instance’s back pointer to its owner
(the employee). Maintaining a one-to-many relationship in the entity bean involves
getting the local object reference from the context of the EmployeeBean, and then
updating the back pointer as Example 2-1 shows.

Example 2-1 Setting the Back-Pointer in the Entity Bean

// obtain owner and phoneNumber

owner = empHome.findByPrimaryKey (ownerId) ;

phoneNumber = new PhoneNumber ("cell", "613", "5551212");
// add phoneNumber to the phoneNumbers of the owner
owner.addPhoneNumber (phoneNumber) ;

// Maintain the relationship in the Employee's addPhoneNumber method
public void addPhoneNumber (PhoneNumber newPhoneNumber) {
// get, then set the back pointer to the owner
Employee owner = (Employee)this.getEntityContext () .getEJBLocalObject();
newPhoneNumber . setOwner (owner) ;
// add new phone
getPhoneNumbers () .add (newPhoneNumber) ;

}

For more information, see the following:
s Configuring Bidirectional Relationship on page 32-34
= "Directionality" on page 33-2

Managing Dependent Objects

Unlike EJB, TopLink dependent persistent objects can be sent back and forth between
a client and a server. When objects are serialized, the risk exists the objects can cause
the cache to lose the identity of the objects or attempt to cache duplicate identical
objects. To avoid potential problems, use the bean setter methods when adding
dependent objects to relationship collections as Example 2-2 shows. This enables
TopLink to handle merging of objects in the cache.

Example 2-2 Managing Dependent Objects

addPhoneNumber (PhoneNumber phone) {
Collection phones = this.getPhoneNumbers () ;
Vector newCollection = new Vector();
newCollection.addAll (phones) ;
newCollection.add (phone) ;
this.setPhones (newCollection) ;
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Managing Collections of EJBObject Objects

Collections generally use the equals method to compare objects. This is not a
problem in the case of an object that contains a collection of EJBObject objects,
because the EJB container collection handles equality appropriately.

Understanding the EJB Entity Beans With BMP Architecture

BMP is the part of the J2EE component model that lets you, the bean provider,
implement the entity bean’s persistence directly in the entity bean class or in one or
more helper classes that you provide.

This architecture is an extension of the three-tier architecture, in which the persistent
data is bean managed within an entity bean using code that you implement. The client
code accesses the data through the entity bean interface.

TopLink BMP is an extension of the TopLink persistence framework that provides
base class BMPEntityBase as a starting point for your BMP development. This class
provides an implementation for all methods (except ejbPassivate) required by the
EJB specifications prior to 3.0. Subclass BMPEnt ityBase to create a TopLink-enabled
entity bean with bean-managed persistence.

To use the BMPEnt ityBase class, perform the following;:

1. Create a TopLink session (see Chapter 72, "Understanding TopLink Sessions") for
your application.

2. Add aBMPWrapperPolicy to each descriptor that represents an entity bean with
bean-managed persistence.

The BMPWrapperPolicy provides TopLink with the information to create remote
objects for entity beans and to extract the data out of a remote object.

3. Create the home and remote interfaces.

4. Create deployment descriptors (see "Integrating TopLink With an Application
Server" on page 7-1 and "Creating TopLink Files for Deployment” on page 8-1).

5. Package your application (see "Packaging a TopLink Application" on page 9-1).
6. Deploy the beans (see "Deploying a TopLink Application" on page 10-1).

To make full use of TopLink session and unit of work features, TopLink provides a
hook into its functionality through the BMPDataStore class. Use this class to translate
EJB-required functionality into simple calls.

The BMPDataStore class provides implementations of LOAD and STORE, multiple
finders, and REMOVE functionality. The BMPDataStore class requires a TopLink
session. A single instance of BMPDataStore must exist for each bean type deployed
within a session. When creating a BMPDataStore, pass in the session name of the
session that the BMPDataStore must use to persist the beans and the class of the bean
type being persisted. Store the BMPDataStore in a global location so that each
instance of a bean type uses the correct store method.

TopLink BMP support (see Figure 2-7) lets you combine the standard interfaces of
entity beans with bean-managed persistence with TopLink flexibility, performance,
and productivity.
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Figure 2-7 Three-Tier BMP Architecture
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TopLink supports BMP. To use BMP support, the home interface must inherit from the
oracle.toplink.ejb.EJB20Home. To make calls to the BMPEnt ityBase, the
findAll method must call the EJB 2.0 version of the methods. These methods are
prefixed with ejb20. For example, in the EJB 2.0 version, the £indA11 method
appears as ejb20FindAll.

To use local beans, use the oracle.toplink.ejb.EJB20LocalHome setting instead
of the default oracle.toplink.ejb.EJB20Home. Instead of the
oracle.toplink.ejb.BMPWrapperPolicy setting, use the
oracle.toplink.ejb.bmp.BMPLocalWrapperPolicy setting.

To accommodate both local and remote configurations, ensure the following;:

= For a bean that has a single interface, use the corresponding wrapper policy (local
or remote) for the descriptor.

= Beans can only participate in relationships as either local or remote interfaces, not
both.

For more information, see the following:

s "Integrating TopLink With an Application Server" on page 7-1
= "Creating TopLink Files for Deployment" on page 8-1

s "Packaging a TopLink Application" on page 9-1

= "Deploying a TopLink Application" on page 10-1

s "Configuring Persistence Type" on page 19-5

= "Configuring the Server Platform" on page 74-14

Example Implementations

An example of the entity beans with bean-managed persistence implementation is a
Model-View-Controller Model 2 architectural design pattern that runs in a J2EE
container, with servlets and JSP that access session beans and entity beans with
bean-managed persistence enhanced by TopLink.

Advantages and Disadvantages
Using BMP with a TopLink three-tier architecture offers the following advantages:

= It simplifies the BMP method calls. These can be inherited from an abstract bean
class, rather than being generated.

s TopLink makes BMP easier to implement.

= It enables you to implement database-independent code in the bean methods.
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s The architecture supports features such as complex relationships, caching,
object-level and dynamic queries, and the unit of work.

The main disadvantages of BMP include the following:
= You must create the persistence mechanisms in the bean code.
= Itisnot as transparent or efficient as CMP.

= TopLink-only Java object applications offer the same degree of independence from
the application server.

Technical Challenges

The key technical challenge in this architecture lies in integrating components into a
cohesive system. For example, this architecture requires a specific TopLink integration
with the application server or J2EE container.

Other issues include the following:
=  External JDBC Pools
s JTA/JTS Integration

s Cache Coordination

External JDBC Pools

By default, TopLink manages its own connection pools. You can also configure
TopLink to use connection pooling offered by the host application server. This feature
is useful for shared connection pools and is required for JTA/JTS integration (see
"Configuring External Connection Pooling" on page 82-2).

JTANJTS Integration

JTA and JTS are standard Java components that enable sessions to participate in
distributed transactions. You must configure TopLink to use JTA/JTS to use session
beans in the architecture (see "Integrating the Unit of Work With an External
Transaction Service" on page 99-21).

Cache Coordination

If you choose to use multiple servers to scale your application, you may require
TopLink cache coordination (see "Understanding Cache Coordination" on page 87-10).

Understanding the EJB 3.0 JPA Entity Architecture

A part of the E]B 3.0 specification, the Java Persistence API (JPA) is a lightweight,
POJO-based framework for Java persistence. JPA focuses on object-relational mapping
and contains a full object-relational mapping specification supporting the use of Java
language metadata annotations and /or XML descriptors to define the mapping
between Java objects and a relational database. Object-relational mapping with the
JPA is completely metadata-driven. JPA supports a SQL-like query language for both
static and dynamic queries. It also supports the use of pluggable persistence providers.

JPA includes the following concepts:

= Entity—any application-defined object with the following characteristics can be an
entity:

— it can be made persistent;
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- it has a persistent identity (a key that uniquely identifies an entity instance
and distinguishes it from other instances of the same entity type. An entity has
a persistent identity when there is a representation of it in a data store);

- itis partially transactional in a sense that a persistence view of an entity is
transactional (an entity is created, updated and deleted within a transaction,
and a transaction is required for the changes to be committed in the database).
However, in-memory entities can be changed without the changes being
persisted.

- itis nota primitive, a primitive wrappert, or built-in object. An entity is a
fine-graned object that has a set of aggregated state that is typically stored in a
single place (such as a row in a table), and have relationships to other entities.

= Entity metadata—describes every entity. Metadata could be expressed as
annotations (specifically defined types that may be attached to or place in front of
Java programming elements) or XML (descriptors).

= Entity manager—enables API calls to perform operations on an entity. Until an
entity manager is used to create, read, or write an entity, the entity is just a regular
nonpersistent Java object. When an entity manager obtains a reference to an entity,
that entity becomes managed by the entity manager. The set of managed entity
instances within an entity manager at any given time is called its persistence
context-only one Java instance with the same persistent identity may exist in a
persistence context at any time.

You can configure an entity manager to be able to persist or manage certain types
of objects, read or write to a particular database, and be implemented by a specific
persistence provider. The persistence provider supplies the backing
implementation engine for JPA, including the EntityManager interface
implementation, the Query implementation, and the SQL generation.

Entity managers are provided by an Ent ityManagerFactory. The configuration
for an entity manager is bound to the EntityManagerFactory, but it is defined
separately as a persistence unit. You name persistence units to allow
differentiation between Ent ityManagerFactory objects. This way your
application obtains control over which configuration to use for operations on a
specific entity. The configuration that describes the persistence unit is defined in a
persistence.xml file.

The following description expresses relationships between JPA concepts:

- Persistence creates one or more EntityManagerFactory objects;

each EntityManagerFactory is configured by one persistence unit;

EntityManagerFactory creates one or more EntityManager objects;
— one or more EntityManager manages one PersistenceContext.

For more information, see the following;:

]

http://www.oracle.com/technology/products/ias/toplink/jpa/ind
ex.html

»  Oracle Containers for [2EE Enterprise JavaBeans Developer’s Guide

Example Implementations

An example of the entity beans with bean-managed persistence implementation is a
Model-View-Controller Model 2 architectural design pattern that runs in a Java EE
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container, with servlets and JSP that access session beans and E]JB 3.0-compliant
entities using the TopLink-based JPA persistence provider.

Advantages and Disadvantages
The use of TopLink JPA entities offers the following advantages:

»  POJO persistence—in JPA, persistent objects are POJOs.
s Object-relational mapping is completely metadata-driven.

= The persistence API exists as a separate layer form the persistent objects and does
not intrude upon them.

s Using the query framework you can query across entities and their relationships
without having to use concrete foreign keys or database columns. Also, you can
define queries statically in metadata or create them dynamically by passing query
criteria on construction. Queries can return entities as results.

= Entities are mobile-objects are able to move from one JVM to another and back,
and at the same time be usable by the application.

= You can configure persistence features through the use of Java SE 5 annotations, or
XML, or a combination of both. You may also rely on defaults.

s If your application is running inside a container, the container provides support
and ease of use; you can configure the same application to run outside a container.

Understanding the Web Services Architecture

A Web services architecture is similar to the three-tier (see "Understanding the
Three-Tier Architecture” on page 2-22) or session bean (see "Understanding the EJB
Session Bean Facade Architecture" on page 2-25) architecture, however, in a Web
services architecture, you encapsulate business logic (the service) in a Web service
instead of (or in addition to) using session beans. In a Web services architecture, clients
communicate with your application using SOAP messages (XML over HTTP).

Figure 2-8 Web Services Architecture

Server
SOAP Handler
SOAP )(MLUlng::rsathiw Request
Ciiont | €M) Ly, ["Web ||y TopLink XML > g
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Java g:jr;ﬁanﬂxm Response

As in any architecture, you can use TopLink to persist objects to relational or EIS data
sources. However, in a Web services architecture, you can also use TopLink to map
your object model to an XML schema for use with the Web service or as the Web
service XML serializer.

Example Implementations

An example of a Web services architecture implementation is the use of a Web service
to expose parts of an existing application to a remote client (typically another
application) by way of SOAP messages. In this application, you can use TopLink XML
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to unmarshall XML messages to Java objects to facilitate requests and marshall Java
object responses back into XML for transmission to the client.

Advantages and Disadvantages

Using TopLink in Web services architecture has many advantages, including, but not
limited to, the following:

= you can map XML messages to an existing Java object model.

= you can achieve a high level of complexity of mapping support
s compliance with the JAXB standards

= providing a scalable, high-performing solution

One debatable disadvantage is this solution’s complexity over a simple RMI session
bean service.

Technical Challenges

As with any technology, there are technical challenges associated with the use of
TopLink in Web services architecture. These technical challenges are mostly related to
special-case scenarios, such as when you need to implement a custom serializer
because you have both the Java objects and the schema.

For more information, see the following:

»  Oracle TopLink as a Custom Serializer in a JAX-RPC 1.1 Web service at
http://www.oracle.com/technology/products/ias/toplink/technic
al/tips/jaxRpcll/index.htm

s Part XIII, "XML Mappings"
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Using TopLink Development Tools

This part describes the development tools and tool support TopLink provides. It
contains the following chapters.

Chapter 3, "Understanding TopLink Development Tools"
This chapter describes the development tools and tool support TopLink provides.
Chapter 4, "Using TopLink Workbench"

This chapter describes how to use TopLink Workbench including working with
databases, generating data from database tables, and creating and editing a
sessions.xml file.

Chapter 6, "Using an Integrated Development Environment"

This chapter explains how to integrate TopLink with an IDE. Detailed instructions
are given for the Oracle JDeveloper IDE.

Chapter 5, "Using the Schema Manager"

This chapter explains how to use the TopLink schema manager to create databases,
tables, stored procedures, and to populate database tables.






3

Understanding TopLink Development Tools

The TopLink runtime provides Java or J2EE applications with access to persistent
entities stored in a data source. In addition to run-time capabilities, the TopLink
Foundation Library includes the TopLink Application Programming Interface (API).
This API enables applications to access TopLink run-time features.

TopLink includes additional development tools that simplify application
development. These tools capture mapping and run-time configuration information in
metadata files that TopLink passes to the application at run time.

TopLink application development includes the following:
= Development Environment
s TopLink Run-Time Environment

TopLink metadata is the link between the two (see "Understanding TopLink Metadata"
on page 2-19).

Figure 3-1 illustrates how these elements interact with the data source.

Figure 3—-1 TopLink Components in Development Lifecycle
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Development Environment

Development Environment

To create a TopLink application, use TopLink Workbench to map objects to data
sources using relational and nonrelational models. Capture the resulting mappings
and additional run-time configurations in the TopLink project file (project .xml) and
build a session configuration file (sessions.xml). These files together represent your
entire TopLink project, as shown in Figure 3-2.

During development, you can use the TopLink API to define query and transaction
logic. When you use entity beans, there is generally little or no direct use of the
TopLink API and there is no session or sessions.xml file.

Figure 3-2 TopLink Workbench in Development Environment
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TopLink Workbench can import compiled entity classes (Java objects or EJB entity
beans), as well as relational or nonrelational schemas through a JDBC driver
(configured by the developer). Because TopLink imports the object and relational
models for mapping, developers can develop the two models relatively independently
from the mapping phase of a project development.

TopLink Run-Time Environment

The TopLink Foundation Library provides the TopLink run-time component. Access
the run-time component either directly through the TopLink API or indirectly through
a J2EE container when using entity beans with container-managed persistence. The
run-time environment is not a separate or external process—it is embedded within the
application. Application calls invoke TopLink to provide persistence behavior. This
function allows for transactional and thread-safe access to shared database connections
and cached objects.

In addition to J2EE environments, TopLink fully supports non-J2EE environments as
well. See "Selecting an Architecture With TopLink" on page 2-5 for more information.
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Using TopLink Workbench

This chapter provides information about understanding, using, and customizing
TopLink Workbench.

This chapter includes the following sections:

= Understanding TopLink Workbench

s Configuring the TopLink Workbench Environment
= Working With TopLink Workbench

= Working With TopLink Workbench Preferences

= Working With Databases

= Working With XML Schemas

= Working With Classes

= Integrating TopLink Workbench With Apache Ant

For information on using TopLink Workbench to configure sessions XML, refer to
Part XV, "TopLink Sessions".

Understanding TopLink Workbench

TopLink Workbench is a separate component from the TopLink runtime-it lets you
graphically configure descriptors and map your project. TopLink Workbench can
verify the descriptor options, access the data source (either a database or an XML
schema), and create the database schema. Using TopLink Workbench, you can define
TopLink descriptors and configurations without using code.

TopLink Workbench can be used during the development phase of the development
process (see "Developing Your Application With TopLink" on page 2-1). Typically, this
phase includes the following:

1. Defining an object model (a set of Java classes) to describe and solve your
problem.

2. Creating a TopLink Workbench project, importing your Java classes and data
sources, and using descriptors to describe how the Java classes map to your data
source model.

3. Creating a TopLink session and registering your descriptors. In your application,
use the session to retrieve and store objects from and to the data source.

TopLink Workbench creates a <projectName>.mwp file to store all TopLink project
information, including object model, descriptor, and session information.

Using TopLink Workbench  4-1



Configuring the TopLink Workbench Environment

The <projectName>.mwp file is used only by TopLink Workbench. Typically, the
only time you need to modify the <projectName>.mwp file is to merge changes
during application development by a team of developers ("Merging Files" on
page 6-4).

Using TopLink Workbench, you export this information into a project . xml file that
your TopLink enabled application reads at run time.

For more information on using TopLink Workbench as the development environment,
see Figure 3-2 on page 3-2.

Configuring the TopLink Workbench Environment

TopLink Workbench reads its environment variables from the setenv script in the
<TOPLINK HOME>\bin directory.

Before you launch TopLink Workbench, you must configure its environment as
follows:

1. Use a text editor to open the <TOPLINK HOME>\bin\setenv script.
= For Windows, open the setenv. cmd file.
»  For UNIX, open the setenv. sh file.

2. Ensure that the JAVA HOME environment variable is set:
» For Windows: set JAVA HOME=C:/j2sdkl.4.2 04

s For UNIX: JAVA HOME=/usr/local/packages/java; export JAVA
HOME

3. Update the DRIVER CLASSPATH environment variable to add the location of the
following (if necessary):

Note: Do not include any Java classes for your persistent business
objects in the DRIVER CLASSPATH variable. Instead, add these
persistent business objects in your TopLink Workbench project
classpath (see "Configuring Project Classpath" on page 19-3).

» JDBC drivers-if you are using relational projects (see "Relational Projects" on
page 17-6).

= J2EE Connector Architecture (J2C) adapters—if you are using EIS projects (see
"EIS Projects" on page 17-7).

s J2C connector. jar file-if you are using EIS projects (see "EIS Projects" on
page 17-7).

The connector. jar file contains javax.resource.cci and
javax.resource.spi interfaces that TopLink EIS uses. By default, TopLink
Workbench updates its classpath to include the Java 1.5 connector. jar file
from <TOPLINK HOME>/7j2ee/home/1lib. If this version of the

connector. jar file is incompatible with your environment, edit the
workbench. cmd or workbench. sh file in <TOPLINK HOME>/bin to change
the path to this file.

At runtime, this connector. jar file (or its equivalent) must be on your
application or application server classpath.
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s Oracle Database ORACLE_HOME/rdbms/jlib/xdb.jar file - if you are using
direct-to-XMLType mappings with an Oracle9i or higher database (see
"Direct-to-XMLIype Mapping" on page 33-4).

s Custom Collection class that you use to override the default Collection

class that TopLink uses with a mapping container policy (see "Configuring
Container Policy” on page 32-26).

Example 4-1 shows how to set the DRIVER_CLASSPATH variable for Windows
and Example 4-2 for UNIX.

Example 4-1 Setting DRIVER_CLASSPATH on Windows

set DRIVER
CLASSPATH=C:\OraHome2\jdbc\1lib\ojdbcl4.jar;C:\Attunity\Connect\Java\lib\attunityResourceAdapt
er.jar;C:\OraHome2\rdbms\jlib\xdb.jar

Note: If the path to your driver(s) contains spaces, you must enclose
the path in double-quotes in the setenv. cmd file. For example:

set DRIVER_CLASSPATH="C:\Program Files\some directory\driver.jar\"

Example 4-2 Setting DRIVER_CLASSPATH on UNIX

DRIVER
CLASSPATH=/OraHome2/jdbc/1lib/ojdbcl4. jar; /attunity/connect/java/lib/attunityResourceAdapter. j
ar;/OraHome2/rdbms/jlib/xdb.jar; export JDBC CLASSPATH

4. Save and close the setenv script.

To use TopLink Workbench in a language different than your default, add the
-Duser.language and -Duser. country options to the JVM_ARGS variable in the
workbench.cmd or . sh file. For example, the following arguments will start TopLink
Workbench in US English, regardless of default language of your operating system:

JVM_ARGS="-Duser.language=en -Duser.country=en US"

Working With TopLink Workbench

Figure 4-1 shows the primary parts of TopLink Workbench window.
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Figure 4-1 TopLink Workbench Window
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The numbered callouts in Figure 4-1 identify the following user interface components:
1. Menu bar

The menu bar contains menus for each TopLink Workbench function. Some
objects also contain context-sensitive menus. See "Using the Menus" on page 4-5
for more information.

2. Toolbars

The toolbars contain shortcuts to specific functions. See "Using the Toolbars" on
page 4-6 for more information.

3. Navigator window section

The Navigator window section shows the project navigation tree for all open
projects (see "Using the Navigator" on page 4-9). Click the plus ( + ) or minus (-)
sign next to an object (or double-click the object) to expand or collapse the tree.
When you select an object in the Navigator window section, its properties appear
in the Editor window.

4. Editor window section

The Editor window section contains specific property sheets and option tabs for
the currently selected object. See "Using the Editor" on page 4-10 for more
information.

5. Problems window section
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The Problems window section shows messages and errors for the currently
selected object in the Navigator window section (see "Using the Problems
Window" on page 4-11). Chapter 14, "TopLink Workbench Error Reference"
contains detailed information on each error message.

Using the Menus
TopLink Workbench contains two types of menus:
= Menu Bar Menus

s Context Menus

Menu Bar Menus

The menu bar, located at the top of the TopLink Workbench window, provides menus
for each TopLink Workbench function. Some menus (such as Selected) are
context-sensitive; the available options may vary, depending on the currently selected
object.

Figure 4-2 Sample Menu Bar Menu
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Context Menus

When you right-click objects in the Navigator window, a context menu appears with
functions specific to the selected object.
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Figure 4-3 Sample Context Menu
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Using the Toolbars
TopLink Workbench contains the following toolbars at the top of the window:

s Standard Toolbar
s Context Toolbar

Toolbars provide tool tips: each toolbar button provides a brief description when you
position the mouse pointer over it.

Standard Toolbar

The standard toolbar furnishes quick access to the standard menu options (File, Edit,
Selected, and so on).

Table 4-1 Standard Toolbar Buttons

Button Description Available for ...
New All
Open All
Save All
|E| Save as All
Save all All
@ Close All
|i| Close all All
Help topics All
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Table 4-1 (Cont.) Standard Toolbar Buttons

Button Description Available for ...
= Export deployment XML Projects
E‘ Refresh classes Projects
a@ Add or refresh classes Projects
i‘ Create new class Projects

Context Toolbar

The context toolbar provides quick access to functions for the currently selected object
in the Navigator (see "Using the Navigator" on page 4-9). The available buttons will
vary, depending on which item you have selected.

You can also right-click the item and choose the appropriate option from the context

menu.

Table 4-2 Context Toolbar Buttons

Button Description Available for ...

2 Login to database Databases
3 Logout of database Databases

o Add new table Databases

[ Add or update tables from database Databases
g Refresh from database Database tables

— Remove table Database tables
1 Rename Database tables

® Add database platform Database platform repositories

EX

Rename repository

Database platform repositories

& Delete platform Database platform repositories
= Clone platform Database platform repositories
o Add database type Database platform repositories
5 Import schema Schemas
25 Relational aggregate descriptor Descriptors
e Relational class descriptor Descriptors
& Relational EJB descriptor Descriptors
%, EIS composite descriptor Descriptors
@ EIS root descriptor Descriptors
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Table 4-2 (Cont.) Context Toolbar Buttons

Button Description Available for ...
e, EIS EJB descriptor Descriptors
@ XML descriptor Descriptors
> Direct-to-field mapping Attributes in relational descriptors
ar Object type mapping' Attributes in relational descriptors
v Type conversion mapping’ Attributes in relational descriptors
= Serialized mapping' Attributes in relational descriptors
o Direct-to-XMLType mapping Attributes in relational descriptors
3 Direct collection mapping Attributes in relational descriptors
# Direct map mapping Attributes in relational descriptors
2 Aggregate mapping Attributes in relational descriptors
- One-to-one mapping Attributes in relational descriptors
o2 Variable one-to-one mapping Attributes in relational descriptors
One-to-many mapping Attributes in relational descriptors
P Many-to-many mapping Attributes in relational descriptors
s Direct mapping Attributes in EIS descriptors
s Direct collection mapping Attributes in EIS descriptors
) Composite object mapping Attributes in EIS descriptors
N Composite collection mapping Attributes in EIS descriptors
& One-to-one mapping Attributes in EIS descriptors
o One-to-many mapping Attributes in EIS descriptors
- Direct-to-XML mapping Attributes in XML descriptors
=5 Direct collection mapping Attributes in XML descriptors
) Composite object mapping Attributes in XML descriptors
N Composite collection mapping Attributes in XML descriptors
o2 Any object mapping Attributes in XML descriptors
o7 Any collection mapping Attributes in XML descriptors
5 Transformation mapping Attributes in all descriptors

Unmap

Attributes in all descriptors
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Table 4-2 (Cont.) Context Toolbar Buttons

Button Description Available for ...
Bi Session Sessions configurations
@ Session Broker Sessions configurations
¥ amed connection poo erver sessions
N Named t 1 S
| Sequence connection pool Server sessions
j Write connection pool Server sessions
o Rename Database sessions, session brokers
» Delete session Database sessions, session brokers

1 Deprecated. For more information, see "Using a Converter Mapping" on page 33-3

Using the Navigator

TopLink displays the items included in each project (descriptors, mappings, data
source, and so on) in the Navigator on the left side of the TopLink Workbench
window, as Figure 4—4 shows.

Figure 4-4 Sample Navigator
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The numbered callouts on Figure 44 identify the following user interface
components:

1. Project (relational project)

2. Package

3. TopLink Descriptor (relational descriptor)

4. Attribute/mapping (direct to field mapping)
5. Unsaved/changed item

6. Database

7. Database table

Click the plus ( + ) or minus ( - ) sign next to the item, or double-click the item name to
expand or collapse the item.
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TopLink Workbench identifies items that have been changed but not yet saved by
adding an asterisk ( *) in front of the item name.

When you select an item in the Navigator, its properties appear in the Editor (see
"Using the Editor" on page 4-10).

To perform specific functions for an item, select the item in the Navigator and do one
of the following:

= Right-click on the object and select the function from the context menu (see
"Context Menus" on page 4-5).

s Choose a function from the Selected menu (see "Menu Bar Menus" on page 4-5).

For information on using the Navigator with a database in relational projects, see
"Working With Database Tables in the Navigator Window" on page 4-21.

For information on using the Navigator with an XML schema in EIS projects (using
XML records) and XML projects, see "Working With XML Schemas in the Navigator"
on page 4-33.

Active and Inactive Descriptors

Inactive descriptors appear dimmed in the Navigator. Inactive descriptors are not
registered with the session when the project is loaded into Java. This feature lets you
define and test subsets of descriptors. To activate or deactivate a descriptor, right-click
the descriptor and select Activate/Deactivate Descriptor from the context menu.

Figure 4-5 Sample Active and Inactive Descriptors
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Figure 4-5 numbered callouts show the following user interface components:
1. Inactive descriptor

2. Active descriptor

Errors and Missing Information

A If an element in the project (such as a descriptor or mapping) contains an error or some
deficiency (sometimes called neediness), a warning icon appears beside the element
icon in the Navigator, and TopLink Workbench displays a message in the Problems
window (see "Using the Problems Window" on page 4-11).

Chapter 14, "TopLink Workbench Error Reference", contains more information on each
TopLink Workbench error message.

Using the Editor

The Editor, on the right side of the TopLink Workbench window, displays the property
sheet associated with the currently selected item in the Navigator, as Figure 4-6
shows.
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Figure 4-6 Sample Editor
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Figure 4-6 numbered callouts identify the following user interface components:
1. Selected element (from the Navigator)

2. Editor property tabs

Using the Problems Window

A If an element in the project (such as a descriptor or mapping) contains an error or some
deficiency (sometimes called neediness), the TopLink Workbench displays a caution
icon (represented by a yellow triangle with a black exclamation point in the middle) to
the left of the deficient element in the Navigator (see "Using the Navigator" on
page 4-9) and displays a message in the Problems window as Figure 4-7 shows.

If you select the error, then TopLink Workbench displays the complete error message
in the Problems window. Chapter 14, "TopLink Workbench Error Reference" contains
detailed information on each error message.

Figure 4-7 Sample Deficient Mapping
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Double-click any error message in the Problems window to automatically highlight
the specific node in the Navigator. To display or hide the Problems window, select
Window > Show Problems from the menu.

You can also create a status report (see "Generating the Project Status Report" on
page 18-12) that includes all errors in a selected project.

Using the Online Help

TopLink Workbench contains an extensive online Help system to assist you in
developing TopLink applications. You can use the online Help system in a hosted or
local environment (see "Help Preferences” on page 4-14).

To receive help on any field, tab, or element in TopLink Workbench, right-click the
element and select Help from the context menu or press F1.

To review the complete TopLink documentation and Quick Start, click Help.

Working With TopLink Workbench Preferences

To customize TopLink Workbench, select Tools > Preferences from the menu. The
Preferences dialog box appears.

Figure 4-8 Preferences Dialog Box
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TopLink Workbench provides the following preferences:
= General Preferences
- Help Preferences
= Mappings Preferences
—  Class Preferences
—  EJB Preferences
— Database Preferences
= Sessions Configuration Preferences

— New Names Preferences
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—  Platform Preferences

Use this dialog box to configure TopLink Workbench preferences. After changing
preferences, you must restart TopLink Workbench.

To import your preferences from an existing file, click Import and select the file.

To export your preferences, click Export and select a directory location and filename.

General Preferences

Use the General preferences to customize the look and feel (the graphical user
interface) of TopLink Workbench as well as to specify any proxy information required
to access the Internet (for example, to allow TopLink to access XML schemas and
on-line documentation hosted on Internet sites). Follow these steps to customize the
General preferences:

1. Select Tools > Preferences from the menu. The Preferences dialog box appears.

2. Select General in the Category window.

Figure 4-9 Preferences—General Dialog Box

:\: Preferences

General

Display Splash Screen

Look and Feel: ‘Windows w
i Size of recently opened Files list: AllES
[ Sessions Configuration
_____ Mew Mames HTTP Praosxy Host: WA-pEay U5, o acle. com
= Platform HTTP Prascy Pott: 30

MNetwark Connect Timeout (seconds): | 10
MNetwaork Read Timeaut (seconds): 10

|:| Reopen Projects on Startup

[ Impork... H Expork... H (a4 H Cancel ]

Use the following information to enter data in each field of the dialog box:

Field Description

Display Splash Screen  Specify if TopLink Workbench should show the graphical splash
screen when starting.

Look and Feel Select the look and feel to use for TopLink Workbench.

Size of recently opened  Select the number of projects to maintain in the File > Reopen

files list option. See "Opening Existing Projects" on page 18-10 for more
information.

HTTP Proxy Host Specify if your PC requires a proxy server to access the internet.

HTTP Proxy Port Specify the port used by your proxy host.

Network Connect Specify the timeout (in seconds) to establish a network or internet

Timeout connection.
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Field Description

Network Read Timeout Specify the timeout (in seconds) when accessing data from a
network or internet connection.

Reopen Projects on Select to reopen the projects that were open the last time you exited
Startup the TopLink Workbench.

You must restart TopLink Workbench to apply the changes.

Help Preferences

Use the Help preferences to select the location of the TopLink documentation (in
addition to the online Help) and other Help system preferences.

By default, TopLink installs includes only the online Help and release notes. All other
documentation (such as Oracle TopLink Getting Started Guide and Oracle TopLink
Developer’s Guide) can be accessed from a hosted location.

1. Select Tools > Preferences from the menu. The Preferences dialog box appears.

2. Expand General in the Category window and select Help. The Preferences—Help
dialog box appears.

Figure 4-10 Preferences—General-Help Dialog Box

:\: Preferences

=)~ aeneral Help
= Mappings Display Welcome at Startup

Class External HTML Browser:

EJB
Database Ci\Program FilesiMozilla Firefoxifirefox, exe

- Sessions Configuration
Mew MNames

! Platform () Local Help Content:
“ Platfarms

(%) Hosted Help Content

[ Import... ][ Export... ” (o] 4 H Cancel

Use the following information to enter data in each field:

Field Description
Display Welcome at Specify if TopLink should show the Welcome screen each time you
Startup start TopLink Workbench.

External HTML Browser Click Browse and select the location of your default Web browser.
You must specify a Web browser to access the Quick Tour, Javadoc
(API), and other Web-based material.
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Field Description

Hosted Help Content! Access the complete TopLink documentation set located on Oracle
Technology Network (OTN). Selecting this option requires your PC
to have Internet access.

Note: Depending on your Internet connection, using Hosted
Documentation may impact performance when searching the
documentation.

Local Help Content! Access the complete TopLink documentation set from a local
location (such as your PC or your company’s intranet).

Click Browse and select the help JAR file location.

! You must restart TopLink Workbench to apply changes to this option.

Note: When using Hosted Help Content, ensure that your proxy
information, specified in the General Preferences, is correct.

When using Local Help Content, download the complete
documentation from OTN. See Oracle TopLink Getting Started Guide for
more information.

Mappings Preferences

Use the Mappings preferences to specify general mapping preferences. Follow these
steps to set the Mapping preferences:

1. Select Tools > Preferences from the menu. The Preferences dialog box appears.

2. Select Mappings in the Category window. The Mappings dialog box appears.

Figure 4-11 Preferences—-Mappings Dialog Box

:\: Preferences

= General Mappings
: Allow changing query bype

QO ves )Mo (&) Prompt

Allow changing query Format

) es (@] (%) Prompt

[ Import.., ][ Export... H (o] 4 H Cancel

Use the following information to enter data in each field:
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Field Description

Allow changing query  Configure whether or not TopLink Workbench always allows,

type never allows, or prompts before allowing you to change the query
type associated with a descriptor.

Allow changing query  Configure whether or not TopLink Workbench always allows,

format never allows, or prompts before allowing you to change the

configuration of a query associated with a descriptor.

Class Preferences

Use the Class preferences to specify how TopLink Workbench maintains classes when
renaming or editing a zero-argument constructor. Follow these steps to set the Class

preferences:

1. Select Tools > Preferences from the menu. The Preferences dialog box appears.

2. Expand Mappings in the Category window and select Class.

Figure 4-12 Preferences — Mappings — Class Dialog Box

:\: Preferences

-Database
Sessions Configuration
- Mew Names
H - Platform
... Platfarms

Class

Maintain a zero-argument construckor while editing classes

If an existing zero-argument constructor is renamed or a parameter is added
ta ik, the Workbench will add another zero-argument construckor to the class,

) es
) No
(%) Prampt

[ Import.., ][ Export... ” (o] 4 H Cancel ]

On the Preferences-Mappings—Class dialog box, specify how TopLink Workbench
maintains classes when renaming or editing a zero-argument constructor.

EJB Preferences

Use the EJB preferences to specify how TopLink Workbench updates the
ejb-jar.xml file when saving EJB projects. Follow these steps to set the EJB

preferences:

1. Select Tools > Preferences from the menu. The Preferences dialog box appears.

2. Expand Mappings in the Category window and select EJB.
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Figure 4-13

Preferences—Mappings—EJB Preferences Dialog Box

:\; Preferences

(= General EIB

i e Help

- Mappings ‘irike ejb-jar.xml on project save

() Always () Mewer (%) Prompt

Allow removing EJE info
O ves )Mo (%) Prompt
Allow removing EJE 2.x info
O ves )Mo (%) Prompt

[ Imnpark. .. ] [ Expart... ] [ 0].4 ] [ Cancel ]

Use the following information to select how TopLink Workbench will update the

ejb-jar.xml file:

Field

Description

Write ejb-jar.xml on
project save

Configure whether or not TopLink Workbench always updates,
never updates, or prompts before updating the ejb-jar.xml file
each time you save the project.

Allow removing EJB
info

Configure whether or not TopLink Workbench always allows,
never allows, or prompts before allowing you to remove the EJB
information associated with a descriptor. See "Configuring a
Descriptor With EJB Information" on page 25-45 for more
information.

Allow removing EJB 2.x
info

Configure whether or not TopLink Workbench always allows,
never allows, or prompts before allowing you to remove the EJB 2.0
or 2.1 information associated with a descriptor. See "Configuring a
Descriptor With EJB Information" on page 25-45 for more
information.

Database Preferences

Use the Database preferences to specify custom database divers and connection URLs
for TopLink Workbench. These drivers and URLs can then be used when defining
database logins. Follow these steps to set the Database preferences:

1. Select Tools > Preferences from the menu. The Preferences dialog box appears.

2. Expand Mappings in the Category window and select Database.
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Figure 4-14 Preferences-Mappings—Database Preferences Dialog Box

:\; Preferences

= General Database
[
5 Mappings Database Driver: | |

Connection LURL: | |

- Sessions Configuration
Mew Mames

: PlatFarm
Lo Platforms

[ Import... H Export... H (o] 4 H Cancel

Use the following information to enter data in each field:

Field Description
Database Driver Enter the custom database driver class name.
Connection URL Enter the custom database connection URL.

Sessions Configuration Preferences

Use the Sessions preferences to specify default classpaths to be added to each newly
created TopLink sessions configuration for features that require an external Java class
(for example, session event listeners). The entries added here will automatically
appear on the Sessions Configuration property sheet (see "Configuring a Sessions
Configuration” on page 73-2). Follow these steps to set the Sessions Configuration
preferences:

1. Select Tools > Preferences from the menu. The Preferences dialog box appears.

2. Select Sessions Configuration in the Category window.
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Figure 4-15 Preferences—Sessions Configuration Dialog Box

:\; Preferences

Sessions Configuration

Default Classpath For Mew Sessions Configuration

Add Entry

[ Import... H Export... H (o] 4 H Cancel ]

To add a JAR or ZIP file, click Add Entry or Browse and add the JAR or ZIP files that
contain the default compiled Java classes for this sessions configuration.

To remove a JAR or ZIP file, select the file and click Remove.

To change the order in which TopLink searches these JAR or ZIP files, select a file and
click Up to move it up, or click Down to move it down in the list.

New Names Preferences

Use the New Names preferences to specify the default values and names of newly
created sessions, session brokers, and connection pools. Follow these steps to set the
New Names preferences:

1. Select Tools > Preferences from the menu. The Preferences dialog box appears.

2. Expand Sessions Configuration in the Category window and select New Names.

Figure 4-16 Preferences—Sessions Configuration—-New Names Dialog Box

:\: Preferences

New Names
Default Mew Mames
- Sessions Configuration: | sessions_config | xml
EJB : 2
i Database Session: | Session |
Sessions Configuration Ercker: | MySessionBroker |
[ Ievi Names
Conneckion Pool: | ConnectionPool |
Irnpark. .. ] [ Expart... ] [ QK ] [ Cancel
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Use the following information to enter data in each field:

Field

Description

Sessions Configuration

Specify the default name for newly created sessions configuration
files (default, sessions.xml). See "Creating a Sessions
Configuration" on page 73-1 for more information.

Session Specify the default name for newly created sessions (default,
Session). See "Session Creation Overview" on page 73-1 for more
information.

Broker Specify the default name for newly created session brokers (default,

SessionBroker). See "Creating Session Broker and Client
Sessions" on page 73-6 for more information.

Connection Pool

Specify the default name for newly created connection pools
(default, ConnectionPool). See Chapter 85, "Creating an Internal
Connection Pool" for more information.

Platform Preferences

Use the Platform preferences to specify the default data source type for newly created
sessions. The type selected here will automatically appear on the Create New Session
dialog box. Follow these steps to set the Platform preferences:

1. Select Tools > Preferences from the menu. The Preferences dialog box appears.

2. Expand Sessions Configuration in the Category window and select Platform.

Figure 4-17 Preferences—Sessions Configuration—Platform Preferences Dialog Box

:\: Preferences

:-- Database

Mew Marmes
Form
“ Platforms

Platform

[[] Use Server Platfarm

essions Configuration Default Daka Source Type

() Database

(&) EIS

O ML

Platform: IEM MQSeries v

[ Import. .. H Export... ” QK H Cancel

Use the following information to enter data in each field:

Field

Description

Use Server Platform

Specify the default application server platform for newly created
sessions configuration files (default, sessions.xml). See "Creating
a Sessions Configuration" on page 73-1 for more information.

Default Data Source
Type

Select the default data source type (Database, EIS, or XML) and
platform for newly created sessions. See "Configuring the Server
Platform" on page 74-14 for more information.
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Working With Databases

In relational projects, when you expand the database object in the Navigator, TopLink
Workbench displays the database tables associated with the project. You can associate
tables by importing them from the database, or by creating them within TopLink
Workbench.

Figure 4-18 Sample Database Tables

™ Navigator

i o= Employee =
@_ = INTRO_TUTORIAL_DB
E ADDRESS

@_— FH EMPLOYEE Il

B PHOME

-

Figure 4-18 numbered callouts identify the following database icons.

1. Project

2. Database

3. Database table

Each database table property sheet contains the following tabs in the Editor:

s Columns-Add or modify the table’s fields, and specify each field’s properties.
= References—Specify references between tables.

This section includes information on the following topics:

= Working With Database Tables in the Navigator Window

= Working With Database Tables in the Editor Window

= Generating Data From Database Tables

Working With Database Tables in the Navigator Window

This section describes the following options:
= Logging In and Out of a Database

»  Creating New Tables

s Importing Tables From a Database

= Removing Tables

= Renaming Tables

= Refreshing Tables From the Database

See "Working With Database Tables in the Editor Window" on page 4-25 for more
information.

Logging In and Out of a Database

To log in or out of a relational database, do the following:

1. Create a database login (see "Database Login Configuration Overview" on
page 83-1).
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2. Tologin to a relational database, right-click the database object in the Navigator,
and choose Log In to Database from the context menu or choose Selected > Log
In to Database from the menu.

3. Tolog out of a relational database, right-click the database object in the Navigator
and choose Log Out of Database from the context menu or choose Selected > Log
Out of Database from the menu.

Creating New Tables

To create a new database table within TopLink Workbench, use the following
procedure:

o 1. Select the database object in the Navigator window and click Add New Table. The
New Table dialog box appears.

You can also right-click the database object and choose Add New Table from the
context menu, or choose Selected > Add New Table from the menu.

Figure 4-19 New Table Dialog Box

:\: New Table

Enter new table name:

Catalog:

Schema:

Table Marne:
MEWTABLE

Help ] [ oK H Cancel

Use the following information to enter data in each field:

Field Description

Catalog Use to identify specific database information for the table. Consult
your database administrator for more information.

Schema Use to identify specific database information for the table. Consult
your database administrator for more information.

Table Name Specify the name of this database table.

TopLink Workbench adds the database table to the project.

Although the database table has been added to the project, it has not been written to
the actual database. See "Generating Tables on the Database" on page 4-32 for more
information on creating the table in the database.

Continue with "Working With Database Tables in the Editor Window" on page 4-25 to
use these tables in your project.

Importing Tables From a Database

TopLink Workbench can automatically read the schema for a relational database and
import the table data into the project as long as your JDBC driver supports the
following JDBC methods:

m getTables
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m getTableTypes

s getImportedKeys
m getCatalogs

m getPrimaryKeys

The JDBC driver must be on the TopLink Workbench classpath (see "Configuring the
TopLink Workbench Environment" on page 4-2).

To import tables from the database, use the following procedure:

1. Select the database object in the Navigator, and click Add/Update Existing Tables
from Database. The Import Tables from Database dialog box appears.

You can also right-click on the database object in the Navigator and choose
Add/Update Existing Tables from Database from the context menu or choose
Selected > Add/Update Existing Tables from Database from the menu.

Figure 4-20 Import Tables from Database Dialog Box

:‘;I Import Tables from Database

Table Mame Pattern: | %

: Catalog: <Ignore -
MY

Schema Pattern:

Table Type: TAEBLE w

Get Table Mames
Available Tables: Selected Tables:

(2w aoDRESS Al 2]

i EMPLOYEE J
W LPROJECT

i PHOMNE

iy PROJ_EMP

W PROJECT

Wi RESPONS |

[ Import: Fully Gualified Names

(% )]

Figure 4-20 numbered callouts identify the following user interface components:
1. Filters
2. Database tables that match the filters

Use the following information to enter data in each field of the dialog box:

Field Description

Table Name Pattern Specify the name of database table(s) to import. Use percent
character ( %) as a wildcard. Tables that match the Table Name
Pattern can be imported.

Catalog Specify the catalog of database table(s) to import.

Schema Pattern Specify the schema of database table(s) to import.

Table Type Specify the type of database table(s) to import.

Available Tables Click Get Table Names to make TopLink display tables that match
Table Name Pattern, Catalog, Schema Pattern, and Table Type
settings.
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Field Description

Selected Tables Select the tables in the Available Tables area to import, and click
the right-arrow button. TopLink adds the table to the Selected
Tables field.

Click OK to import the tables from the database into the TopLink
Workbench project.

Import Fully Qualified  Specify whether or not the tables” names are fully qualified against
Names the schema and catalog.

Examine each table’s properties to verify that the imported tables contain the correct
information. See "Working With Database Tables in the Editor Window" on page 4-25
for more information.

Removing Tables
To remove a database table from the project, use the following procedure:

1. Select a database table in the Navigator, and click Remove Table on the toolbar.
TopLink Workbench prompts for confirmation.

You can also right-click on the database object and choose Remove from the
context menu or choose Selected > Remove Table from the menu.

2. Click OK. TopLink Workbench removes the table from the project.

Note: Although you have removed the table from the TopLink
Workbench project, the table remains in the database.

Renaming Tables

To rename a database table in the TopLink Workbench project, use the following
procedure:

1. Right-click the table in the Navigator and choose Rename from the context menu.
The Rename dialog box appears.

You can also select the table and choose Selected > Rename from the menu.

2. Enter a new name and click OK. TopLink Workbench renames the table.

Note: Although you have renamed the table in the TopLink
Workbench project, the original table name remains in the database.

Refreshing Tables From the Database
To refresh (that is, reload) the database tables in the TopLink Workbench project, use
this procedure:

Select a database table in the Navigator, and click Refresh from Database on the
toolbar.

You can also select the table and choose Selected > Refresh from Database from the
menu, or click Refresh. TopLink Workbench reloads the database table.

When refreshing tables from the database, if there are multiple database tables with
similar names, the Duplicate Tables dialog box appears.
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Figure 4-21 Duplicate Table Dialog Box

T Duplicate Tables for DUAL

The table DUAL has multiple matches on the database, please select the table From which vou waould like ta refresh:
FUBLIC.DUAL
SYS.DUAL

Select the specific database table to update, and then click OK.

Working With Database Tables in the Editor Window

When you select a database table in the Navigator, its properties appear in the Editor.
Each database table contains the following property tabs:

s Columns—Add or modify the table fields, and specify each field properties.
= References—Specify references between tables.

This section describes how to use these tabs to configure the following;:

= Working With Column Properties

»  Setting a Primary Key for Database Tables

»  Creating Table References

s Creating Field Associations

Working With Column Properties

Use the database table’s Column tab to specify properties for the database table’s
fields.

To specify a table’s column properties, use this procedure:

1. Select a database table in the Navigator. The table’s property sheet displays in the
Editor.

2. C(lick the Columns tab.

Figure 4-22 Fields Properties

Mame Type Size Sub-Size | Allows Mull | Unique | Primary Key | Identity Add...
DESCRIP VARCHARZ  w | 200 % O F
LEADER,_ID MUMBER, v | 152 o2 O O
PROI_ID MUMBER, v| 133 ofs O
PROJ_NAME  |VARCHARZ w | 303 Ll i
PROI_TYPE YARCHARZ  + 1|8 O O
WERSION MUMBER, v | 133 ol L O

Use the following information to fill each column on the Columns tab:
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Field Description
Name Specify the name of the field.
Type Use the drop-down list to select the field’s type.
Note: The valid values will vary, depending on the database.
Size Specify the size of the field.
Sub-Size Specify the sub-size of the field.
Allows Null Specify if this field can be null.
Unique Specify whether the value must be unique within the table.
Primary Key Specify whether or not this field is a primary key for the table (see

"Setting a Primary Key for Database Tables" on page 4-26).

Identity Use to indicate a Sybase, SQL Server or Informix identity field.

Note: Some properties may be unavailable, depending on your
database type.

To add a new field, click Add.
To remove a field, select the field and click Remove.

To rename a field, select the field and click Rename.

Setting a Primary Key for Database Tables
To set a primary key(s) for a database table, use this procedure:

Note: TopLink Workbench can automatically import primary key
information if supported by the JDBC driver.

1. Select a database table in the Navigator. Its property sheet appears in the Editor.
2. Click the Columns tab.

Figure 4-23 Setting Primary Key for a Database Table

5 ¢ References

Mame Tvpe Size Sub-Size | Allows Mull | Unique | Primary Key | Identiby m
DESCRIP VARCHARZ 200 :

Primary key

v O O
LEADER._ID MUMBER: v | 15/% (1] O /,/%-ﬂ\
PROI_ID MUMEBER. wv| 152 1}k O ( )
PROI_MAME  |VARCHARZ | 302 O \“-—Ef/
PROI_TYPE YARCHARZ 1@ O O
WERSION MUMEBER. v| 152 1}k | O

3. Select the Primary Key field(s) for the table.
Creating Table References

References are table properties that contain the foreign key; they may or may not
correspond to an actual constraint that exists on the database. TopLink Workbench
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uses these references when you define relationship mappings and multiple table
associations.

When importing tables from the database, TopLink Workbench can automatically
create references (if the driver supports this), or you can define references from the
workbench. See "Importing Tables From a Database" on page 4-22.

To create a new table reference, use this procedure:

1. Select a database table in the Navigator. The table’s properties display in the
Editor.

2. C(lick the References tab.

Figure 4-24 References Tab

Columns | References |

@——l Mame Target Table On Database Add. ..

EMPLOYEE_ADDRESS  eeeiaa)

Remove

EMPLOYEE_EMPLOYEE | EMPLOYEE A _

Rename...

EMPLOYEE _SALARY SALARY v O
@—— Source Column Target Column Add
ADDR._ID | ADDRESS_ID v

Figure 4-26 numbered callouts identify the following user interface components:
1. Table References area
2. Key Pairs area

3. Inthe References area, click Add. The New Reference dialog box appears.

Figure 4-25 New Reference Dialog Box

:\: New Reference

Enter Mame of Mew Reference:

Select the Source Table:

Select the Target Table:
BODRESS

[] On Database

Use the following information to enter data in each field of the dialog box:

Field Description
Enter Name of New Specify the name of the reference table. If you leave this field
Reference blank, TopLink Workbench automatically creates a name based on

the format: SOURCETABLE_TARGETTABLE.
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Field Description

Select the Source Table  Specify the name of the source database table (the currently
selected table in the Navigator).

Select the Target Table Use the list to specify the target table for this reference.

On Database Specify if you want to create the reference on the database when
you create the table. Not all database drivers support this option.

Continue with "Creating Field Associations" on page 4-28.

Creating Field Associations

For each table reference, you can specify one or more field associations that define how
fields in the source table relate to fields in the target table. See "Creating Table
References" on page 4-26.

To create new field references, use this procedure:

1. Select a database table in the Navigator. The table’s properties display in the
Editor.

2. Click the References tab.

Figure 4-26 References Tab

Colurnns | References

@— MName Target Table On Database

ADDRESS

EMPLOYEE _SALARY SALARY A O

EMPLOYEE_EMPLOYEE | EMPLOYEE w

@— Source Column Target Column

ADDR._ID “ | ADDRESS_ID A4 |

Figure 4-26 numbered callouts identify the following user interface components:
1. Table references area
2. Key pairs area

3. Select a table reference from the references area.

4. To create a new key pair, click Add in the key pairs area and complete each field in
the key pairs area using the following information:

Field Description

Table References Area

Reference Name Specify the name of this table reference
Target Table Specify the database table that is the target of this
reference.
On Table Specify if the reference exists on the database.
Key Pairs Area
Source Field Select the database field from the source table.
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Field Description

Target Field Select the database field from the target table.

Generating Data From Database Tables

TopLink Workbench can automatically generate a variety of information from the
database tables. This section describes the following:

s Generating SQL Creation Scripts
= Generating Classes and Descriptors From Database Tables
= Generating EJB Entity Beans and Descriptors From Database Tables

= Generating Tables on the Database

Generating SQL Creation Scripts

Using the TopLink Workbench, you can generate SQL scripts that you can use to create
tables in a relational database.

To automatically generate SQL scripts to create the tables in a project, use this
procedure:

1. Select the database table(s) in the Navigator.

2. Right-click the table(s) and choose Generate Creation Script for > Selected Table
or All Tables from the context menu. The SQL Creation Script dialog box appears.

You can also choose Selected > Generate Creation Script for > Selected Table or
All Tables from the menu.

Figure 4-27 SQL Creation Script Dialog Box

:\: SQL Creation Script

DROP TABLE PROJECT ~
CREATE TABLE PROJECT (PROJ_TYPE YARCHARZ{1) MULL, DESCRIP YARCHARZ(200)
MULL, YERSION MUMBER(15) MULL, LEADER_ID MUMBER(15) NULL, PROI_NAME
WARCHARZ(30) NULL, PROJ_ID NUMBER{15) NOT MULL, PRIMARY KEY (PROI_IDN

DROP TABLE PHONE

CREATE TABLE PHONE {P_NUMBER. YARCHARZ(7) MULL, AREA_CODE YARCHARZ(Z)
MULL, EMP_ID NUMEERS 15) MOT MULL, T¥PE YARCHARZ{15) NOT MULL, PRIMARY KEY
(EMP_ID, TYPE))

DROP TABLE PRO1_EMP

CREATE TABLE PROJ_EMP (EMP_ID NUMBER(15) NOT MULL, PROJ_ID MUMBER(15)

MOT NULL, PRIMARY KEY (EMP_ID), PROI_IDY)

DROP TABLE EMPLOYEE

(CREATE TABLE EMPLOYEE (START_DATE DATE NULL, GENDER YARCHARZ(1) NULL,
END_TIME DATE MULL, END_DATE DATE NULL, START _TIME DATE NULL, VERSION
MUMBER(15) MULL, ADDR_ID NUMBER{ 15) MULL, MAMAGER_ID NUMBER{ISI NULL, o

[ oo JL ]

Copy the script and paste it into a file. You may need to edit the file to include
additional SQL information that TopLink Workbench could not generate. If the
database table or column name is an SQL reserved word, you must edit the SQL script
and enclose the database table or column in quotes. See "Oracle Database Reserved
Words" in the Oracle Database SQL Reference Guide for more information.

Note: If TopLink cannot determine how a particular table feature
should be implemented in SQL, it generates a descriptive message
in the script.
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Generating Classes and Descriptors From Database Tables

TopLink Workbench can automatically generate Java class definitions, descriptor
definitions, and associated mappings from the information in database tables. You can
later edit the generated information if necessary.

For each table, TopLink Workbench does the following;:

s Creates a class definition and a descriptor definition.

= Adds attributes to the class for each column in the table.

= Automatically generates access methods, if specified.

»  Creates direct-to-field mappings for all direct (nonforeign key) fields in the table.

»  Creates relationship mappings (one-to-one and one-to-many) if there is sufficient
foreign key information. You may be required to determine the exact mapping

type.

Note: Class and attribute names are generated based on the table
and column names. You can edit the class properties to change
their names.

To generate classes and descriptors from database tables, use the following
procedure:

1. Select the database table(s) in the Navigator.

2. Right-click the table(s) and choose Generate Classes and Descriptors from >
Selected Table or All Tables from the context menu.

You can also choose Selected > Generate Classes and Descriptors from >
Selected Table or All Tables from the menu.

3. Click Yes. The Generate Classes and Descriptors dialog box appears.

Figure 4-28 Generate Classes and Descriptors Dialog Box

I\; Generate Classes and Descriptors

Package Mame:

Generate Accessing Methods

|

Use the following information to enter data in each field:

Field Description

Package Name Specify the name of package to generate. The package name must
comply with Java naming standards.

Generate Accessing Specify if TopLink Workbench generates accessing methods for

Methods each class and descriptor.

If the table contains foreign key fields that may represent relationship mappings, then
the Choose Relationships to Generate dialog box appears.
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!

Figure 4-29 Choose Relationships to Generate Dialog Box

I\; Choose Relationships to Generate

Based on the foreign keys of the tables, some relationship mappings can be generated, Select the appropriate
relationships below and indicate their kvpes using the mapping buttans,

Potential Relationships: Selected Relationships:

EMPLOYEE (EMP_ID) =3 EMPLOYEE (MANAGER_ID)

EMPLOYEE (MANAGER_ID) == EMPLOYEE (EMP_ID)

e

[] Generate Bi-directional Relationships

%o

Select an entry from Potential Relationships and click the 1:1 Mapping or 1:M
Mapping button, located between the Potential Relationships and Selected
Relationships windows. See Chapter 33, "Understanding Relational Mappings" for
more information on mappings.

You can also specify whether the relationships are bidirectional. See "Configuring
Bidirectional Relationship" on page 32-34 for more information.

Click OK to automatically create the relationships.
The newly created descriptors appear in the Navigator of TopLink Workbench.

Generating EJB Entity Beans and Descriptors From Database Tables

Using TopLink Workbench, you can automatically generate EJB entity beans and
descriptors for each database table, including the following;:

= One EJB descriptor that implements the <javax.ejb.EntityBeans> and entity
bean classes

s Bean relation attributes (CMP or BMP)
= Java source for each class

s EJB-compliant method stubs

Note: This option is available only for projects with
container-managed or bean-managed persistence. See "Configuring
Persistence Type" on page 19-5 for more information.

To automatically generate EJB entity beans and descriptors for each database table, use
this procedure:

1. Select the database table(s) in the Navigator.

2. Right-click the table(s) and choose Generate EJB Entities and Descriptors from >
Selected Table or All Tables from the context menu. TopLink Workbench prompts
you to save your project.

You can also choose Selected > Generate EJB Entities and Descriptors from >
Selected Table or All Tables from the menu.

3. (Click Yes to save your project before generating EJB entities. The Generate EJB
Entity Classes and Descriptors dialog box appears.
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Figure 4-30 Generate EJB Entity Classes and Descriptors Dialog Box

T Generate EJB 2.0 CMP Entity Classes and Descriptors E|

Package Mame:
;L?e;%ﬂ;.lg %;;;pear Generate Local Inkerfaces
and BMP projects only. [] Gererate Remote Interfaces
T

Use the following information to enter data in each field on the Generate EJB Entity
Classes and Descriptors dialog box:

Field Description

Package Name Name of the package to contain the generated entity
beans and descriptors.

Generate Local Interfaces’ Specify if TopLink creates local interfaces for the EJB
entity beans.

Generate Remote Interfaces! Specify if TopLink creates remote interfaces for the EJB
entity beans.

! For CMP and BMP projects only. See "Configuring a Descriptor With EJB Information" on page 25-45 for
more information.

If the table contains foreign key fields that may represent relationship mappings, then
the Choose Relationships to Generate dialog box appears. Select a potential
relationship and click the 1:1 Mapping or 1:M Mapping button, located between the
Potential Relationships and Selected Relationships windows.

You can also specify if the relationships are bidirectional (see "Configuring
Bidirectional Relationship" on page 32-34).

Repeat for all appropriate sets of tables.
Click OK to generate the relationship mappings.

The system creates the remote primary key, home, and bean classes for each bean and
adds this information to the project.

Generating Tables on the Database

To create a table in the database, based on the information in TopLink Workbench, use
this procedure:

Note: You must log in the database before creating tables. See
"Logging in to the Database" on page 20-7 for more information.

1. Select the database table(s) in the Navigator.

2. Right-click the table(s) and choose Create on Database > Selected Table or All
Tables from the context menu.

You can also create tables by selecting Selected > Create on Database > Selected
Table or All Tables from the menu.

TopLink Workbench creates the tables on the database.
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Alternatively, you can generate tables at run time by exporting the information in
TopLink Workbench to a TableCreator class (see "Understanding the Schema
Manager" on page 5-1).

Working With XML Schemas

For XML and EIS projects, TopLink Workbench maps each TopLink descriptor to your

XML schema.

This section includes information on the following topics:

Working With XML Schemas in the Navigator
Working With XML Schema Structure

Importing an XML Schema

Configuring XML Schema Reference

Configuring XML Schema Namespace

Working With XML Schemas in the Navigator

After you import one or more XML schemas into your project (see Importing an XML
Schema on page 4-34) and you expand the schema object in the Navigator, TopLink

Workbench displays the schemas associated with the project.

Figure 4-31 Sample XML Schemas
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Figure 4-31 numbered callouts identify the following schema icons:

1.
2.
3.

Project
Schemas object

Specific schema
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For more information, see the following:

= "Working With XML Schema Structure" on page 4-34

s "Configuring XML Schema Reference" on page 4-36

s "Configuring XML Schema Namespace" on page 4-37

Working With XML Schema Structure

When you select a specific XML schema in the Navigator, you can display the
structure and details of the schema using the Schema Structure tab.

To display the structure and details of a schema, use this procedure:

1. Select a schema element in the Navigator. Its properties appear in the Editor.

2. Click the Schema Structure tab. The Schema Structure tab appears.

3. Select an element in the schema. The element’s details appear.

Figure 4-32 Schema Structure Tab

Schema Document Info | Schema Structure
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lement: name="area-code"
lement: name="number"
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Use the following information to verify data in each field in the Schema Document

Info tab:

Field

Description

Schema Structure

Displays the elements of the schema, listed in alphabetical order, in
an expandable or collapsible tree structure.

Details

Displays detailed information (such as name and type) for the
currently selected element in the Schema Structure area.

These fields are for display only and cannot be changed in TopLink Workbench.

Importing an XML Schema

The first step in configuring an EIS project (using XML records) or XML project is
importing the XML schema(s) that your project uses.

When you import a schema, you define a schema reference that gives TopLink the
information it needs to locate the schema itself. Anytime after you import an XML
schema, you can update the schema reference (see "Configuring XML Schema
Reference" on page 4-36) if necessary.

After importing an XML schema, you can configure XML schema namespaces (see
"Configuring XML Schema Namespace" on page 4-37).
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To import an XML schema into an EIS project (using XML records) or an EIS project,
use this procedure:

1. Right-click the schemas element in the Navigator and select Import Schema from
the context menu. The Import Schema dialog box appears.

Figure 4-33 Import Schema Dialog Box

:\: Import Schema

Marne:

Source:

(%) File:
O URL:
() Classpath:

Use the following information to enter data in each field in the Import Shema dialog
box:

Field Description

Name Specify the name of this schema. This is the display name that
TopLink Workbench uses. It can be different than the name you
specify when you configure Source.

Source Select how TopLink Workbench should import the schema.

File Specify that TopLink Workbench should import the schema from a
file.

Enter the fully qualified directory path and filename of the schema
file.

URL Specify that TopLink Workbench should import the schema using a
URL.

Enter the complete URL of the schema file.

Note: When importing schemas by URL, ensure you have set your
proxy information correctly. See "General Preferences” on page 4-13
for more information.

Classpath Specify that TopLink Workbench should import the schema from the
project classpath.

Resource Name Enter the fully qualified name of the XML schema file including the
name of the package of which it is a part. For example, if your XML
schema mySchema.xsd is in C: \project\config and you add this
directory to your project classpath (see "Configuring Project
Classpath" on page 19-3, specify a resource name of
project.config.mySchema.xsd.

To reimport a specific schema, right-click on the specific schema in the Navigator and
select Reimport Schema from the context menu.

To reimport all schemas in a project, right-click on Schemas in the Navigator and select
Reimport All Schemas from the context menu.
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To change a schema’s source, right-click on the specific schema in the Navigator
window and select Properties from the context menu. The Schema Properties dialog
appears.

Configuring XML Schema Reference

After you import an XML schema (see "Importing an XML Schema" on page 4-34), you
can update its source by configuring the schema reference.

Using TopLink Workbench

To specify the source of a schema, use this procedure:
1. Select a schema element in the Navigator. Its properties appear in the Editor.

2. Click the Schema Document Info tab. The Schema Document Info tab appears.

Figure 4-34 Schema Document Info Tab—Source Field

Source y

| File: "C:\Documents and Settingsippurich| Deskkopimwhnl-jaxb-rwiconfiglemploves. xsd" |

Mamespaces

Built-in Mamespaces:

Mamespace URL Prefix Declare
hitbp: f ey, w3, 0rgf2001 fXMLSchema |xs |
http: f fvwvs. w3, 0rgf200 1 f4MLSchema-instance [xsi |
Target Mamespace!

Mamespace LURL Prefix Declare
(absent) | |

Imported Mamespaces:

Mamespace URL Prefix Declare

3. Click Edit to select a new source for the selected schema. The Schema Properties
dialog box appears.

Figure 4-35 Schema Properties Dialog Box

:\: Schema Properties

Marne: | employes |

Source:
(*) File:

| ChDocuments and Settings\ppurich\Desktop\mwmml\config\.ew| [ Browse. .. ]
) URL:

) Classpath:

Reimpart H Ok H Cancel
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Use the following information to complete each field in the Schema Properties dialog
box:

Field Description

Name Specify the name of this schema. This is the display name that
TopLink Workbench uses. It can be different than the name you
specify when you configure Source.

Source Select how TopLink Workbench should import the schema.

File Specify that TopLink Workbench should import the schema from a
file.

Enter the fully qualified directory path and filename of the schema
file.

URL Specify that TopLink Workbench should import the schema using a
URL.

Enter the complete URL of the schema file.

Note: When importing schemas by URL, ensure you have set your
proxy information correctly. See "General Preferences” on page 4-13
for more information.

Classpath Specify that TopLink Workbench should import the schema from the
project classpath.

Resource Name Enter the fully qualified name of the XML schema file including the
name of the package of which it is a part. For example, if your XML
schema mySchema.xsd is in C: \project\config and you add this
directory to your project classpath (see "Configuring Project
Classpath" on page 19-3, specify a resource name of
project.config.mySchema.xsd.

Using Java

Use Java to configure schema reference. Create a descriptor amendment method (see
"Configuring Amendment Methods" on page 25-81) that instantiates the appropriate
type of XMLSchemaReference (XMLSchemaClassPathReference,
XMLSchemaFileReference, or XMLSchemaURLReference) and configures the
descriptor with it, as follows:

= If you are using EISDescriptors, the TopLink runtime does not use the schema
reference; no further configuration is required.

» If you are using XMLDescriptors, configure the descriptor with the
XMLSchemaReference using XMLDescriptor method setSchemaReference.

Configuring XML Schema Namespace

As defined in http://www.w3.org/TR/REC-xml-names/, an XML namespace is a
collection of names, identified by a URI reference, which are used in XML documents
as element types and attribute names. To promote reusability and modularity, XML
document constructs should have universal names, whose scope extends beyond their
containing document. XML namespaces are the mechanism which accomplishes this.

When you import an XML schema (see "Importing an XML Schema" on page 4-34)
such as the one that Example 4-3 shows, TopLink Workbench organizes the various
namespaces that the XML schema identifies as Table 4-3 shows.

Example 4-3 XML Schema with Namespace Options

<xsd:schema
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xmlns:<prefix>="<URI>" <!-- TopLink Workbench Built-in Namespace -->

targetNamespace="<URI>" <!-- TopLink Workbench Target Namespace -->

elementFormDefault="qualified"

attributeFormDefault="unqualified"

version="10.1.3">

<xsd:import <!-- TopLink Workbench Imported Namespace -->
namespace="http://xmlns.oracle.com/ias/xsds/opm"
schemaLocation="object-persistence 1 0.xsd"

/>

</xsd:schema>

Table 4-3 TopLink Workbench XML Schema Categories

TopLink
Workbench
Category Defined By Purpose When Needed
Built-in xmlns:<prefix>="<URI>" Provides access to types If your project uses more
defined in other XML than one XML schema or if
schemas for use as is. you want to use xsi or xsd
types.
Target targetNamespace="<URI>" The namespace you use to You may need to specify a
qualify the types you define  target namespace
for your application. If set, all depending on how element
XML documents that use and attribute form options
these types must use this are set (see "Element and
namespace qualifier. Attribute Form Options" on
page 17-23).
Imported xsd:import Provides access to types If your project uses more

defined in the corresponding than one XML schema and
built-in XML schema so that ~ you want to extend one or
you can extend the built-in ~ more built-in types.

types. Extended types must

be qualified by the target

namespace.

For more information, see "Understanding XML Namespaces" on page 17-22.

Using TopLink Workbench

To specify the namespaces of a schema, use this procedure:
1. Select a schema element in the Navigator. Its properties appear in the Editor.

2. Click the Schema Document Info tab. The Schema Document Info tab appears.
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Figure 4-36 Schema Document Info Tab—Namespaces Field
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Use the following information to complete each Namespaces field in the tab:

Field

Description

Built-in Namespaces

All namespaces defined by xmlns:<prefix>="<URI>".

Note that when a schema is imported to the TopLink
Workbench (see "Importing an XML Schema" on page 4-34),
none of the built-in namespaces” URLs are selected. If you are
using inheritance, declare the built-in namespace with xsi
prefix. Otherwise, TopLink will throw exceptions.

Target Namespaces

All namespaces defined by targetNamespace="<URI>".

Imported Namespaces

All namespaces defined by xsd: import.

Prefix

Double-click in the Prefix field to specify the prefix that
corresponds to the given namespace.

When the TopLink runtime marshalls (writes) an object to an
XML document, it uses the namespace prefixes you specify
here.

When the TopLink runtime unmarshalls (reads) an XML
document, the document may use any prefix value as long as it
corresponds to the appropriate namespace. For more
information, see "TopLink Runtime Namespace Resolution" on
page 17-26.

Declare

When selected, XML documents must use the corresponding
URI qualifier when referring to types from this namespace.
XML documents may use a different prefix value as long as
that value is associated with the appropriate namespace URL
For more information, see "TopLink Runtime Namespace
Resolution" on page 17-26.

Using Java

Using Java, to configure XML schema namespaces for an EIS descriptor (with XML
records) or an XML descriptor, create a descriptor amendment method (see
"Configuring Amendment Methods" on page 25-81) that uses EISDescriptor or
XMLDescriptor method getNamespaceResolver to configure the descriptor’s
NamespaceResolver accordingly as Example 4—4 shows.
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Example 4-4 Configuring Namespaces

public void addToDescriptor (ClassDescriptor descriptor) {
descriptor.getNamespaceResolver.put (
prefix,
namespaceURI

)i

Working With Classes

Using TopLink Workbench, you can create Java classes and packages. This section
includes information on the following;:

s Creating Classes

s Configuring Classes

= Importing and Updating Classes
= Managing Nondescriptor Classes

= Renaming Packages

Creating Classes

Oracle recommends that you develop your Java classes using an IDE such as Oracle
JDeveloper and import these existing classes into TopLink Workbench (see "Importing
and Updating Classes" on page 4-50)

However, it is sometimes convenient to create and conﬁgure classes in TopLink
Workbench: for example, when generating an object model from a database schema.

This section includes information on using TopLink Workbench to create Java classes.

For more information on using TopLink Workbench to edit classes, see "Creating
Classes" on page 4-40.

Using TopLink Workbench

To create new classes and packages from within TopLink Workbench, use this
procedure:

1. Select the project in the Navigator and click Create New Class.

You can also right-click the project in the Navigator and choose Create New Class
from the context menu or choose Selected > Create New Class from the menu.

Figure 4-37 Add New Class Dialog Box

T Add New Class

Package Mame: W

Mew Class Mame: | MewClass

|

Use the following information to enter data in each field on the Add New Class dialog
box:
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Field Description

Package Name Choose an existing package or enter a new package name. If
blank, TopLink Workbench uses the default package name.

New Class Name Enter a class name. The New Class Name must be unique within
the package.

For more information on using TopLink Workbench to edit classes, see "Configuring
Classes" on page 4-41.

Configuring Classes

Oracle recommends that you develop your Java classes using an IDE such as Oracle
JDeveloper and import these existing classes into TopLink Workbench (see "Importing
and Updating Classes" on page 4-50)

However, it is sometimes convenient to create (see "Creating Classes" on page 4-40)
and configure classes in TopLink Workbench: for example, when generating an object
model from a database schema.

This section describes using TopLink Workbench to edit classes, including the
following:

s Configuring Class Information

s Configuring Class Modifiers

= Configuring Class Interfaces

» Adding Attributes

= Configuring Attribute Modifiers

s Configuring Attribute Type Information

= Configuring Attribute Accessing Methods
= Adding Methods

s Configuring Method Modifiers

= Configuring Method Type Information

s Configuring Method Parameters

Configuring Class Information

This section includes information on Using TopLink Workbench to configure class
information.

Using TopLink Workbench To configure class and superclass information, use this
procedure:

1. Select a class in the Navigator. Its properties appear in the Editor.

2. Click the Class Info tab in the Editor.

3. Click the Class tab.

Using TopLink Workbench 4-41



Working With Classes

Figure 4-38 Class Tab, Class Information Fields
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Use the following information to enter data in each field on the tab:

Field Description
Name The name of the class. This field is for display only.
Superclass Click Browse and select a class and package that contains the

class (that is, the superclass).

Configuring Class Modifiers

This section includes information on Using TopLink Workbench to configure class
modifiers.

Using TopLink Workbench To configure class modifiers, use this procedure:
1. Select a class in the Navigator. Its properties appear in the Editor.

2. Click the Class Info tab in the Editor.

3. Click the Class tab.

Figure 4-39 Class Tab, Class Modifiers Fields

Diescriptor Info | Class Info | Gueries | Caching | Locking

Class | attributes | Methods

Mame: examples.sessions. threetier.model. Emplayves

Superclass: | java.lang.Object
< Modifiers = Interfaces Implemented

Access Modifiers

(%) public
() (Default)

Other Modifiers
[] abstract

2
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Use the following information to enter data in each field on the tab:

Field Description

Access Modifiers Use to specify whether the class is accessible publicly or not.

Only public classes are visible to the Oracle TopLink
Workbench.

Other Modifiers Specify if the class is Final or Abstract, or both. Final classes are
not included in the superclass selection lists for other classes to
extend.

Configuring Class Interfaces

This section includes information on Using TopLink Workbench to specify the
interfaces implemented by a class. You can choose any interface in the TopLink
Workbench classpath (see "Configuring Project Classpath” on page 19-3).

Although you may add interfaces to a project directly (see "Importing and Updating
Classes" on page 4-50), you do not need to do so in order to configure a class to
implement an interface.

Using TopLink Workbench To implement interfaces, use this procedure:

1. Select a class in the Navigator. Its properties appear in the Editor.

2. Click the Class Info tab in the Editor.

3. Click the Class tab.

Figure 4-40 Class Tab, Interfaces Implemented Fields

Descriptor Info | Class Info | Queries | Caching | Locking

Class | attributes | Methods

Mame: examples.sessions, threetier . model. Employves
Superclass: | java.lang.Object
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COther Modifiers
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S

Use the following information to enter data in the Interfaces Implemented field on the
Class tab:

Field Description
Interfaces Implemented To add an interface, click Add and select the interface and
package.

To remove an interface, select the interface and click Remove
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Adding Attributes

This section includes information on Using TopLink Workbench to add an attribute to
a class.

Using TopLink Workbench To add a new attribute (field) to the descriptor, click Add.

To delete an existing attribute, select the attribute and click Remove.

To rename an existing attribute, select the attribute and click on Rename.

The Attributes tab contains the following tabs:

= General

m  Accessors

Configuring Attribute Modifiers

This section includes information on Using TopLink Workbench to configure attribute
modifiers.

Using TopLink Workbench To specify access modifiers, use this procedure:

1. Select a class in the Navigator. Its properties appear in the Editor.

2. Click the Class Info tab in the Editor.

3. Click the Attributes tab. The Attributes tab contains two sub-tabs.

4. Click the General tab.

Figure 4-41 Attributes Tab, Modifiers Fields

Descriptor Info | Class Info | Queries | Caching | Locking

Class | Attribukes | Methods

Zig city : String General | Accessors
g country : YalueHolderInterface ——

n. . ¥ Maodifiers

g id : long

7 Access Modifiers Cther Modifiers
Zig pravince : String () public (3) private [ final [ transient
Sig street Skring

¢ Crprotecked () (Default) [ static [ wolatile

Type Information

Type: java.util.Map
Type Dimensionality: 0%

Map Key Type: java.lang.Object
Map Yalue Type: java.lang.String

[ add... ][ Remove ][ Rename ]

Use the following information to enter data in the Modifiers fields on the Attributes
tab:
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Field

Description

Access Modifiers

Specify how the attribute is accessible:
& Public

(I.. ' Protected—only visible within its own package and
subclasses.

a ¢ Private-not visible for subclasses

Eli:" Default-only visible within its own package

Other Modifiers

Specify whether the attribute is Final, Static, Transient, or
Volatile.

Note: Selecting some modifiers may disable others.

Configuring Attribute Type

Information

This section includes information on Using TopLink Workbench to configure attribute

type information.

Using TopLink Workbench To specify attribute type information, use this procedure:

1. Select a class in the Navigator. Its properties appear in the Editor.

Click the Class Info tab

in the Editor.

2
3. Click the Attributes tab. The Attributes tab contains two sub-tabs.
4

Click the General tab.

Figure 4-42 Attributes Tab,

Descriptor Info | Class Info | Queries | Caching
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2'. city ¢ Skring
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Type Information Fields

Locking
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Modifiers
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) protected () (Default) [ static [ wvolatile
'. Type Infomh,

Type: java,util.Map
Tvpe Dimensionality: 0%
Map Key Type: java.lang. Object
Map Yalue Tvpe: java.lang. String

Use the following information to enter data in Type Information fields on the

Attributes tab:
Field Description
Type Click Browse and select a class and package for the attribute.

Type Dimensionality

Specify the length of an array. This field applies only if Type is
an array.
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Field Description

Value Type Click Browse and select a class and package for the attribute.
This field applies for ValueHolderInterface types only.

Map Key Type Click Browse and select a class and package for the attribute.
This field applies for Map types only.

Map Value Type Click Browse and select a class and package for the attribute.
This field applies for Map types only.

Element Type Click Browse and select a class and package for the attribute.

This field applies for List types only.

Configuring Attribute Accessing Methods

This section includes information on Using TopLink Workbench to configure attribute
accessing methods. If you change an attribute and regenerate the accessing methods,
TopLink does not remove any previously generated methods.

Using TopLink Workbench To specify attribute accessing methods, use this procedure:

1. Select a class in the Navigator. Its properties appear in the Editor.

2. Click the Class Info tab in the Editor.

3. Click the Attributes tab. The Attributes tab contains two sub-tabs.

4. Click the Accessors tab.

Figure 4-43 Attributes Tab, Accessors Fields

Descriptor Info | Class Info | Queries | Caching || Locking

Class | Attributes | methods

E'l‘ city  Skring Generdl| Accessars ™

2" country : ValueHolderInterface

Sigid : lan

i - e Get Methad: | ¢ getPostalCoded) : Map “

Sig pravince @ String Set Method: (l'i. setPostalCode{Map) : void w
2" street : Skring
Generate Methods
Add Method: <none selected = w
Remove Method: | <none selected= b
Generate Methods

[ Add... H Remove ][ Rename ]

Use the following information to complete the Accessors fields on the Attributes tab:

Field Description

Get Method Choose the get method for the attribute.
This field applies for non-Collection types only.

Set Method Choose the set method for the attribute.
This field applies for non-Collection types only.
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Field Description
Add Method Choose the add method for the attribute.
This field applies for List and Map types only.
Remove Method Choose the remove method for the attribute.
This field applies for List and Map types only.
Value Holder Get Method Choose the method used to return the
ValueHolderInterface type.
This field applies for ValueHolderInterface types only.
Value Holder Set Method Choose the method used to set the ValueHolderInterface

type.
This field applies for ValueHolderInterface types only.

Value Get Method

Choose the method used to return the actual value.

This field applies for ValueHolderInterface types only.

Value Set Method

Choose the method used to set the actual value.

This field applies for ValueHolderInterface types only.

Adding Methods

This section includes information on Using TopLink Workbench to add a method to a

class.

Using TopLink Workbench To add or remove methods, use this procedure:

1. Select a class in the Navigator. Its properties appear in the Editor.

2. Click the Class Info tab in the Editor.

3. Click the Methods tab.

Figure 4-44 Class Info—Methods Tab

Descriptor Info | Class Info | Queries | Caching | Locking

Class | Attributes | Methads
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5}. setPostalCode{Map) : void

# setPostalCode(String) : void

# setProvince(String) : void

# setStreet(String) : void

@ toString() : String

Add,,. Remove

Rename

Modifiers

Access Modifiers Other Modifiers

() public () private
() protected () {Default)

Tywpe Information

Erowse...

Parameters

Type Dimensionality

To add a new method to the descriptor, click Add.

To delete an existing method, select the method and click Remove.
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To rename an existing method, select the method and click Rename.

Configuring Method Modifiers

This section includes information on Using TopLink Workbench to configure method
modifiers.

Using TopLink Workbench To specify access modifiers, use this procedure:

1. Select a class in the Navigator. Its properties appear in the Editor.

2. C(Click the Class Info tab in the Editor.

3. C(lick the Methods tab.

Figure 4-45 Methods Tab, Modifiers Fields

Descriptor Info | Class Info | Queries | Caching | Locking

Class | Attributes | Methods
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@ setCity(String) : void
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@ setPostalCode(Map) ; void

@ setPostalCode(String) : void

# setProvince(String) : void

@ setStreet(String) : void

# tosString() ¢ String Parameters

Type Dimensionality

[ Add... ][ Remove ][ Renarne ]

Use the following information to enter data in Modifiers fields on the Methods tab:

Field Description
Access Modifiers Specify how the method can be accessed:
$ Public

T ¢ Protected—only visible within its own package and
subclasses.

a ¢ Private-not visible for subclasses.

Eﬂ' Default-only visible within its own package.

Other Modifiers Specify whether the method is Abstract, Final, Synchronized,
Static, or Native.

Note: Selecting some modifiers may disable others.

Configuring Method Type Information

This section includes information on Using TopLink Workbench to configure method
type information.
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Using TopLink Workbench To specify method type information, use this procedure:
1. Select a class in the Navigator. Its properties appear in the Editor.

2, Click the Class Info tab in the Editor.

3. Click the Methods tab.

Figure 4-46 Methods Tab, Type Information Fields

Descriptor Info | Class Info | Queries | Caching | Locking

Class | Attributes | Methods

Address{) Modifiers
@ getCity() ; String Access Modifiers Other Modifiers
@ getCountry() : String () public 2 il
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@ setPostalCode(String) : void

# setProvince(String) : void
@ setStreet(String) : void
# tosString() ¢ String Parameters

Type Dimensionality

[ Add... ][ Remove ][ Renarne ]

Use the following information to enter data in Type Information fields on the Methods
tab:

Field Description

Return Type Click Browse and select a class and package for the method.

Type Dimensionality Specify the length of an array. This field applies only if Type is
an array.

Configuring Method Parameters
This section includes information on Using TopLink Workbench to configure method

parameters.

Using TopLink Workbench To specify additional method parameters, use this procedure:
1. Select a class in the Navigator. Its properties appear in the Editor.

2, Click the Class Info tab in the Editor.

3. Click the Methods tab.

Using TopLink Workbench 4-49



Working With Classes

Figure 4-47 Methods Tab, Method Parameters Fields
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Use the following information to enter data in Parameters fields on the Methods tab:

Field Description

Type Click Browse and select a class and package for the method.

Dimensionality Specify the length of an array. This field applies only if Type is
an array.

Importing and Updating Classes

This section includes information on Using TopLink Workbench to import and update
Java classes.

You can import Java classes and interfaces created in any IDE.
You can import any class on the system classpath or project classpath.

If a class exists on both the system classpath and the project classpath, TopLink
Workbench will update the class from the system classpath. To update or refresh from
the project classpath, remove the class from the system classpath and restart TopLink
Workbench.

For more information, see "Configuring Project Classpath" on page 19-3.

Using TopLink Workbench
Use this procedure to update or refresh the classes in the TopLink Workbench project.

1. Define the available classes and packages for the project on the General tab. See
"Configuring Project Classpath" on page 19-3 for information on classes and
packages.

2. Click Add or Refresh Class. The Select Classes dialog box appears.

You can also update the classes by choosing Selected > Add or Refresh Classes
from the menu.
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5

Figure 4-48 Select Classes Dialog Box

I\; Select Classes

Available Packages/Classes: Selected Classes:

+@ examples  sessions, threetier

£ examples sessions. threetier.examples J

- examples,sessions, threstier, model

[ Refresh List ] [ oK ] [ Cancel ]

Select the packages or classes (or both) to import into the project and click OK.
TopLink Workbench adds the new classes to your project in the Navigator.

By default, TopLink Workbench creates the following descriptor types for each
package and class (depending on your project type):

= Relational projects—Relational class descriptors (see "Relational Class Descriptors"
on page 24-2)

= EIS projects—EIS composite descriptors (see "EIS Composite Descriptors" on
page 24-5)

s XML projects—XML descriptors (see "XML Descriptors" on page 23-12)

See Chapter 24, "Creating a Descriptor" for more information.

Note: If the class exists on both the system classpath and the
project classpath, TopLink Workbench will update the class from
the system classpath. To update or refresh from the project
classpath, remove the class from the system classpath and restart
TopLink Workbench.

To Remove a Class From a Project, do the following:
Select the descriptor and click Remove, or choose Selected > Remove from the menu.

Managing Nondescriptor Classes

Some of the mappings in your TopLink project may reference classes that do not have
TopLink descriptors or are not included in the project.

To add, remove, or refresh Java classes that do not have TopLink descriptors, use this
procedure:

From the menu, select Workbench > Manage Non-Descriptor Classes. The Manage
Non-Descriptor Classes dialog box appears.

You can access the dialog box by right-clicking the TopLink project icon in the
Navigator and selecting Manage Non-Descriptor Classes from the context menu.
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Figure 4-49 Manage Non-Descriptor Classes Dialog Box

T Manage Non-Descriptor Classes

These are the non-descriptor classes For whom the Full class definitions have been imported into
the Workbench. Other classes may be referenced by name, but their names are all the
information that is kept.

Add/Refresh: Entire class definition is updated from class file and added to project.
Remove: Class definition is cleared. Class may still be referred to by name only,

I ExampleSessionEventAdapter (examples.sessions.threetier examples)

Select one of the following options:
s Toadd new classes, click Add. The Select Classes dialog box appears.

s Toadd new classes, click Add. The Select Classes dialog box appears (see
Figure 4-48, "Select Classes Dialog Box" on page 4-51.

Only classes that have been added to the project’s class path can be added as
nondescriptor classes. See "Configuring Project Classpath" on page 19-3 for more
information.

= To delete an existing class, select the class and click Remove.

»  To refresh the classes (for example, if you edited the classes in an IDE), click
Refresh.

Renaming Packages

When you add classes to a project, TopLink Workbench shows the classes contained in
the package to which they belong (see "Using the Navigator" on page 4-9).

You can use TopLink Workbench to change the package statements in all the Java
classes of a selected package (to move the all the classes contained by the selected

package to a new package). This is useful if you are refactoring an existing TopLink
Workbench project.

Note: The TopLink Workbench package rename feature is not
intended for migrating projects from older versions of TopLink: for
this, you must still use the TopLink Package Renamer. The Package
Renamer updates import statements for TopLink classes: it does not
change the package statements in user application classes.

For information on the TopLink Package Renamer, refer to Oracle
TopLink Release Notes and Oracle TopLink Getting Started Guide for more
information.

For more information on using TopLink Workbench to edit classes, see "Configuring
Classes" on page 4-41.

Using TopLink Workbench

To change the package of an existing class in TopLink Workbench, use this procedure:
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1. Right-click the package in the Navigator and select Rename.

You can also select the package and choose Selected > Rename from the menu.

Figure 4-50 Rename Package Dialog Box

:\: Rename Package

Erter Mewy Package Mame:

o] oo ]

Enter the package name and click OK. TopLink Workbench changes the name of the
package in the Navigator window.

For more information on using TopLink Workbench to edit classes, see "Configuring
Classes" on page 4-41.

Integrating TopLink Workbench With Apache Ant

If you use the Apache Ant Java-based build tool, you can use the Ant task and type
definitions that TopLink provides to invoke certain TopLink Workbench functions
from an Ant build file. Using these tasks, you can integrate TopLink Workbench into
your automated build process.

This section describes the following:

= Configuring Ant to Use TopLink Workbench Tasks
s Understanding TopLink Workbench Ant Task API
s Creating TopLink Workbench Ant Tasks

For more information about Ant, see http://ant .apache.org/manual/.

Configuring Ant to Use TopLink Workbench Tasks

Before you can use TopLink Workbench tasks in your Ant build files, you must
consider their library dependencies (see "Library Dependencies” on page 4-53).

To declare TopLink Workbench tasks in your Ant build.xml file, declare them
directly (see "Declaring TopLink Workbench Tasks" on page 4-54).

Library Dependencies

In addition to the Ant library dependencies (see
http://ant.apache.org/manual/install .html#librarydependencies),
Table 44 lists the TopLink-specific JAR files that must be in your Ant classpath.

Table 4-4 TopLink Workbench Ant Task Library Dependencies
JAR Name Needed For ... Available At ...

toplinkmw.jar | TopLink Workbench Ant task and type definitions. <TOPLINK HOME>/jlib
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Declaring TopLink Workbench Tasks

After you declare the TopLink Workbench task definitions (see Table 4-6) and data
definitions (see Table 4—4) in the toplink-ant-1ib.xml file as Example 4-5 shows,
you can use a TopLink Workbench task in a build.xml file, as Example 46 shows:

Example 4-5 Declaring TopLink Workbench Ant Task and Data Types in a
toplink-ant-lib.xml File

<?xml version="1.0"?>
<antlib>
<taskdef name="mappings.export"
classname="oracle.toplink.workbench.ant.taskdefs.ExportDeploymentXMLTask" />

<taskdef name="mappings.validate"
classname="oracle.toplink.workbench.ant.taskdefs.MappingsValidateTask" />

<taskdef name="session.validate"
classname="oracle.toplink.workbench.ant.taskdefs.SessionValidateTask" />

<typedef name="ignoreerror"
classname="oracle.toplink.workbench.ant.typedefs.IgnoreError" />

<typedef name="ignoreerrorset"
classname="oracle.toplink.workbench.ant.typedefs.IgnoreErrorSet" />

<typedef name="loginspec"

classname="oracle.toplink.workbench.ant.typedefs.LoginSpec" />
</antlib>

Example 4-6 Specifying the toplink-ant-lib.xml File in the build.xml File
<project name="MyBuild" default="validate.session" basedir="." xmlns:toplink="toplinklib">
<typedef file = "toplink-ant-lib.xml" classpathref = "mw.classpath" uri = "toplinklib" />
</project>
Understanding TopLink Workbench Ant Task API
Table 4-5 lists the TopLink Workbench Ant task definitions that TopLink provides.

Table 4-5 TopLink Workbench Ant Task Definitions

Task Name TopLink Class

mappings.validate oracle.toplink.workbench.ant.taskdefs.MappingsvValidateTask

session.validate oracle.toplink.workbench.ant.taskdefs.SessionvValidateTask

mappings.export oracle.toplink.workbench.ant.taskdefs.ExportDeploymentXMLTask

Table 4-6 lists the TopLink Workbench Ant type definitions that TopLink provides.

Table 4-6 TopLink Workbench Ant Type Definitions

Type Name TopLink Class

ignoreerror oracle.toplink.workbench.ant.typedefs.IgnoreError
ignoreerrorset oracle.toplink.workbench.ant.typedefs.IgnoreErrorSet
loginspec oracle.toplink.workbench.ant.typedefs.LoginSpec
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Creating TopLink Workbench Ant Tasks

Example 4-7 shows a typical Ant build.xml file that declares and uses the TopLink
Workbench Ant task and type definitions.

Example 4-7 Example Ant Build File with TopLink Workbench Ant Tasks

<project name="MyBuild" default="validate.session" basedir="." xmlns:toplink="toplinklib">
<!l-- ===================================================== -->
<!-- Properties -->
<l-- ===================================================== -->

<target name="init">
<property file="build.properties"/>

<property name = "toplink.mwp.dir" value = "${basedir}/mw"/>
<property name = "toplink.sessions.dir" value = "${basedir}/config"/>
<property name = " myProject.classes" value = "${basedir}/classes "/>

<path id = "database.classpath">
<pathelement path = "${toplink.home}/jlib /dms.jar"/>
<pathelement path = "${toplink.home}/jlib /OracleThinJDBC.jar"/>
</path>
<path id = "toplink.classpath">
<pathelement path = "${toplink.home
<pathelement path = "${toplink.home
<pathelement path = "${toplink.home
<pathelement path = "${toplink.home
</path>
<path id = "mw.classpath">
<pathelement path = "${toplink.home}/jlib /tlmwcore.jar"/>
<pathelement path = "${toplink.home}/jlib /toplinkmw.jar"/>
</path>
<path id = "mwplatforms.classpath"s
<pathelement path = "${toplink.home}/config"/>
</path>

/jlib /toplink.jar"/>
/31ib /ejb.jar"/>

/jlib /xmlparserv2.jar"/>
/jlib /antlr.jar"/>

e e

<typedef file = "toplink-ant-lib.xml"

classpathref = "mw.classpath"
uri = "toplinklib" />
</target>
<l-- =========z============================================ -->
<!-- Define task parameter -->
<l-- ===================================================== -->
<target name="parameter.definition" depends="init">
<toplink:ignoreerrorset id = "ignoreErrors"s
<toplink:ignoreerror code = "0233" />

</toplink:ignoreerrorset>

<toplink:loginspec id = "loginSpec"

url = "jdbc:cloudscape:stagedb;create=true"

driverclass = "COM.cloudscape.core.JDBCDriver"

user = "scott"

password="tiger" />
</target>
<l-- ==================================================== -->
<!-- Validate the MW Project -->
<l-- ===================================================== -->

<target name="validate.project" depends="parameter.definition"s>

<toplink:mappings.validate
projectfile = "${toplink.mwp.dir}/myProject.mwp"
reportfile = "${toplink.mwp.dir}/problem-report.html"
reportformat = "html"
property = "mw-valid"
classpathref = "mwplatforms.classpath" >
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<toplink:classpath refid = "mw.classpath" />
<toplink:classpath refid "toplink.classpath" />

<toplink:ignoreerrorset refid = "ignoreErrors"/>

</toplink:mappings.validate>

</target>
<!-- TopLink deployment descriptor XML generation -->
<l-- ===================================================== -->

<target name="export.deployment" depends="validate.project" if="mw-valid">

<toplink:mappings.export
projectfile = "${toplink.mwp.dir}/myProject.mwp"
deploymentfile = "${toplink.sessions.dir}/sessions.xml"
property = "export-completed"
failonerror = "true"
classpathref = "toplink.classpath"s

<toplink:classpath refid = "mw.classpath" />
<toplink:classpath refid = "mwplatforms.classpath" />

<toplink:ignoreerrorset refid = "ignoreErrors"/>
<toplink:loginspec refid = "loginSpec" />
</toplink:mappings.export>

</target>

<l-- ===================================================== -->
<!-- TopLink Session Validate -->
<l-- =============================-s=====s=s===s==sss=====s==== -->

<target name="validate.session" depends="export.deployment" if="export-completed">

<toplink:session.validate

sessionsfile = "${toplink.sessions.dir}/sessions.xml"
sessionname = "ThreeTierEmployee"

property = "session-valid"

classpathref = "toplink.classpath"

classpath = "${ myProject.classes}" >

<toplink:classpath refid = "mw.classpath" />
<toplink:classpath refid = " database.classpath" />

<toplink:loginspec refid = "loginSpec" />
</toplink:session.validate>
</target>
<project>

mappings.validate

The mapings.validate task is a testing task that you use to list of all the problems
in a TopLink Workbench project (. mwp) file.

This task provides the ability to:
= log all the problems to a file in text or HTML format

= setan Ant property to indicate that the TopLink Workbench project is valid (has no
errors)
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Parameters

Table 4-7 mappings.validate Task Parameters

Attribute Description Required
projectfile Fully qualified TopLink Workbench projects file name (mwp). Yes

reportfile Fully qualified file name to which to write the output. No

reportformat The format of the generated output. Must be html or text. No-default to text.
classpath Project classpath. No

classpathref Reference to a path defined elsewhere. No

property The name of the property to set (true if there is no problem). No

Parameters Specified as Nested Elements
You can specify the following parameters as nested elements of this task:

= classpath
= "ignoreerror" on page 4-60

= ignoreerrorset" on page 4-61

Examples
Example 4-8 shows a typical mappings.validate task.

Example 4-8 A mappings.validate Task

<toplink:mappings.validate
projectfile = "${toplink.mwp.dir}/myProject.mwp"
reportfile = "${toplink.mwp.dir}/problem-report.html"
reportformat = "html"
property = "mw-valid"
classpath = "${mwplatforms.classpath}" >

<toplink:classpath refid = "mw.classpath" />
<toplink:classpath refid = "toplink.classpath" />

<toplink:ignoreerrorset refid = "ignoreErrors"/>
<toplink:ignoreerror code = "0555" />
</toplink:mappings.validate>

session.validate

The session.validate task is a testing task that you use to test your TopLink
deployment XML by running TopLink.

This task provides the ability to:
»  specify the test type using a nested element

= setan Ant property to indicate that the TopLink Workbench project is valid (has no
errors)
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Parameters

Table 4-8 session.validate Task Parameters

Attribute Description Required

sessionsfile Fully qualified sessions.xml file. No—default to sessions.xml
and to classpath.

sessionname Name of the session to test. Yes

classpath Project classpath. No

classpathref Reference to a path defined elsewhere. No

property The name of the property to set (true if valid). No

Parameters Specified as Nested Elements
You can specify the following parameters as nested elements of this task:

= classpath
= '"loginspec" on page 4-62

Examples
Example 4-9 shows a typical session.validate task.

Example 4-9 A session.validate Task

<toplink:session.validate

sessionsfile = "${toplink.sessions.dir}/sessions.xml"
sessionname = "ThreeTierEmployee"

property = "session-valid"

classpathref = "toplink.classpath"

classpath = "${ myProject.classes}" >

<toplink:classpath refid = "mw.classpath" />
<toplink:classpath refid = " database.classpath" />

<toplink:loginspec refid = "loginSpec" />
</toplink:session.validate>

mappings.export
The mappings . export task is a generation task that you use to generate a TopLink
deployment XML file for a given TopLink Workbench project (. mwp). The
mappings.export task executes a mappings.validate (see "'mappings.validate"
on page 4-56) before executing. A BuildException is thrown if validation fails.

This task provides the ability to override the TopLink Workbench project database
login information.

Parameters

Table 4-9 mappings.export Task Parameters

Attribute Description Required

projectfile Fully qualified TopLink Workbench projects file ~ Yes
name (. mwp).
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Table 4-9 (Cont.) mappings.export Task Parameters

Attribute Description Required
deploymentfile Fully qualified TopLink project deployment file  No-default to the name
name (.xml). specified in the TopLink
Workbench project (. mwp).
ejbjarxmldir The directory that contains the ejb-jar.xml No-default to the directory
file (only applicable to J2EE project). specified in the TopLink
Workbench project (. mwp).
classpath Project classpath. No
classpathref Reference to a path defined elsewhere. No
failonerror Indicates whether the build will continue even if No

there are export errors; defaults to true.

property The name of the property to set (true if export  No
completed successfully).

Parameters Specified as Nested Elements
You can specify the following parameters as nested elements of this task:

= classpath
= 'loginspec" on page 4-62
= ‘ignoreerror" on page 4-60

= ‘ignoreerrorset” on page 4-61

Examples
Example 4-9 shows a typical mappings.export task.

Example 4-10 A mappings.export Task

<toplink:mappings.export
projectfile = "${toplink.mwp.dir}/myProject.mwp"
deploymentfile = "${toplink.sessions.dir}/sessions.xml"
property = "export-completed"
failonerror = "true"
classpathref = "toplink.classpath"s

<toplink:classpath refid = "mw.classpath" />
<toplink:classpath refid = "mwplatforms.classpath" />

<toplink:ignoreerrorset refid = "ignoreErrors"/>
<toplink:ignoreerror code = "0545" />
<toplink:loginspec
url = "jdbc:cloudscape:stagedb;create=true"
driverclass = "COM.cloudscape.core.JDBCDriver"
user = "scott"

password="tiger" />
</toplink:mappings.export>

classpath

Use the classpath element to define the Java classpath necessary to run a task. For
more information, see http://ant .apache.org/manual /using.html#path.
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ignoreerror

Parameters

Table 4-10 classpath Element Parameters

Attribute Description Required

location Specifies a single file or directory relative to the No
project's base directory (or an absolute filename).

path Specifies one or multiple files or directories separated ~ No
by a colon or semicolon.

refid Reference to a path defined elsewhere. No

Parameters Specified as Nested Elements
You can specify the following parameters as nested elements of this task:

= pathelement

n fileset
m dirset
n filelist
Examples

Example 4-11 shows a typical classpath element.

Example 4-11 A classpath Element

<classpath>
<pathelement path="${classpath}"/>
<fileset dir="1ib">
<include name="**/*. jar"/>
</fileset>
<pathelement location="classes"/>
<dirset dir="${build.dir}">
<include name="apps/**/classes"/>
<exclude name="apps/**/*Test*"/>
</dirset>
<filelist refid="third-party jars"/>
</classpath>

Use the ignoreerror element to instruct a TopLink Ant task to ignore a specific
TopLink Foundation Library (see "TopLink Exception Reference" on page 13-1) or
TopLink Workbench (see "TopLink Workbench Error Reference" on page 14-1) run-time
error code.

To instruct a TopLink Ant task to ignore multiple error codes, consider using an
ignoreerrorset element (see "ignoreerrorset” on page 4-61).

Parameters

Table 4-11 ignoreerror Element Parameters

Attribute Description Required

code Error code of the problem to ignore. Yes

Parameters Specified as Nested Elements
You cannot specify parameters as nested elements of this element.
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Examples

Example 4-12 shows a typical ignoreerror element. This element instructs a
mappings.export task to ignore TopLink Workbench error code 0545.

Example 4-12 An ignoreerror Element

<toplink:mappings.export
projectfile = "${toplink.mwp.dir}/myProject.mwp"
deploymentfile = "${toplink.sessions.dir}/sessions.xml"
classpathref = "toplink.classpath">

<toplink:classpath refid = "mw.classpath" />
<toplink:classpath refid = "mwplatforms.classpath" />

<toplink:ignoreerror code = "0545" />

</toplink:mappings.export>

ignoreerrorset

Use the ignoreerrorset element to instruct a TopLink Ant task to ignore any of
multiple TopLink Foundation Library (see "TopLink Exception Reference" on

page 13-1) or TopLink Workbench (see "TopLink Workbench Error Reference" on
page 14-1) run-time error codes.

Parameters

Table 4-12 ignoreerrorset Element Parameters

Attribute Description Required

id Unique identifier for this type instance, can be used to No
reference this type in scripts.

refid Reference to a ignoreerrorset defined elsewhere. No

Parameters Specified as Nested Elements
You can specify the following parameters as nested elements of this element:

= ignoreerror" on page 4-60

Examples

Example 4-13 shows a typical ignoreerrorset element. This element instructs a
mappings.export task to ignore all of TopLink Workbench error codes 0402 and
0570. Note that the mappings . export task also uses an explicitly ignoreerror
element: this means that the mappings . export task will ignore all of error codes
0402, 0570, and 0545.

Example 4-13 An ignoreerrorset Element

<toplink:ignoreerrorset id = "ignoreErrors"s
<toplink:ignoreerror code = "0402" />
<toplink:ignoreerror code = "0570" />

</toplink:ignoreerrorset>

<toplink:mappings.export
projectfile = "${toplink.mwp.dir}/myProject.mwp"
deploymentfile = "${toplink.sessions.dir}/sessions.xml"
classpathref = "toplink.classpath">
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<toplink:classpath refid = "mw.classpath" />
<toplink:classpath refid = "mwplatforms.classpath" />
<toplink:ignoreerrorset refid = "ignoreErrors"/>
<toplink:ignoreerror code = "0545" />

</toplink:mappings.export>

loginspec

Use the 1oginspec element to instruct a TopLink Ant task

database login information in a TopLink Workbench project.

Chapter 81, "Understanding Data Access".

to override the project
For more information, see

Note:
"Relational Projects" on page 17-6).

You cannot use this element with a J2EE project.

You can only use this element with a relational project (see

Parameters

Table 4-13 loginspec Element Parameters

Attribute Description Required

id Unique identifier for this type instance, can be used No
to reference this type in scripts.

refid Reference to a loginspec defined elsewhere. No

driverclass Fully qualified class of the data source driver (see No-default to the class that the
"Configuring Database Login Connection Options"  TopLink Workbench project
on page 83-2). specifies.

url URL of the driver see "Configuring Database Login ~ Yes
Connection Options" on page 83-2).

user Login user name (see "Configuring User Name and ~ No-default to the value that the
Password" on page 82-1). TopLink Workbench project

specifies
password Login password (see "Configuring User Name and =~ No—default to the value that the

Password" on page 82-1).

TopLink Workbench project
specifies

Parameters Specified as Nested Elements

You cannot specify parameters as nested elements of this element.

Examples
Example 4-14 shows a typical loginspec element.

Example 4-14 A loginspec Element

<toplink:mappings.export
projectfile = "${toplink.mwp.dir}/myProject.mwp"

deploymentfile = "${toplink.sessions.dir}/sessions.xml"

classpathref = "toplink.classpath">

<toplink:classpath refid
<toplink:classpath refid

"mw.classpath" />
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<toplink:loginspec

url = "jdbc:cloudscape:stagedb;create=true"
driverclass = "COM.cloudscape.core.JDBCDriver"
user = "scott"

password="tiger" />
</toplink:mappings.export>

Using TopLink Workbench 4-63



Integrating TopLink Workbench With Apache Ant

4-64 Oracle TopLink Developer's Guide



O

Using the Schema Manager

The SchemaManager and its related classes provide API that you can use from a Java
application to specify database tables in a generic format, and then create and modify
them in a specific relational database. This decouples your TopLink project from a
particular database schema while giving you a programmatic means of creating a
database schema based on your TopLink project. For example, you can use the schema
manager to recreate a production database in a nonproduction environment. This lets
you build models of your existing databases, and modify and test them during
development.

Note: You can also create database tables manually during
development using TopLink Workbench (see "Creating New Tables"
on page 4-22 and "Generating Tables on the Database" on page 4-32).

This chapter includes information on the following topics:
s Understanding the Schema Manager

»  Creating a Table Creator

»  Creating Tables With a Table Creator

s Automatic Database Table Creation

Understanding the Schema Manager

Figure 5-1 summarizes the important SchemaManager classes and the primary
means of using them.
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Figure 5-1 SchemalManager Usage
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Although you can use the SchemaManager API directly, Oracle recommends that you
create a TableCreator class and use its API (which, in turn, uses the
SchemaManager).

You can automatically generate a TableCreator using:

»  TopLink Workbench during development (see "Using TopLink Workbench During
Development" on page 5-4)

s DefaultTableGenerator atrun time (see "Using the Default Table Generator at
Run Time" on page 5-4)

The TableCreator class owns one or more TableDefinition classes (one for each
database table) and the TableDef inition class owns one or more
FieldDefinition classes (one for each field).

The TableDefinition class lets you specify a database table schema in a generic
format. At run time, TopLink uses the session associated with your TopLink project to
determine the specific database type, and uses the generic schema to create the
appropriate tables and fields for that database.

After creating a TableCreator class, you can use its API to create and drop tables
(see "Creating Tables With a Table Creator" on page 5-6). You can also configure
TopLink to do this automatically (see "Automatic Database Table Creation" on
page 5-6).

Because the schema manager uses Java types rather than database types, it is
database-independent. However, because it does not account for database-specific
optimizations, it is best-suited for development purposes rather than production. For
more information on how the schema manager maps Java types to database types, see
"Schema Manager Java and Database Type Conversion" on page 5-3.

Although the schema manager can handle the sequencing configuration that you
specify in your TopLink project, if you are using sequencing with non-Oracle
databases, there are some sequencing restrictions you should be aware of (see
"Sequencing" on page 5-3).
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Schema Manager Java and Database Type Conversion

Table 5-1 lists the Java type to database type conversions that the schema manager
supports depending on the database platform your TopLink project uses. This list is
specific to the schema manager and does not apply to mappings. TopLink
automatically performs conversions between any database types within mappings.

Table 5-1 Java and Database Field Type Conversion
Java Type Oracle DB2 Sybase MySQL MS Access
java.lang.Boolean NUMBER SMALLINT BIT default 0 TINYINT(1) SHORT
java.lang.Byte NUMBER SMALLINT SMALLINT TINYINT SHORT
java.lang.Byte[] LONG RAW BLOB IMAGE BLOB LONGBINARY
java.lang.Character CHAR CHAR CHAR CHAR TEXT
java.lang.Character[] | LONG CLOB TEXT TEXT LONGTEXT
java.lang.Double NUMBER FLOAT FLOAT(32) DOUBLE DOUBLE
java.lang.Float NUMBER FLOAT FLOAT(16) FLOAT DOUBLE
java.lang.Integer NUMBER INTEGER INTEGER INTEGER LONG
java.lang.Long NUMBER INTEGER NUMERIC BIGINT DOUBLE
java.lang.Short NUMBER SMALLINT SMALLINT SMALLINT SHORT
java.lang.String VARCHAR?2 VARCHAR VARCHAR VARCHAR TEXT
java.math.BigDecimal NUMBER DECIMAL NUMERIC DECIMAL DOUBLE
java.math.BigInteger NUMBER DECIMAL NUMERIC BIGINT DOUBLE
java.sql.Date DATE DATE DATETIME DATE DATETIME
java.sql.Time DATE TIME DATETIME TIME DATETIME
java.sqgl.Timestamp DATE TIMESTAMP DATETIME DATETIME DATETIME

Sequencing

For more information about database platforms that TopLink supports, see "Database
Platforms" on page 81-3.

If you generate a TableCreator class using TopLink Workbench (see "Using TopLink
Workbench During Development" on page 5-4) or DefaultTableGenerator (see
"Using the Default Table Generator at Run Time" on page 5-4), then sequencing
configuration is included in your TableCreator according to your TopLink project
configuration. In this case, when you use TableCreator method createTables, it
does the following;:

»  Creates the sequence table as defined in the session DatabaseLogin

= Creates or inserts sequences for each sequence name for all registered descriptors
in the session

»  Creates the Oracle sequence object if you use Oracle native sequencing

You can use advanced API to handle special cases like Sybase or Microsoft SQL Server
native sequencing (see "Using Java" on page 5-4).

For more information about sequencing, see "Understanding Sequencing in Relational
Projects" on page 17-14.
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Creating a Table Creator

You can automatically generate a TableCreator using:

s TopLink Workbench during development (see "Using TopLink Workbench During
Development" on page 5-4)

s DefaultTableGenerator atrun time (see "Using the Default Table Generator at
Run Time" on page 5-4)

After creating a TableCreator class, you can use its API to create and drop tables
(see "Creating Tables With a Table Creator" on page 5-6).

Using TopLink Workbench During Development

To create a TableCreator class that you can use in a Java application to recreate a
database schema using the SchemaManager, use this procedure:

1. Right-click the project in the Navigator and choose Export > Table Creator Java
Source from the context menu. The Table Creator dialog box appears.

You can also select the table and choose Selected > Export > Table Creator Java
Source from the menu.

2. Enter a name for the table creator class and click OK. The Save As dialog box
appears.

3. Choose a location for your table creator class and click OK. TopLink Workbench
exports the table creator Java class to the location you specify.

Using the Default Table Generator at Run Time

To create a TableCreator class in Java using the DefaultTableGenerator, use
this procedure:

1. Create an instance of DefaultTableGenerator, passing in an instance of your
TopLink project:

DefaultTableGenerator myDefTblGen = new DefaultTableGenerator (toplinkProject) ;
2. Create a TableCreator instance:

s If you want a TableCreator that can support any session, use:

TableCreator myTblCre = myDefTblGen.generateDefaultTableCreator();

» If you want a TableCreator customized for a specific TopLink session, use:

TableCreator myTblCre =
myDefTblGen.generateFilteredDefaultTableCreator (toplinkSession) ;

You can also configure TopLink to use the DefaultTableGenerator to
automatically generate and execute a TableCreator at run time (see "Automatic
Database Table Creation" on page 5-6).

Using Java

This section describes how to create a TableCreator class in Java, including the
following:

s Creating a TableCreator Class

s Creating a TableDefinition Class
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= Adding Fields to a TableDefinition
s Defining Sybase and Microsoft SQL Server Native Sequencing

Creating a TableCreator Class

To create your own TableCreator instance, you should extend TableCreator as
Example 5-1 shows:

Example 5-1 Creating a TableCreator Class

public class MyTableCreator extends oracle.toplink.tools.schemaframework.TableCreator {

public M7TableCreator() {
setName ("MyTableCreator") ;
addTableDefinition (buildADDRESSTable () ) ;

public TableDefinition buildADDRESSTable () {
TableDefinition table = new TableDefinition();

return table;

}

Creating a TableDefinition Class

The TableDefinition class includes all the information required to create a new
table, including the names and properties of a table and all its fields.

The TableDefinition class has the following methods:
m setName

m addField

s addPrimaryKeyField

s addIdentityField

s addForeignKeyConstraint

All table definitions must call the setName method to set the name of the table that is
described by the TableDefinition.

Adding Fields to a TableDefinition

Use the addField method to add fields to the TableDefinition. To add the
primary key field to the table, use the addPrimaryKeyField method rather than the
addField method.

To maintain compatibility among different databases, the type parameter requires a
Java class rather than a database field type. TopLink translates the Java class to the
appropriate database field type at run time. For example, the St ring class translates
to the CHAR type for dBase databases. However, if you are connecting to Sybase, the
String class translates to VARCHAR. For more information, see "Schema Manager Java
and Database Type Conversion" on page 5-3.

The addField method can also be called with the fieldSize or fieldSubSize
parameters for column types that require size and subsize to be specified.

Some databases require a subsize, but others do not. TopLink automatically provides
the required information, as necessary.

Using the Schema Manager 5-5



Creating Tables With a Table Creator

Defining Sybase and Microsoft SQL Server Native Sequencing

Use FieldDefinition method addIdentityField to add fields representing a
generated sequence number from Sybase or Microsoft SQL Server native sequencing.
See "Native Sequencing With a Non-Oracle Database Platform" on page 17-19 for
detailed information on using sequencing.

Creating Tables With a Table Creator

After creating a TableCreator class (see "Creating a Table Creator" on page 5-4), you
can use its API to create and drop tables. The important TableCreator methods are
as follows (each method takes an instance of DatabaseSession):

m createTables-this method creates tables, adds constraints, and creates
sequence tables and sequences (if sequence tables already exist, this method drops
them and recreates them).

» dropTables-his method drops all constraints and drops all tables (except
sequence tables) that the TableCreator defines.

= createConstraints-this method creates constraints on all pre-existing tables
that the TableCreator defines.

s dropConstraints-this method drops constraints on all pre-existing tables that
the TableCreator defines.

» replaceTables-this method drops and then creates all tables that the
TableCreator defines.

Automatic Database Table Creation

If you deploy a CMP project to OC4J configured to use TopLink as the persistence
manager, then you can configure OC4]J to automatically create (and, optionally, delete)
database tables for your persistent objects.

You can configure automatic database table creation at one of three levels as Table 5-2
shows. You can override the system level configuration at the application level and
you can override system and application configuration at the EJB module level.

Table 5-2 Configuring Automatic Table Generation

Level Configuration File Setting Values
System (global) <0C4J_HOME>/config/ autocreate-tables Truel or False
application.xml
autodelete-tables True or False!l
Application (EAR) orion-application.xml autocreate-tables True! or False
autodelete-tables True or False!
EJB Module (JAR) orion-ejb-jar.xml pm-properties sub-element Create,
default-mapping attribute DropAndCreate,
dlb—table—gen2 or UseE)xisting3

! Default.
2 For more information, see "Configuring default-mapping Properties" on page 8-12.
3 See Table 5-3.
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If you configure automatic table generation at the EJB module level, the value you
assign to the db-table-gen attribute corresponds to the autocreate-tables and
autodelete-tables settings as Table 5-3 shows.

Table 5-3 Equivalent Settings for db-table-gen

db-table-gen Setting autocreate-tables Setting autodelete-tables Setting
Create True False

DropAndCreate True True

UseExisting False NA

You can use this feature in conjunction with default mapping (see "Default Mapping in
CMP Projects Using OC4]J at Run Time" on page 30-4).
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Using an Integrated
Development Environment

This chapter includes information on using TopLink with an integrated development
environment (IDE). This chapter includes the following sections:

s Configuring TopLink for Oracle JDeveloper
s Configuring TopLink Workbench With Source Control Management Software

In addition to the development environment described here, TopLink can be used
with any J2EE development environment and process.

Configuring TopLink for Oracle JDeveloper

This section contains information on how to configure TopLink for use with Oracle
JDeveloper. JDeveloper is a J2EE development environment with end-to-end support
to develop, debug, and deploy e-business applications and Web services.

Using TopLink Mappings

Starting with Oracle JDeveloper 10g, the standard JDeveloper installation includes an
embedded TopLink editor. Refer to the JDeveloper documentation for complete
information.

To use TopLink with JDeveloper 9.0.4 (and earlier), use the following procedure to
add the TopLink JAR files to your JDeveloper projects:

1. Select a JDeveloper project in the System Navigator window.
2. Choose Project > Project Settings. The Project Settings window appears.

3. Choose Configurations > Development > Libraries. A list of predefined and
user-defined libraries appears.

Using an Integrated Development Environment  6-1



Configuring TopLink for Oracle JDeveloper

Figure 6—1 List of Available Libraries
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4. Click New to create a new library that will contain the TopLink . jar files. The
New Library dialog box appears.

5. Enter a name for the new library—for example, TopLink. Ensure that the default
choice for Location remains as User Libraries.

Figure 6-2 Creating a New Library Dialog Box
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6. To edit the Class Path and add the TopLink . jar files, click Edit.

Add the following to the beginning of your Class Path:

<ORACLE_HOME>\toplink\jlib\toplink.jar
<ORACLE HOME>\toplink\jlib\antlr.jar
<ORACLE HOME>\lib\xmlparserv2.jar
<ORACLE HOME>\1lib\xml.jar

7. Click OK. On the Project Settings window click OK.
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Using an Existing User-Defined TopLink Library

After a user library is created, it can be referenced again by any other project. Revisit
the Libraries window of the Project Settings, and add the TopLink Library to any
project with which you want to use TopLink.

Using TopLink Sessions

When using TopLink 10g (10.1.3.1.0) with Oracle JDeveloper, you should be aware that
you cannot configure all sessions.xml options with the JDeveloper mapping editor.

To configure supported options (prior to 10g (10.1.3.1.0)), use the JDeveloper mapping
editor. For details, refer to the JDeveloper online help at:

http://www.oracle.com/technology/documentation/9i jdev.html

To configure the new TopLink 10g (10.1.3.1.0) options, including, cache coordination
options (see Chapter 88, "Configuring a Coordinated Cache"), historical sessions (see
Chapter 78, "Configuring Historical Sessions"), and connection policy for server
sessions (see "Configuring Connection Policy" on page 74-19) use one of the following
methods:

s UseaSessionEventListener.prelLogin (SessionEvent) method

= When accessing the session from the session manager, request it with the
loggedIn option set to false. The returned session can then be customized and
you can invoke login.

Configuring TopLink Workbench With
Source Control Management Software

You can use TopLink Workbench with a source control management (SCM) system to
facilitate enterprise-level team development (see "Using a Source Control Management
System" on page 6-3). If you have a small development team, you can manage the
changes from within XML files (see "Sharing Project Objects" on page 6-6).

When using a TopLink Workbench project in a team environment, you must
synchronize your changes with other developers. See "Merging Files" on page 6-4 for
more information.

Using a Source Control Management System

If you use an enterprise, file-based source control management system to manage your
Java source files, you can use the same system with your TopLink Workbench project
files. These project files are maintained by TopLink Workbench and written out in
XML file format.

The check in and check out mechanism for the source control system defines how to
manage the source (the XML source and TopLink Workbench project file) in a
multiuser environment.

Checking Out and Checking In TopLink Workbench Project Files

Although your actual development process will vary depending on your SCM tool, a
typical process involves the following steps:

1. Determine (based on your SCM system) which files to retrieve from the source
management system.

2. Edit the project using TopLink Workbench.
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Merging Files

3. Save the edited project. If TopLink Workbench displays the Read-Only Files dialog
box, make a note of these files, they must be unlocked and possibly merged. See
"Working With Locked Files" on page 6-6 for more information.

4. Merge the required project files. See "Merging Files" on page 6-4 for details.

5. Check in the modified files, then retrieve from the repository any files that have

been added or modified for this TopLink Workbench project.

The most difficult aspect of application development is merging changes from two (or
more) development team members that have simultaneously edited the same file. If
one developer checks in his or her changes, a merge condition exists. Use a file
comparison tool to determine the merged aspects of the project. The files to edit will
vary, depending on the type of merge:

Merging Project Files
Merging Table, Descriptor, and Class Files

Example 6-1 and Example 6-2 demonstrate a merge out merging technique.

Merging Project Files
Project files contain references to the objects in the project. Generally, your project
<projectName>.mwp contains the following elements:

Database information: <database>
»  Database tables: <tables>
Descriptors: <descriptorss>
Repository: <repositorys>

s Classes: <classpath-entriess

Changes in these parts of the . mwp file are usually caused by adding, deleting, or
renaming project elements.

To merge project files, you will generally need to merge a project file if another
developer has added or removed a descriptor, table, or class, and checked in the
project while you were adding or removing descriptors, tables, or classes from the
same project. To merge the project’s . mwp file, use this procedure:

1.

Perform a file comparison between the <projectName>mwp file in the repository
and your local copy. The file comparison shows the addition or removal of a
project element inside the owner (that is, <database>, <descriptorss, or
<repositorys).

2. Insert the XML script to, or delete from your local <projectName>.mwp file
(inside the corresponding owner element). This brings your local code up-to-date to
the current code in the code repository.

3. Retrieve any updated files, as indicated by your source control system.

Your local source now matches the repository.

Example 6—1 Merging Projects

Another developer has added and checked in a new Employee class descriptor to the

com. demo package while you were working with the same TopLink Workbench
project. To merge your work with the newly changed project, follow these steps:
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1. Perform a file comparison on the <projectName>.mwp file to determine the
differences between your local file and the file in the repository. Your SCM system
may show the file in merge status.

The file comparison shows the addition of the <package-descriptors> tag and
a <name> element inside that tag:

<package-descriptor>
<name>com. demo.Employee.ClassDescriptor</name>
</package-descriptor>

2. Insert this XML into your <projectName>.mwp file (inside the <descriptors>
element) to bring it up-to-date with the current files in the source repository.

3. Retrieve any new or updated files from your source control system. This includes
the newly added Employee class descriptor.

4. Check in files that you have modified.

Merging Table, Descriptor, and Class Files

Developers who concurrently modify the same existing table, descriptor, or class file
will create a merge condition for the following files:

s Table: <tableName>.xml (one for each table)
s Descriptor: <descriptorName. type>.xml (one for each descriptor)
n Class: <className>.xml (one for each class)

TopLink Workbench changes these files when saving a project if you have changed
any of the contents within them (such as adding a mapping to a descriptor, adding an
attribute to a class, or a changing a field reference in a table).

If another developer has changed an attribute in a table, descriptor, or class, while you
were changing a different mapping on that same descriptor, you will need to merge
your project. To merge your project, use this procedure:

1. Perform a file comparison on the specific . xm1 files in merge status (that is, table,
descriptor, or class). The file comparison shows the addition or removal of an
XML element.

2. Insert the XML script to, or remove from your local . xm1 file to bring it up-to-date
with the current files in the source repository.

Example 6—2 Merging Files

Another developer has added and checked in the firstName mapping to the
Employee class descriptor while you were changing a different mapping on that same
descriptor. To merge your work with the newly changed project, use this procedure:

1. Perform a file comparison on the
com.demo.Employee.ClassDescriptor.xml file located in
<projectRoot>/Descriptor/ directory that is in merge status.

The file comparison shows the addition of the <mapping> tag and the elements
inside that tag:

<mapping>
<uses-method-accessing>false</uses-method-accessing>
<inherited>false</inherited>
<read-only>false</read-only>
<instance-variable-name>firstName</instance-variable-name>
<default-field-names>
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<default-field-name>direct field=</default-field-name>
</default-field-names>
<field-handle>
<field-handle>
<table>EMPLOYEE</table>
<field-name>F NAME</field-name>
</field-handle>
</field-handle>
<mapping-class>MWDirectToFieldMapping </mapping-classs>
</mapping>

2. Insert this XML block into your local
com.demo.Employee.ClassDescriptor.xml file (inside the existing
<mapping> element) to bring it up to date to the current files in the source
repository.

3. Retrieve any new files noted as missing by your source control system. This
includes any tables or descriptors that may be referenced by the new mapping.

4. Check in files that you have modified.

Sharing Project Objects

You can also share project objects by copying the table or descriptor files into the
appropriate directories in the target project.

After copying the files, insert a reference to the table, descriptor, or class in the
appropriate place in the <projectName>.mwp file. All references contained within
the project file must refer to an existing object in the project.

Managing the ejb-jar.xml File
When working in a team environment, manage the ejb-jar.xml file similarly

to the . xml project files. TopLink Workbench edits and updates the ejb-jar.xml
file, if necessary, when working with an EJB project.

If you use a version control system, perform the same check in and check out
procedures. For merge conditions, use a file comparison tool to determine which
elements have been added or removed. Modify the file as necessary and check in the
file to exercise version control on your work.

Working With Locked Files

When working in a team environment, your source control system may lock files when
you retrieve them from the repository. If TopLink Workbench attempts to save a locked
file, the Version Control Assistance dialog box appears, showing the locked files.
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Figure 6-3 Version Control Assistance Dialog Box
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Select one of the following methods to save your project:
= Use your source control system to unlock the files, and then click Save.
s Click Save As to save the project to a new location.

See "Saving Projects” on page 18-11 for more information.
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Part Il

Deploying a TopLink Application

This part describes how to package and deploy a TopLink application to an
application server. It contains the following chapters.

Chapter 7, "Integrating TopLink With an Application Server"

This chapter contains information on software requirements for integrating
TopLink with your specific application server.

Chapter 8, "Creating TopLink Files for Deployment"

This chapter describes how to create the necessary TopLink files for deployment to
your application server.

Chapter 9, "Packaging a TopLink Application"
This chapter explains how to package the deployment files.
Chapter 10, "Deploying a TopLink Application"

This chapter provides procedures for deploying different types of TopLink
applications in a variety of environments.
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Integrating TopLink With an Application
Server

This chapter describes how to configure Oracle TopLink for use with J2EE containers
and application servers. It includes sections on the following:

m  Application Server Support

»  Application Server Integration Concepts

For more information, see the following:

s "Creating TopLink Files for Deployment" on page 8-1
» "Packaging a TopLink Application" on page 9-1

s "Deploying a TopLink Application" on page 10-1

Application Server Support
TopLink can be used with any J2EE application server.

Table 7-1 lists the application servers for which TopLink provides special EJB and
CMP integration.

Table 7-1 TopLink Integration Support by Application Server Type

TopLink Integration for TopLink Integration for
Application Server Type Application Server Version EJB Version
"Oracle Containers for J2EE (OC4])" =« 10.1.3 s 21,300
on page 7-5 = 1012 . 2n

= 904 s 2n

[ ] 9.0.3 [ 2.n
"BEA WebLogic Server" on = 90 s 2n
page 7-14 = 81 . 27

= 7.0 (Service Pack 2) = 21

s 6.1 (Service Pack 4) = 2n
"IBM WebSphere Application s 60 s 2mn
Server" on page 7-21 . 51 . on

[ ] 5.0 [ ] 2.n

] 4.0 ] 2n
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! When using OC4J and Java 1.5, TopLink supports a subset of the persistent features anticipated in the final

EJB 3.0 specification. EJB 3.0 feature support is subject to change and dependent upon the contents of the
final specification. For more information on EJB 3.0 support, see Oracle Containers for ]2EE Enterprise
JavaBeans Developer’s Guide.

Application Server Integration Concepts

This section describes concepts unique to TopLink application server integration,
including the following:

Software Requirements

XML Parser Platform Configuration
Security Permissions

Persistence Manager Migration

Clustering

Software Requirements

To run a TopLink application within a J2EE container, your system must meet the
following software requirements:

An application server or J2EE container (see Table 7-1)
XML parser (see "XML Parser Platform Configuration" on page 7-2)

A JDBC driver configured to connect with your local database system (for more
information, see your database administrator)

A Java development environment, such as:
- Oracle JDeveloper
- IBM WebSphere Studio Application Developer (WSAD)

- SunJava Development Kit (JDK) 1.3.1 or later. Oracle recommends using 1.4.2
(or later).

Any other Java environment that is compatible with the Sun JDK 1.3.1 or later

A command-line JVM executable (such as java.exe or jre.exe)

XML Parser Platform Configuration

The TopLink run-time environment uses an XML parser to do the following;:

Read and write XML configuration files (see "project.xml File" on page 8-2 and
"sessions.xml File" on page 8-4)

Read and write TopLink Workbench project files (see "Understanding TopLink
Workbench" on page 4-1)

Perform object-to-XML transformations in EIS projects using XML records (see
Chapter 53, "Understanding EIS Mappings"

Perform object-to-XML transformations in XML projects (see Chapter 62,
"Understanding XML Mappings"

Application servers use an XML parser to read deployment files such as
ejb-jar.xml and <J2EE container>-ejb-jar.xml (see "Creating TopLink
Files for Deployment" on page 8-1).
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To avoid XML parser conflicts, you must configure your TopLink application to use
the same XML parser as that used by the application server on which you deploy your
application.

Internally, TopLink accesses its XML parser using an instance of
oracle.toplink.platform.xml.XMLPlatform class.

You can configure TopLink to use any XML parser for which an XMLPlat form class
exists (see "Configuring XML Parser Platform" on page 7-3).

You can also create your own XMLPlatform to provide access to an XML parser not
currently supported by TopLink (see "Creating an XML Parser Platform" on page 7-3).

Configuring XML Parser Platform
TopLink provides the XMLPlat form instances shown in Table 7-2.

Table 7-2 Supported XML Platforms

XMLPIlatform... Provides Access too... Use With...
oracle.toplink.platform.xml.xdk.XDKPlatform' XDKParser: this class provides access to Oracle Containers
the Oracle XML Developer’s Kit (XDK) for J2EE (OC4J)

XML parser (see
http://www.oracle.com/technology
/tech/xml/xdkhome .html).

oracle.toplink.platform.xml.jaxp.JAXPPlatform JAXPParser: this class provides accessto =~ BEA WebLogic

the Java SDK XML parser in the Server
javax.xml.parsers package (see
http://java.sun.com/j2ee/1.4/doc IBM WebSphere

Applicati
s/tutorial/doc/JAXPIntro2.html). pplication Server

1 Default:

Note: To use an XML parser not listed in Table 7-2, create your own
XMLPlatform (see "Creating an XML Parser Platform" on page 7-3).

To configure your TopLink application to use a particular instance of the
XMLPlatform class, set system property toplink.xml.platform to the fully
qualified name of your XMLPlatform class as Example 7-1 shows.

Example 7-1 Configuring XML Platform
toplink.xml.platform=oracle.toplink.platform.xml.jaxp.JAXPPlatform

Creating an XML Parser Platform

Using the oracle. toplink.platform.xml classes included in the public source
files shipped with TopLink (see "Using Public Source" on page 12-2), you can create
your own instance of the oracle.toplink.platform.xml.XMLPlatform class to
specify an XML parser not listed in Table 7-2.

After creating your XMLPlat form, configure TopLink to use it (see "Configuring XML
Parser Platform" on page 7-3).

XML Parser Limitations

Crimson (http://xml.apache.org/crimson/) is the XML parser supplied in the
Java 2 Platform, Standard Edition (J2SE) and in some JAXP reference implementations.
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If you use Crimson with the JAXP API to parse XML files whose system identifier is
not a fully qualified URL, then XML parsing will fail with a not valid URL exception.

Other XML parsers defer validation of the system identifier URL until it is specifically
referenced.

If you are experiencing this problem, consider one of the following alternatives:
= Ensure that your XML files use a fully qualified system identifier URL.
= Use another XML parser (such as the OracleAS XML Parser for Java v2).

Security Permissions

By default, when you run a TopLink-enabled application in a JVM configured with a
nondefault java.lang.SecurityManager, the TopLink run-time environment
executes certain internal functions by executing a PrivilegedAction with
java.security.AccessController method doPrivileged. This ensures that
you do not need to grant many permissions to TopLink for it to perform its most
common operations. You need only grant certain permissions depending on the types
of optional TopLink features you use.

For more information, see "Understanding Security Permissions" on page 7-22.

If you run a TopLink-enabled application in a JVM without a nondefault
SecurityManager, you do not need to set any permissions.

Persistence Manager Migration

Clustering

From the perspective of an application server, TopLink is a persistence manager. You
can configure an application server to use TopLink as the default persistence manager.

You can only use one persistence manager for all the entity beans with
container-managed persistence in a JAR file.

TopLink provides automated support for migrating an existing J2EE application to use
TopLink as the persistence manager. For more information, see the following:

s "Migrating OC4] Orion Persistence to OC4J TopLink Persistence" on page 7-5
= "Migrating BEA WebLogic Persistence to OC4J TopLink Persistence" on page 7-16

Most application servers include a clustering service that you can use with your
TopLink application. To use TopLink with an application server cluster, use this
procedure:

1. Install the toplink. jar file (and include it in the classpath) on each application
server in the cluster to which you deploy TopLink applications.

2. Configure TopLink cache consistency options appropriate for your application.
For more information, see Chapter 87, "Understanding the Cache".

If you are deploying a CMP application, see also "Configuring
cache-synchronization Properties" on page 8-11.

3. Configure clustering on each application server.

For more information, see your application server documentation.
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To integrate a TopLink application with OC4J, you must consider the following;:
s CMP Integration

= Migrating OC4] Orion Persistence to OC4] TopLink Persistence

s JTA Integration

In addition to configuring these OC4] specific options, you must also consider the
general application server integration issues in "Application Server Integration
Concepts" on page 7-2.

CMP Integration

To enable TopLink CMP integration in OC4], use the following procedure (this
procedure assumes you have already installed TopLink):

1. If necessary, migrate your CMP application using the TopLink migration tool (see
"Migrating OC4] Orion Persistence to OC4] TopLink Persistence" on page 7-5).

2. Evaluate your choice of UnitOfWork change policy (see "Unit of Work and
Change Policy" on page 97-6).

Note: If you are using EJB 3.0, you can let TopLink configure your
persistent classes with the most efficient change policy (see "Attribute
Change Tracking Policy" on page 97-8) at class-loading time using
byte code weaving.

3. Ensure that all necessary deployment descriptor files are in place (see "Creating
TopLink Files for Deployment” on page 8-1 and "Packaging a TopLink
Application” on page 9-1).

Note: If you are using EJB 3.0, you can use annotations to specify
most of what you formerly specified in deployment descriptors. Use
deployment descriptors to override annotations or specify options not
supported by annotations. For more information on what annotations
are currently supported, see Oracle Containers for J2EE Enterprise
JavaBeans Developer’s Guide.

4. Optionally, consider the EJB customization options that TopLink provides (see
"Configuring Miscellaneous EJB Options" on page 7-25).

Migrating OC4J Orion Persistence to OC4J TopLink Persistence

In 10g¢ (10.1.3.1.0), OC4J is shipped configured to use TopLink as its default persistence
manager.

If you upgrade your OC4J to this release, you must migrate persistence configuration
from your original orion-ejb-jar.xml file to the toplink-ejb-jar.xml file.

In this release, Oracle provides a TopLink migration tool that you can use to automate
this migration for Release 2 (9.0.4) or later OC4] installations.
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After using the TopLink migration tool, you may need to make some additional
changes as described in "Post-Migration Changes" on page 12.

If you encounter problems during migration, see "Troubleshooting Your Migration" on
page 7-13.

This section explains how to use the TopLink migration tool, including:
s Overview

= Using the TopLink Migration Tool From TopLink Workbench

s  Using the TopLink Migration Tool From the Command Line

= Post-Migration Changes

s Troubleshooting Your Migration

Overview

Before using the TopLink migration tool, review this section to understand how the
TopLink migration tool works and to determine what OC4] persistence manager
metadata is, and is not, migrated.

Input and Output
The TopLink migration tool takes the following files as input:

s ejb-jar.xml

m orion-ejb-jar.xml

It migrates as much OC4J-specific persistence configuration as possible to a new
toplink-ejb-jar.xml file and creates the following new files in a target directory
you specify:

m orion-ejb-jar.xml

m toplink-ejb-jar.xml

»  TopLink Workbench project file TLCmpProject . mwp

The ejb-jar.xml and orion-ejb-jar.xml files may be in an EAR, JAR, or just
standalone XML files. If you migrate from standalone XML files (rather than an EAR

or JAR file), ensure that the domain classes are accessible and included in your
classpath.

The TopLink migration tool creates a new orion-ejb-jar.xml and
toplink-ejb-jar.xml file to the target directory you specify in the same format as
it reads the original files. For example, if you specify an EAR file as input, then the
TopLink migration tool stages and creates a new EAR file that contains both the new
orion-ejb-jar.xml and the new toplink-ejb-jar.xml file, but is otherwise
identical to the original.

The TopLink Workbench project file is always created as a separate file.

Note: Oracle recommends that you make a backup copy of
your orion-ejb-jar.xml file before using the TopLink
migration tool.

Migration
As it operates, the TopLink migration tool logs all errors and diagnostic output to a log
file named oc4j migration.log in the output directory. If you use the TopLink
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migration tool from TopLink Workbench, see also the TopLink Workbench log file
oracle.toplink.workbench.log located in your user home directory (for
example, C: \Documents and Settings\<user-names).

The TopLink migration tool processes descriptor, mapping, and query information
from the input files as follows:

» It builds a TopLink descriptor object for each entity bean and migrates native
persistence metadata like mapped tables, primary keys, and mappings for CMP
and CMR fields.

» It builds a TopLink mapping object for every CMP and CMR field of an entity
bean and migrates native persistence metadata like foreign key references.

» It builds a TopLink query object for each finder or ejbSelect of an entity bean
and migrates persistence metadata like customized query statements.

Table 7-3 lists OC4J <entity-deployment> attributes and subelements from the
orion-ejb-jar.xml file and for each, indicates whether or not the TopLink
migration tool:

s Retains it in the new orion-ejb-jar.xml file
= Migrates it to the new toplink-ejb-jar.xml file

In Table 7-3, elements are identified with angle brackets. Note that in some cases an
attribute is migrated when set to one value, but discarded if set to another value (for
example, exclusive-write-access).

Table 7-3 OC4dJ orion-ejb-jar.xml Feature Migration

Retained in New | Migrated to New
orion-ejb-jar.xml Feature orion-ejb-jar.xml | toplink-ejb-jar.xml

<entity-deployment>

clustering-schema

copy-by-value

data-source

location

max-instances

min-instances

max-tx-retries

disable-wrapper-cache

name

pool-cache-timeout

wrapper

local-wrapper

call-timeout

exclusive-write-access

true

false

do-select-before-insert

true

false

isolation

locking-mode
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Table 7-3 (Cont.) OC4J orion-ejb-jar.xml Feature Migration

orion-ejb-jar.xml Feature

Retained in New
orion-ejb-jar.xml

Migrated to New
toplink-ejb-jar.xml

pessimistic

optimistic

read-only

old pessimistic

update-changed-fields-only

true

false

table

force-update

truel

false

data-synchronization-option

ejbCreate

ejbPostCreate

batch-size

Any value greater than 1

<ior-security-configs>

<env-entry-mapping>

<resource-ref-mappings>

<resource-env-ref-mapping>

<primkey-mappings>

<cmp-field-mapping>

one-to-one-join

inner

outer?

shared

<finder-method>

<persistence—type>3

With EJB Information" on page 25-45.

You can enable force-update after migration. For more information, see "Configuring a Descriptor

TopLink supports both outer and inner joins at run time.You can manually configure EJB descriptors

with these options. For more information, see "Join Reading and Object-Level Read Queries" on

page 93-12.

% The persistence-type attribute’s table column size, if present, is discarded. For more information, see

"Recovering persistence-type Table Column Size" on page 7-12.

Table 74 lists OC4J features and their TopLink equivalents configured by the TopLink

migration tool.

Table 7-4 0OC4dJ and TopLink Feature Comparison

Feature orion-ejb-jar.xml

toplink-ejb-jar.xml

CMP field mapping Direct

Serialized object

Direct-to-field

Serialized object
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Table 7-4 (Cont.) OC4J and TopLink Feature Comparison

Feature orion-ejb-jar.xml toplink-ejb-jar.xml

CMR field mapping One-to-one One-to-one
One-to-many One-to-many
Many-to-many Many-to-many

Partial query Full SQL statement SQL Call

Finder Oracle specific syntax SQL Call or EJB QL

Lazy loading (fetch group) Lazy loading of primary key and ~ Not supported

CMP fields

Alternatively, you can manually
configure the TopLink equivalent, if
appropriate (see "Fetch Groups" on
page 23-5).

SQL statement caching Cache static SQL Not supported at the bean level.
TopLink supports parameterized SQL
and statement caching at the session
and query level (see Chapter 93,
"Understanding TopLink Queries").

Locking Optimistic: database-level Optimistic: object-level

Pessimistic: bean instance-level Pessimistic: query lock at
database-level

Read-only Attempt to change throws Attempt to change throws

Exception Exception
Validity timeout Read-only bean validity timeout =~ Cache timeout
before reloaded.
Isolation level Committed Committed
Serializable Serializable
Not Committed
Not Repeatable
Delay update until commit Supported Supported (see "Configuring a

Descriptor With EJB Information" on
page 25-45).

Exclusive write access on bean

Default value is false

Assume true

Insert without existence check

Supported

Supported

Update changed fields only

Supported

Supported (see "Attribute Change
Tracking Policy" on page 97-8).

Force update

Invoke bean life cycle ejbStore
method even though persistent
fields have not changed

Supported

Using the TopLink Migration Tool From TopLink Workbench

To use the TopLink migration tool and create a new, mapped TopLink Workbench

project from an OC4J application, use this procedure:

1. From TopLink Workbench, select File > Migrate > From OC4]J 9.0.x.
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Figure 7-1 Create Project from OC4J Migration Dialog Box

T Create Mapping Workbench Projects from OC4.J Migration g|

Frorm:
() Individual Files

Input Directory:
() Archive File
Toe
Cutput Directory:
Clazspath

Add Ertries. ..

2. Continue with "Post-Migration Changes" on page 7-12.

Use the following information to enter data in each field of the Create Project from

0OC4] dialog box:
Field Description
From Use these fields to specify the location of the existing OC4] files.
These files may be included as part of a JAR, EAR, or individual
files.
Individual Files Select to convert from individual ejb-jar.xml and
orion-ejb-jar.xml files in the Input Directory. Click
Browse and select the directory location that contains the XML
files to convert from.
Archive File Select to use a specific archive file. Click Browse and select the
archive file to convert from..
To Use these fields to specify the location to which migrated files
are written.
Output Directory Click Browse and select a directory location in which to create
the new XML files and TopLink Workbench project.
Classpath If you are migrating from individual files, ensure that the
domain classes are accessible and included in your classpath.
Show Migration Log Select to have migration log output displayed in a separate

window.

Using the TopLink Migration Tool From the Command Line

To use the TopLink migration tool from the command line, you must perform the
following steps:

1. Ensure that the following is in your classpath:
» <TOPLINK HOME>/jlib/antlr.jar

» <TOPLINK HOME>/jlib/ejb.jar
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m <TOPLINK HOME>/jlib/toplink.jar

m <TOPLINK HOME>/jlib/cmpmigrator.jar
» <TOPLINK HOME>/jlib/toplinkmw.jar

» <TOPLINK HOME>/jlib/tlmwcore.jar

m <TOPLINK HOME>/config

m <ORACLE HOME>/lib/xmlparserv2.jar

2, If you intend to migrate from plain XML files (rather than an EAR or JAR file),
ensure that the domain classes are accessible and included in your classpath.

3. Make a backup copy of your original XML files.

4. Execute the TopLink migration tool as Example 7-2 illustrates using the
appropriate arguments listed in Table 7-5.

The usage information for the TopLink migration tool is:

java -Dtoplink.ejbjar.schemavalidation=<true|false>
-Dtoplink.migrationtool.generateWorkbenchProject=<true|false>
-Dhttp.proxyHost=<proxyHost> -Dhttp.proxyPort=<proxyPort>
oracle.toplink.tools.migration.TopLinkCMPMigrator -s<nativePM> -i<inputDirs>
-a<ear>|<jar> -x -o<outputDir> -v

To identify the input files, you must specify one of -a or -x.

For troubleshooting information, see "Troubleshooting Your Migration" on
page 13.

Example 7-2 Using the TopLink Migration Tool from the Command Line

java -Dhttp.proxyHost=www-proxy.us.oracle.com -Dhttp.proxyPort=80
oracle.toplink.tools.migration.TopLinkCMPMigrator -sOc4j-native -iC:/mywork/in
-aEmployee.ear -oC:/mywork/out -v

Table 7-5 TopLink Migration Tool Arguments

Argument Description

toplink.ejbjar.schemavalidation The system property used to turn on schema validation if
ejb-jar.xml uses XML Schema (XSD) instead of DTD. The
default value is false.

toplink.migrationtool.generateWorkbenchProject The system property used enable generation of the TopLink
Workbench project. The default value is true.

<proxyHost> The address of your local HTTP proxy host

<proxyHost> The port number on which your local HTTP proxy host receives
HTTP requests.

-s <source> The name of the native persistence manager from which you are
migrating.

For OC4]J, use the name Oc4j-native.

-i <input-directorys> Fully qualified path to the input directory that contains both the
OC4J ejb-jar.xml and orion-ejb-jar.xml files to
migrate. Default: current working directory.

-a <EAR-or-JAR> Fully qualified path to the archive file (either an EAR or JAR)
that contains both the OC4] ejb-jar.xml and
orion-ejb-jar.xml files to migrate.
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Table 7-5 (Cont.) TopLink Migration Tool Arguments

Argument

Description

-X

Tells the TopLink migration tool that the OC4] files in the input
directory to migrate from are plain XML files (not in an archive
file).

If you use this option, ensure that the domain classes are
accessible and included in your classpath.

-0 <output-directory <targetDirs is the path to the directory into which the

TopLink migration tool writes the new orion-ejb-jar.xml,
toplink-ejb-jar.xml, and log files. The path may be
absolute or relative to the current working directory. You must
specify this argument value.

Ensure that permissions are set on this directory to allow the
TopLink migration tool to create files and subdirectories.

Verbose mode. Tells the TopLink migration tool to log errors and
diagnostic information to the console.

Post-Migration Changes

After you migrate the orion-ejb-jar.xml file persistence configuration to your
toplink-ejb-jar.xml file, consider the following post-migration changes:

= Recovering persistence-type Table Column Size
»  Updating the Unknown Primary Key Class Mapping Sequence Table

s Project Customization

Recovering persistence-type Table Column Size

In the orion-ejb-jar.xml file, you can specify this mapping,
cmp-field-mapping, with a persistence-type attribute that provides both the
type and column size as shown in Example 7-3.

Example 7-3 A cmp-field-mapping with persistence-type Specifying a Column Size
<cmp-field-mapping ejb-reference-home="MyOtherEntity" name="myField"
persistence-name="myField" persistence-type="VARCHAR2 (30)">

The TopLink migration tool migrates the persistence type but not the column size
because a TopLink project does not normally contain this size information.

To recover the persistence-type column size, do the following:

1. Perform the migration as described in "Using the TopLink Migration Tool From
the Command Line" on page 10.

2. Launch the generated TopLink Workbench project file TLCmpProject . mwp.
3. Login to your database (see "Logging In and Out of a Database" on page 4-21).

TopLink Workbench retrieves all column sizes.

Updating the Unknown Primary Key Class Mapping Sequence Table

TopLink supports the use of an unknown primary key class (see "Unknown Primary
Key Class Support" on page 7-25) and so the TopLink migration tool also supports this
feature.

OC4J uses a native run-time key generator to generate unique keys for auto-id key
fields. In contrast, TopLink uses a sequencing table.
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If your OC4J persistence configuration includes the use of an unknown primary key
class, then the TopLink migration tool will create a sequencing table for this purpose.

Before deploying your application after migration, you must do the following;:
1. Determine the largest key value generated prior to migration.

2, Manually update the counter of the TopLink migration tool-generated sequence
table to a number that must be one larger than the largest key value generated
prior to migration.

Project Customization
You can customize the following components of your project:

»  EJB 3.0 Persistence Manager Customization
»  EJB 2.1 Persistence Manager Customization

» Session Event Listener

EJB 3.0 Persistence Manager Customization For an EJB 3.0 persistent application deployed
to OC4]J, you customize the TopLink persistence manager by creating a TopLink
project XML file named toplink-ejb-jar.xml and a TopLink session XML file
named ejb3-toplink-sessions.xml and packaging them in the META- INF
directory of the EJB-JAR that contains your entities. For more information, see
"Customizing the TopLink Persistence Manager in an E]JB 3.0 Application” in the Oracle
Containers for J2EE Enterprise JavaBeans Developer’s Guide.

EJB 2.1 Persistence Manager Customization For an EJB 2.1 CMP application deployed to
OC4J, you customize the TopLink persistence manager by configuring properties in
the orion-ejb-jar.xml file. These properties are used to configure the TopLink
session that the TopLink runtime uses internally for CMP projects. For more
information, see "Configuring persistence-manager Entries" on page 8-10.

Session Event Listener After you applied the default settings to your project at
deployment time, you may wish to customize the TopLink session by configuring the
session event listener. The pre-login event that the session raises is particularly useful.
It lets you define the custom (nondefault) specifics for the session just before the
session initializes and acquires connections.

For more information, see the following:
= "Session Customization" on page 72-4
»  "Managing Session Events With the Session Event Manager" on page 72-5

s "Configuring Session Event Listeners" on page 74-17

Troubleshooting Your Migration

This section describes solutions for problems you may encounter during migration,
including the following;:

s Log Messages
s Unexpected Relational Multiplicity

Log Messages

As it operates, the TopLink migration tool logs all errors and diagnostic output to a log
file named oc4j migration. log in the output directory. If you use the TopLink
migration tool from TopLink Workbench, see also the TopLink Workbench log file
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oracle.toplink.workbench. log located in your user home directory (for
example, C: \Documents and Settings\<user-names)

In addition to these warnings, the TopLink migration tool logs an error if it encounters
a problem that prevents it from completing the migration. Table 76 lists these
problems and suggests possible solutions.

Table 7-6 TopLink Migration Tool Error Messages

Error Message Description

There isno ejb-jar.xml The ejb-jar.xml file is missing. The TopLink migration tool
in the input file. You must stops and copies the original input files into the target directory.
provide theejb-jar.xml
in order for the migration
process to work.

Verify that the ejb-jar.xml file is present in the specified EAR,
JAR, or as a plain XML file. Empty the target directory and execute
the TopLink migration tool again.

There is not an The orion-ejb-jar.xml file is missing. The TopLink migration
orion-ejb-jar.xml tool stops and copies the original input files into the target
with native persistent directory.

metadata defined, no

migration needed., Verify that the orion-ejb-jar.xml file is present in the

specified EAR, JAR, or as a plain XML file. Empty the target
directory and execute the TopLink migration tool again.

toplink-ejb-jar.xml A toplink-ejb-jar.xml fileis already present in the target
is already defined in the directory. The TopLink migration tool stops and copies the original
archive, no migration input files into the target directory.

needed. Remove the toplink-ejb-jar.xml file from the target

directory. Empty the target directory and execute the TopLink
migration tool again.

Unexpected Relational Multiplicity

The TopLink migration tool retrieves relationship multiplicity from the
orion-ejb-jar.xml file and not from the OC4] ejb-jar.xml file.

Thus, even though the OC4] ejb-jar.xml file defines a relationship to be
one-to-many, if the orion-ejb-jar.xml file defines the same relationship as
many-to-many, then the TopLink migration tool will migrate the relationship as
many-to-many.

JTA Integration

For applications that require JTA integration, specify the external transaction controller
when you configure the server platform in your session (see "Configuring the Server
Platform" on page 74-14).

For more information, see "Integrating the Unit of Work With an External Transaction
Service" on page 99-21.

BEA WebLogic Server

To integrate a TopLink application with BEA WebLogic Server, you must consider the
following:

= Classpath

s CMP Integration

= Migrating BEA WebLogic Persistence to OC4] TopLink Persistence
s JTA Integration
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Security Manager

In addition to configuring these BEA WebLogic Server-specific options, you must also
consider the general application server integration issues in "Application Server
Integration Concepts" on page 7-2.

Classpath

To configure TopLink support for BEA WebLogic Server, do the following:

1.

CMP Integration

Add the following JAR files to the application server classpath:

<ORACLE_HOME>\toplink\jlib\toplink.jar

Ensure that your TopLink application defines an XML parser platform (see "XML
Parser Platform Configuration" on page 7-2).

To enable TopLink CMP integration in BEA WebLogic Server, use the following
procedure (assuming you have already installed TopLink):

1.

Locate the persistence directory, located above the installation drive and root
directory of your BEA WebLogic Server executable, as follows:

Version Persistence Directory (above the <WebLogic INSTALL DIR>)
6.1 (Service Pack 4) \wlserveré6.1l\lib\persistence

7.0 (Service Pack 2) \weblogic700\server\lib\persistence

8.1 \weblogic8l\server\lib\persistence

Do one of the following:

s Use a text editor to open the persistence.install file in the
BEA WebLogic Server persistence directory, and add a new line that references
the TopLink CMP Descriptor.xml file.

= Replace the WebLogic persistence.install file with the TopLink
persistence.install file found in the
<ORACLE_HOME>\toplink\config directory.

Add the following JAR files to the application server classpath:

<ORACLE_HOME>\toplink\jlib\toplink.jar
<ORACLE_HOME>\lib\xmlparserv2.jar

If necessary, migrate your CMP application using the TopLink migration tool
("Migrating BEA WebLogic Persistence to OC4] TopLink Persistence" on
page 7-16).

Ensure that all necessary deployment descriptor files are in place (see "Creating
TopLink Files for Deployment" on page 8-1 and "Packaging a TopLink
Application” on page 9-1).

Optionally, consider the EJB customization options that TopLink provides
("Configuring Miscellaneous EJB Options" on page 7-25).

Start the container, and then start the TopLink application. Where supported, use a
startup script to start the server. If you write your own startup script, ensure that
the classpath includes the files listed in Step 2.
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Migrating BEA WebLogic Persistence to OC4J TopLink Persistence

You can migrate a BEA WebLogic application that uses the default BEA WebLogic
persistence manager to an Oracle Containers for J2EE (OC4J) application that uses
TopLink as the persistence manager. In this release, Oracle provides a TopLink
migration tool that you can use to automate this migration.

This section includes the following:

s Overview

= Using the TopLink Migration Tool From TopLink Workbench
s  Using the TopLink Migration Tool From the Command Line

If you encounter problems during migration, see "Troubleshooting Your Migration" on
page 7-13.

After using the TopLink migration tool, you may need to make some additional
changes as described in "Post-Migration Changes" on page 12.

Overview

Before using the TopLink migration tool, review this section to understand how the
TopLink migration tool works and to determine what BEA WebLogic persistence
manager metadata is, and is not, migrated.

Input and Output

The TopLink migration tool takes the following files as input:

s weblogic-ejb-jar.xml

m weblogic-cmp-rdbms-jar.xml

It migrates as much BEA WebLogic-specific persistence configuration as possible to a
new toplink-ejb-jar.xml file and creates the following new files in a target
directory you specify:

m orion-ejb-jar.xml

m toplink-ejb-jar.xml

s TopLink Workbench project file TLCmpProject . mwp

The input BEA WebLogic files may be in an EAR, JAR, or just standalone XML files. If

you migrate from standalone XML files (rather than an EAR or JAR file), ensure that
the domain classes are accessible and included in your classpath.

The TopLink migration tool creates a new orion-ejb-jar.xml and
toplink-ejb-jar.xml file to the target directory you specify in the same format as
it reads the original files. For example, if you specify an EAR file as input, then the
TopLink migration tool stages and creates a new EAR file that contains both the new
orion-ejb-jar.xml and the new toplink-ejb-jar.xml file, but is otherwise
identical to the original.

The TopLink Workbench project file is always created as a separate file.

Note: Oracle recommends that you make a backup copy of
your weblogic-ejb-jar.xml,
weblogic-cmp-rdbms-jar.xml, and
toplink-ejb-jar.xml files before using the TopLink
migration tool.
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For information on configuring the weblogic-ejb-jar.xml file, see "Configuring the
weblogic-ejb-jar.xml File for BEA WebLogic Server" on page 8-13.

Migration

As it operates, the TopLink migration tool logs all errors and diagnostic output to a log
file named wls migration. log in the output directory. If you use the TopLink
migration tool from TopLink Workbench, see also TopLink Workbench log file
oracle.toplink.workbench. log located in your user home directory (for
example, C: \Documents and Settings\<user-names).

The TopLink migration tool processes descriptor, mapping, and query information
from the input files. It performs the following:

» It builds a TopLink descriptor object for each entity bean and migrates native
persistence metadata like mapped tables, primary keys, and mappings for CMP
and CMR fields.

s It builds a TopLink mapping object for every CMP and CMR field of an entity
bean and migrates native persistence metadata like foreign key references.

s It builds a TopLink query object for each £inder or ejbSelect of an entity bean
and migrates persistence metadata like customized query statements.

Table 7-7 lists BEA WebLogic features and their TopLink equivalents configured by the
TopLink migration tool.

Table 7-7 BEA WebLogic and TopLink Feature Comparison

Feature weblogic-cmp-rdbms-jar.xml toplink-ejb-jar.xml

Direct mapping Field mapping Direct-to-field
Table mapping

Relational mapping WebLogic-RDBMS relation One-to-one

One-to-many

Many-to-many

Multiple tables Table mapping Supported
Read-only Read-only: concurrency strategy Supported
Pessimistic locking Enforce pessimistic concurrency ona  Supported

per-bean basis

Large Objects (LOB) support  Map the current field to one of the Supported for Oracle BLOB only
following:

1. CLOB or BLOB in an Oracle
database

2. LongStringorSybaseBinary
in a Sybase database

Optimistic locking Optimistic: concurrency strategy Version
Verify columns: optimistic Timestamp
concurrency strategy
Cascade delete Database cascade delete Privately owned
Sorting database dependency Order database operations unit of work
Lazy loading (fetch group) Field group Not supported.

Alternatively, you can manually
configure the TopLink equivalent,
if appropriate (see "Fetch Groups"
on page 23-5).
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Using the TopLink Migration Tool From TopLink Workbench

To use the TopLink migration tool and create a new, mapped TopLink Workbench
project from a BEA WebLogic application, use this procedure:

1. From TopLink Workbench, select File > Migrate > From Weblogic Server.

Figure 7-2 Create Projects from WebLogic Server Migration Dialog Box

3 Create Mapping Workbench Projects from WLS Migration El

(%) Archive File
Toe

Cutput Directory:
Classpath

Add Ertries. ..

[ show Migration Log

2. Continue with "Post-Migration Changes" on page 7-12.

Use the following information to enter data in each field on the Create Project from

WebLogic dialog box:
Field Description
From Use these fields to specify the location of the existing BEA
WebLogic files. These files may be included as part of a JAR,
EAR, or individual files.
Individual Files Select to convert from individual weblogic-ejb-jar.xml
and weblogic-cmp-rdbms-jar.xml files in the Input
Directory. Click Browse and select the directory location that
contains the XML files to convert from.
Archive File Select to use a specific archive file. Click Browse and select the
archive file to convert from..
To Use this field to specify the location to which migrated files are
written.
Output Directory Click Browse and select a directory location in which to create
the new XML files and TopLink Workbench project.
Classpath If you are migrating from individual files, ensure that the
domain classes are accessible and included in your classpath.
Show Migration Log Select to have migration log output displayed in a separate

window.

Using the TopLink Migration Tool From the Command Line
To use the TopLink migration tool from the command line, you must do the following;:
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1. Ensure that the following is in your classpath:
» <TOPLINK HOME>/jlib/antlr.jar
» <TOPLINK HOME>/jlib/ejb.jar
m <TOPLINK HOME>/jlib/toplink.jar
m <TOPLINK HOME>/jlib/cmpmigrator.jar
m <TOPLINK HOME>/jlib/toplinkmw.jar
» <TOPLINK HOME>/jlib/tlmwcore.jar
m <TOPLINK HOME>/config
m <ORACLE HOME>/lib/xmlparserv2.jar

2, If you intend to migrate from plain XML files (rather than an EAR or JAR file),
ensure that the domain classes are accessible and included in your classpath.

3. Make a backup copy of your original XML files.

4. Execute the TopLink migration tool as Example 7—4 illustrates using the
appropriate arguments listed in Table 7-8.

The usage information for the TopLink migration tool is:

java -Dtoplink.ejbjar.schemavalidation=<true|false>
-Dtoplink.migrationtool.generateWorkbenchProject=<true|false>
-Dhttp.proxyHost=<proxyHost> -Dhttp.proxyPort=<proxyPort>
oracle.toplink.tools.migration.TopLinkCMPMigrator -s<nativePM> -i<inputDirs>
-a<ear>|<jar> -x -o<outputDir> -v

To identify the input files, you must specify one of -a or -x.

For troubleshooting information, see "Troubleshooting Your Migration" on
page 13.

Example 7-4 Using the TopLink Migration Tool from the Command Line

java -Dhttp.proxyHost=www-proxy.us.oracle.com -Dhttp.proxyPort=80
oracle.toplink.tools.migration.TopLinkCMPMigrator -sWebLogic -iC:/mywork/in
-aEmployee.ear -oC:/mywork/out -v

Table 7-8 TopLink Migration Tool Arguments

Argument Description

toplink.ejbjar.schemavalidation The system property used to turn on schema validation if
ejb-jar.xml uses XML Schema (XSD) instead of DTD. The
default value is false.

toplink.migrationtool.generateWorkbenchProject The system property used enable generation of the TopLink
Workbench project. The default value is true.

<proxyHost> The address of your local HTTP proxy host

<proxyHost> The port number on which your local HTTP proxy host receives
HTTP requests.

-s <source> The name of the native persistence manager from which you are
migrating.

For BEA WebLogic, use the name WebLogic.

-i <input-directorys> Fully qualified path to the input directory that contains the BEA
WebLogic weblogic-ejb-jar.xml and
weblogic-cmp-rdbms-jar.xml files to migrate. Default:
current working directory.
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Table 7-8 (Cont.) TopLink Migration Tool Arguments

Argument

Description

-a <EAR-or-JAR>

Fully qualified path to the archive file (either an EAR or JAR)
that contains both the BEA WebLogic
weblogic-ejb-jar.xml and
weblogic-cmp-rdbms-jar.xml files to migrate.

Tells the TopLink migration tool that the BEA WebLogic files in
the input directory to migrate from are plain XML files (not in an
archive file).

If you use this option, ensure that the domain classes are
accessible and included in your classpath.

-0 <output-directory

The path to the directory into which the TopLink migration tool
writes the new orion-ejb-jar.xml,
toplink-ejb-jar.xml, and log files. The path may be
absolute or relative to the current working directory. You must
specify this argument value.

Ensure that permissions are set on this directory to allow the
TopLink migration tool to create files and subdirectories.

Verbose mode. Tells the TopLink migration tool to log errors and
diagnostic information to the console.

JTA Integration

For applications that require JTA integration, specify the external transaction controller
when you configure the server platform in your session (see "Configuring the Server
Platform" on page 74-14).

For more information, see "Integrating the Unit of Work With an External Transaction
Service" on page 99-21.

Security Manager

If you use a security manager, specify a security policy file in the weblogic.policy
file (normally located in the BEA WebLogic install directory), as follows:

-Djava.security.manager
-Djava.security.policy==c:\weblogic\weblogic.policy

The BEA WebLogic installation procedure includes a sample security policy file. You
need to edit the weblogic.policy file to grant permission for TopLink to use
reflection.

The following example illustrates only the permissions that TopLink requires, but
most weblogic.policy files contain more permissions than are shown in this
example.

Example 7-5 A Subset of a "Grant" Section from a BEA WebLogic.policy File

grant {
// "enableSubstitution" required to run the WebLogic console
permission java.io.SerializablePermission "enableSubstitution";
// "modifyThreadGroup" required to run the WebLogic Server
permission java.lang.RuntimePermission "modifyThreadGroup";
// grant permission for TopLink to use reflection
permission java.lang.reflect.ReflectPermission "suppressAccessChecks";

}i
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IBM WebSphere Application Server

Classpath

To integrate a TopLink application with IBM WebSphere Application Server, you must
consider the following;:

= Classpath
s CMP Integration
s JTA Integration

In addition to configuring these IBM WebSphere application server-specific options,
you must also consider the general application server integration issues in
"Application Server Integration Concepts" on page 7-2.

You configure the IBM WebSphere application server classpath differently depending
on what version of this server you are using;:

s Configuring Classpath for IBM WebSphere Application Server 4.0
s Configuring Classpath for IBM WebSphere Application Server 5.0 and Later

Configuring Classpath for IBM WebSphere Application Server 4.0

TopLink provides CMP support for IBM WebSphere application server 4.0. To
configure the classpath for this version, do the following;:

1. Add the following JAR files to the application server classpath directory (see
Table 7-9):

<ORACLE_HOME>\toplink\jlib\toplink.jar

2. Ensure that your TopLink application defines an XML parser platform (see "XML
Parser Platform Configuration” on page 7-2).

Table 7-9 lists the default application classpath directories for IBM container

components in IBM WebSphere application server 4.0.

Table 7-9 Classpath Directories for IBM WebSphere 4.0 Container Components

Container Default Application Classpath
WebSphere Application Server 4.0 \WebSphere\AppServer\lib\app
(for Windows)

WebSphere Studio Application Developer 4.0 \Program Files\ibm\Application
(for Windows) Developer\plugins\com.ibm.etools.
websphere.runtime\lib\app

Configuring Classpath for IBM WebSphere Application Server 5.0 and Later

TopLink provides JTA and general integration support for IBM WebSphere application
server 5.0 and later. To configure the classpath for this version, do the following:

1. Create a shared library that contains the following Toplink JAR files and associate
the shared library with the application:

<ORACLE_HOME>\toplink\jlib\toplink.jar

2. Ensure that your TopLink application defines an XML parser platform (see "XML
Parser Platform Configuration” on page 7-2).
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CMP Integration

To enable TopLink CMP integration in IBM WebSphere application server, use the
following procedure (assuming you have already installed TopLink):

1. Ensure that all necessary deployment descriptor files are in place (see "Creating
TopLink Files for Deployment" on page 8-1 and "Packaging a TopLink
Application" on page 9-1).

2. Optionally, consider the EJB customization options that TopLink provides
("Configuring Miscellaneous EJB Options" on page 7-25).

JTA Integration

For applications that require JTA integration, specify the external transaction controller
when you configure the server platform in your session (see "Configuring the Server
Platform" on page 74-14).

For more information, see "Integrating the Unit of Work With an External Transaction
Service" on page 99-21.

Clustering on IBM WebSphere Application Server

For more information on integrating a TopLink application with an application server
cluster, see "Clustering” on page 7-4.

Understanding Security Permissions

By default, when you run a TopLink-enabled application in a JVM configured with a
nondefault java.lang.SecurityManager, the TopLink run time executes certain
internal functions by executing a PrivilegedAction with
java.security.AccessController method doPrivileged. This ensures that
you do not need to grant many permissions to TopLink for it to perform its most
common operations. You need only grant certain permissions depending on the types
of optional TopLink features you use (see "Permissions Required by TopLink Features'
on page 7-23).

[

While using doPrivileged method provides enhanced security, it will severely
impact overall performance. Alternatively, you can configure TopLink to disable the
use of doPrivileged method even when a nondefault SecurityManager is
present (see "Disabling doPrivileged Operation" on page 7-25). In this case, you must
grant TopLink all required permissions (see "Permissions Required by TopLink
Features" on page 7-23 and "Permissions Required When doPrivileged is Disabled" on
page 7-24).

Note: While enabling the use of doPriviledged method enhances
TopLink application security, it does not guarantee that secure code
cannot be called by application code in ways that the system did not
intend. You must consider the use of doPriviledged method within
the context of your overall application security strategy. For more
information, see http://java.sun.com/security/index. jsp.

If you run a TopLink-enabled application in a JVM without a nondefault
SecurityManager, you do not need to grant any permissions.
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Permissions Required by TopLink Features

When you run a TopLink-enabled application in a JVM configured with a nondefault
java.lang.SecurityManager and doPrivileged operation is enabled, you may
need to grant additional permissions if your application requires any of the following:

= System Properties

s Loading project.xml or sessions.xml Files
s Cache Coordination

= Accessing a Data Source by Port

= Logging With java.util.logging

= J2EE Application Deployment

System Properties

By default, a TopLink-enabled application requires access to the system properties
granted in the default <JAVA HOME>/lib/security/java.policy file. If your
application requires access to other platform-specific, environment, or custom
properties, then grant further PropertyPermission permissions as Example 7-6
shows.

Example 7-6 Permissions for System Properties

permission java.util.PropertyPermission "my.property", "read";

Loading project.xml or sessions.xml Files

Most TopLink-enabled applications read in project .xml and sessions.xml files
directly. Grant permissions to the specific files or file locations as Example 7-7 shows.
This example assumes that both project .xml and sessions.xml files are located
in the same directory (given by application-specific system property

deployment .xml . home). Alternatively, you can specify a separate
FilePermission for each file.

Example 7-7 Permissions for Loading Deployment XML Files

permission java.io.FilePermission "${deployment.xml.home}/*.xml", "read";

For information on FilePermission settings for J2EE applications, see "J2EE
Application Deployment" on page 7-24.

Cache Coordination

If your application uses cache coordination (see "Understanding Cache Coordination"
on page 87-10), then grant accept, connect, listen, and resolve permissions to
the specific sockets used by your coordinated cache as Example 7-8 shows. This
example assumes that the coordinated cache multicast port (see "Configuring a
Multicast Port" on page 88-5) is 1024.

Example 7-8 Permissions for Cache Coordination

permission java.net.SocketPermission "localhost:1024-", "accept, connect, listen, resolve";
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Accessing a Data Source by Port

If your TopLink-enabled application accesses a data source using a socket, then grant
connect and resolve permissions for that socket as Example 7-9 shows. This
example assumes that the host name (or IP address) of the remote host that provides
the data source (such as a relational database server host) is given by
application-specific system property remote.data.source.host and that this host
accepts data source connections on port 1025.

Example 7-9 Permissions for non-J2EE Data Source Connections

permission java.net.SocketPermission “${remote.dataAsourceAhost}:1025—", "connect, resolve";

For J2EE applications, data source socket permissions are usually handled by the
application server.

Logging With java.util.logging

If you configure your TopLink-enabled application to use java.util.logging
package (see "Configuring Logging" on page 74-4), then grant your application
control permissions as Example 7-10 shows.

Example 7-10 Permissions for java.util.logging

permission java.util.logging.LoggingPermission "control"

J2EE Application Deployment

If you are deploying a TopLink-enabled J2EE application, you must grant
permissions for:

s The toplink. jar file. For example:

grant codeBase "file:<TOPLINK HOME>/jlib/toplink.jar" {
permission java.security.AllPermission;

bi
If you are using an XML platform, you must also grant the following permissions:
s The toplink.xml.platformsystem property. For Example:

permission java.util.PropertyPermission "toplink.xml.platform", "read"

Permissions Required When doPrivileged is Disabled

If you disable doPrivileged operation when you run a TopLink-enabled application
in a JVM configured with a nondefault java.lang.SecurityManager, you must
grant the following permissions:

m Jjava.lang.reflect.RelectPermission "suppressAccessChecks"
m Jjava.lang.RuntimePermission "accessDeclaredMembers"
m Jjava.lang.RuntimePermission "getClassLoader"

You may also have to grant additional permissions depending on the TopLink features
your application uses. For more information, see "Permissions Required by TopLink
Features" on page 7-23.
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Disabling doPrivileged Operation

To disable doPrivileged operation when you run a TopLink-enabled application in
a JVM configured with a nondefault java.lang.SecurityManager, set system
property oracle.j2ee.toplink.security.usedoprivileged to false. If you
are using OC4J, set system property oracle.j2ee.security.usedoprivileged
to false.

To enable doPrivileged operation, set these system properties to true.

Configuring Miscellaneous EJB Options

TopLink provides system properties that you can use to customize the following EJB
options:

»  Setter Parameter Type Checking
s Unknown Primary Key Class Support
= Single-Object Finder Return Type Checking

Setter Parameter Type Checking

To make TopLink verify that the parameters to one-to-one and one-to-many
relationship setters are of the same type as the corresponding CMR field, set system
property toplink.cts.collection.checkParameters to a value of true (not
case sensitive). If the setters are not the same type, then TopLink throws a
java.lang.IllegalArgumentException.

Note: Setting this property to true will affect performance. Use this
setting only if necessary.

If you set the property to false (the default value), TopLink does not make this
verification. In this case, it is up to your application to make sure the parameters are of
the correct type.

For more information, see the EJB 2.1 specification, section 10.3.6.

Unknown Primary Key Class Support

In special situations, you may choose not to specify the primary key class or the
primary key fields for an entity bean with container-managed persistence. For
example, if the entity bean does not have a natural primary key or you want the
deployer to select the primary key fields at deployment time, you may choose to defer
primary key type specification.

If this is the case, you must declare the type of the argument of the
findByPrimaryKey method as java.lang.Object and you must also specify the
primary key class (prim-key-class) in the deployment descriptor (ejb-jar.xml)
as java.lang.Object.

TopLink now provides run-time support for such deferred primary key type
specification.

For more information, see the EJB 2.1 specification, section 10.8.3.
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Single-Object Finder Return Type Checking

By setting system property toplink.cts.checkMultipleRows to true, you can
configure TopLink to throw a javax.ejb.FinderException if multiple beans are
returned from a single-object finder method.

For more information, see the EJB 2.1 specification, section 10.5.6.1.
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Creating TopLink Files for Deployment

This chapter includes TopLink information you need when creating deployment files
for the following types of applications:

Java Applications

= JavaServer Pages and Servlet Applications

= Session Bean Applications

= CMP Applications

= BMP Applications

For more information on packaging and deployment, see the following:
s "Understanding TopLink Deployment File Creation" on page 8-1

s 'Integrating TopLink With an Application Server" on page 7-1

» '"Packaging a TopLink Application" on page 9-1

= "Deploying a TopLink Application" on page 10-1

Understanding TopLink Deployment File Creation

Depending on the type of application you are deploying, you may need to create any
of the following deployment files:

= project.xml File

= sessions.xml File

= ejb-jar.xml File

= <J2EE-Container>-ejb-jar.xml File
= toplink-ejb-jar.xml File

TopLink Workbench provides the ability to create deployment files from a TopLink
Workbench project (see "Exporting Project Information" on page 18-13). After you
build a project, you have two options to create the deployment files:

s Create XML deployment files that require no compiling.

»  Create Java source files, which you compile and deploy outside of TopLink
Workbench.

Oracle recommends XML deployment because XML files are easier to deploy and
troubleshoot than compiled Java files. This approach gives you a very flexible
configuration that enables you to make changes safely and easily. XML deployment
files do not require third-party applications or compilers to deploy successfully.

Creating TopLink Files for Deployment 8-1



Understanding TopLink Deployment File Creation

Note: If you are using EJB 3.0, you can use annotations to specify
most of what you formerly specified in deployment descriptors. Use
deployment descriptors to override annotations or specify options not
supported by annotations. For more information on what annotations
are currently supported, see Oracle Containers for J2EE Enterprise
JavaBeans Developer’s Guide.

project.xml File

The project . xml file is the core of your application. It contains the descriptors and
mappings you define and also includes any named queries or finders associated with
your project.

This section describes the following:

= XSD File Format

= Non-CMP Applications and Project Metadata
= CMP Applications and Project Metadata

s Creating project.xml With TopLink Workbench

»  Creating project.xml Programatically

XSD File Format

Starting with 10g (10.1.3.1.0), the project . xml file uses an XML schema file format
(XSD file) instead of the old document type definition. This defines not only the
elements and attributes, but also the rules that govern how the elements and attributes
are used in a valid XML file. The XSD file is formatted as standard XML and fully
compliant with Oracle namespaces. Although TopLink can read both the current XSD
and older DTD formats, only the current XSD format is written out.

Previously formats were defined only by the DTDs. You can now generate
deployment XML files based on the following XML schemas:

m object-persistence 1 0.xsd: This schema defines general persistence and
mapping concepts.

= toplink-object-persistence 10 1 3.xsd: This schema extends the
general concepts to include additional TopLink specific data.

For more information, refer to the appropriate XSD in the <TOPLINK
HOME>\config\xsds directory. The XSD files are also available on OTN at:

s http://www.oracle.com/technology/oracleas/schema/object-persist
ence 1 0.xsd

s http://www.oracle.com/technology/oracleas/schema/toplink-object
-persistence 10 1 3.xsd

Non-CMP Applications and Project Metadata

For a non-CMP application, you define your project metadata in a project . xml file.

The project .xml file provides a simple and flexible way to configure, modify, and
troubleshoot the project metadata. Because of these attributes, the project .xml file
is the preferred way to configure a TopLink project.
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TopLink Workbench provides a graphical tool to build and edit the project .xml
file. For information on creating projects with TopLink Workbench, see "Creating
project.xml With TopLink Workbench" on page 8-3.

CMP Applications and Project Metadata

For a CMP application, how you specify project metadata is dependent upon the J2EE
application server you are deploying your application (see "toplink-ejb-jar.xml File" on
page 8-6).

Creating project.xml With TopLink Workbench

Because you must synchronize the project .xml file with the classes and data source
associated with your application, Oracle recommends that you not modify this file
manually. TopLink Workbench ensures proper synchronization, and is the best way to
make changes to the project. Simply modify the project in TopLink Workbench and
redeploy the project . xml file. Using this option reduces development time by
eliminating the need to regenerate and recompile Java code each time the project
changes.

See "Exporting Project Information" on page 18-13 for detailed information on
exporting the deployment XML information.

Note: You can name this file with a name other than project .xml;
however, for clarity, this discussion assumes that the file has not been
renamed.

Creating project.xml Programatically
Optionally, you can use the DeploymentXMLGenerator API to programatically
generate the project . xml file in either of the following ways:

= From an application, instantiate the DeploymentXMLGenerator and your java
source. Call the following method:

generate (<MW _Project.mwp>, <output file.xml>)
s From the command line, use:

java -classpath

toplink.jar;toplinkmw. jar;xmlparserv2.jar;ejb.jar;
oracle.toplink.workbench.external.api.DeploymentXMLGenerator
<MW _Project.mwp> <output file.xml>

Before you use either method, ensure your the classpath includes the <ORACLE
HOME>\toplink\config directory.

Note: If you are using EJB 3.0, you can use annotations to specify
most of what you formerly specified in the project . xml file. To
override annotations or specify options not supported by annotations,
you can still provide a project .xml file in your EJB 3.0 application.
For more information on what annotations are currently supported,
see Oracle Containers for J2EE Enterprise JavaBeans Developer’s Guide
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sessions.xml File

Each TopLink project belongs to a TopLink session. A session is the facade through
which an application accesses TopLink functionality (for more information on
sessions, see Part XV, "TopLink Sessions"). Where you define a session differs
depending on whether or not your application uses CMP.

This section describes the following:

= XSD File Format

= Non-CMP Applications and Session Metadata
»  CMP Applications and Session Metadata

XSD File Format

Starting with 10g (10.1.3.1.0), the sessions.xml file uses an XML schema file format
(XSD file) instead of the old document type definition. In addition to gaining all the
benefits of using an XSD, this change ensures that the TopLink run-time environment
provides better diagnostics during sessions.xml file loading and validation.

The XSD files are also available on OTN at:
http://www.oracle.com/technology/oracleas/schema/sessions 10 1
3.xsd

When you use the XSD formatted sessions.xml file, the TopLink run time separates
sessions.xml file validation from session instantiation. Separating XML file
formatting problems from Session Manager session instantiation problems simplifies
troubleshooting. Exceptions thrown during validation clearly indicate that the failure
is due to an invalid sessions.xml file as Example 8-1 illustrates.

Example 8—-1 Enhanced Validation Exceptions

Exception [TOPLINK-9010] (Oracle TopLink - 10g (10.0.3) (Build 040127Dev)):
oracle.toplink.exceptions.SessionLoaderException

Exception Description: A End tag does not match start tag 'session'. was thrown while parsing
the XML file against the XML schema.

Internal Exception: oracle.xml.parser.v2.XMLParseException: End tag does not match start tag
'session'.

Non-CMP Applications and Session Metadata
For a non-CMP application, you define your sessions in a sessions.xml file.
The sessions.xml file provides a simple and flexible way to configure, modify, and

troubleshoot the application sessions. Because of these attributes, the sessions.xml
file is the preferred way to configure a TopLink session.

TopLink Workbench provides a graphical tool to build and edit the sessions.xml
file. For information on creating sessions with TopLink Workbench, see Chapter 73,
"Creating Sessions".

CMP Applications and Session Metadata
For a CMP project, how you specify session metadata is dependent upon the J2EE
application server to which you are deploying your application:

= For OC4]J, the session configuration is done in the orion-ejb-jar.xml file. You
can specify the data-source, some common session options, and a session
customizer class (see "OC4] and the orion-ejb-jar.xml File" on page 8-6). In this
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case, you name the TopLink project XML file as toplink-ejb-jar.xml (see
"project.xml File" on page 8-2)

= For BEA WebLogic Server, the session configuration is done in the
toplink-ejb-jar.xml file. You can specify the data-source, some common
session options, and a session customizer class (see "toplink-ejb-jar.xml File" on
page 8-6).

= For IBM WebSphere application server, the session configuration is done in a
sessions.xml file which must be named toplink-ejb-jar.xml (see
Chapter 73, "Creating Sessions").

Note: If you are using EJB 3.0, you cannot use annotations to specify
session configuration. You must provide a sessions.xml file, if one
is applicable to your application type.

ejb-jar.xml File
Each EJB module contains one ejb-jar.xml file that describes all the EJB in the
module.

Most IDEs provide facilities to create the ejb-jar.xml file. For more information
about generating this file from your IDE, see your IDE documentation.

If you build an EJB application, Oracle recommends that you use TopLink Workbench
to build the ejb-jar.xml file. Because TopLink Workbench can both read and write
the ejb-jar.xml file, you can use TopLink Workbench to maintain your
ejb-jar.xml file in the following ways:

= When you change the file manually outside of TopLink Workbench, reimport the
ejb-jar.xml file into TopLink Workbench project to refresh the project.

= When you change the TopLink Workbench project, TopLink Workbench updates
the ejb-jar.xml file automatically when you save the project.

For more information about managing the ejb-jar.xml file in TopLink Workbench,
see "Working With the ejb-jar.xml File" on page 18-15 for more information.

Note: If you are using EJB 3.0, you can use annotations to specify
most of what you formerly specified in the ejb-jar.xml file. To
override annotations or specify options not supported by annotations,
you can still provide an ejb-jar.xml file in your EJB 3.0 application.
For more information on what annotations are currently supported,
see Oracle Containers for J2EE Enterprise JavaBeans Developer’s Guide.

<J2EE-Container>-ejb-jar.xml File

The contents of the <J2EE-Container>-ejb-jar.xml file depend on the container
to which you deploy your E]B. To create this file, use the tools that accompany your
container.

In most cases, the <J2EE-Container>-ejb-jar.xml file integrates with TopLink
without revision. However, in some cases, you must make some TopLink-specific
modifications.
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Note: If you are using EJB 3.0, you can use annotations to specify
most of what you formerly specified in the
<J2EE-Container>-ejb-jar.xml file. To override annotations or
specify options not supported by annotations, you can still provide a
<J2EE-Container>-ejb-jar.xml file in your EJB 3.0 application.
For more information on what annotations are currently supported,
see Oracle Containers for J2EE Enterprise JavaBeans Developer’s Guide.

For more information, see the following:
= OC4] and the orion-ejb-jar.xml File
= BEA WebLogic Server and the weblogic-ejb-jar.xml File

OC4J and the orion-ejb-jar.xml File

Table 8-1 summarizes the scenarios in which you may choose to modify the
orion-ejb-jar.xml file.

Table 8—1 When to Modify the orion-ejb-jar.xml File

CMP Type Mapping Type Action

Orion Specified in orion-ejb-jar.xml 1. Deploy.

Orion Default mappings 1. Editthe orion-ejb-jar.xml file to set

persistence-manager attribute name to orion.
2. Deploy.

Toplink Specified in 1. Deploy.
toplink-ejb-jar.xml (default
persistence manager properties)

Toplink Specified in 1. Edit the orion-ejb-jar.xml file to set
toplink-ejb-jar.xml (custom persistence-manager attribute name to
persistence manager properties) toplink.

2. Editadditional persistence-manager subentries
(see "Configuring the orion-ejb-jar.xml File for
OC4J" on page 8-9).

3.  Deploy.

Toplink Default mappings (no 1. Deploy.
toplink-ejb-jar.xml)

For more information on configuring the orion-ejb.jar.xml file, see "Configuring
the orion-ejb-jar.xml File for OC4]" on page 8-9.

BEA WebLogic Server and the weblogic-ejb-jar.xml File

For more information on configuring the weblogic-ejb-jar.xml, see "Configuring
the weblogic-ejb-jar.xml File for BEA WebLogic Server" on page 8-13.

toplink-ejb-jar.xml File

The toplink-ejb-jar.xml file is used only in CMP projects. The TopLink runtime
uses properties set in the <J2EE container>-ejb-jar.xml file (see
"<J2EE-Container>-ejb-jar.xml File" on page 8-5) to locate the
toplink-ejb-jar.xml file and read it in.
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Note: If you are using EJB 3.0, you can use annotations to specify
most of what you formerly specified in the toplink-ejb-jar.xml
file. To override annotations or specify options not supported by
annotations, you can still provide a toplink-ejb-jar.xml file in
your EJB 3.0 application. For more information on what annotations
are currently supported, see Oracle Containers for J2EE Enterprise
JavaBeans Developer’s Guide

The purpose of toplink-ejb-jar.xml file depends on the type of application
server you are using;:

= OC4] and the toplink-ejb-jar.xml File
= BEA WebLogic Server and the toplink-ejb-jar.xml File
= IBM WebSphere Application Server and the toplink-ejb-jar.xml File

0C4J and the toplink-ejb-jar.xml File

When deploying a CMP application to OC4J, the toplink-ejb-jar.xml file is the
name used for the project .xml file.

To create the toplink-ejb-jar.xml file in this case, simply rename your
project .xml file. For more information, see "project.xml File" on page 8-2.

BEA WebLogic Server and the toplink-ejb-jar.xml File

When deploying a CMP application to BEA WebLogic Server, the
toplink-ejb-jar.xml file contains a reference to the project .xml file.

Example 8-2 shows a typical BEA WebLogic Server toplink-ejb-jar.xml file:

Example 8-2 BEA WebLogic Server toplink-ejb-jar.xml File

<?xml version="1.0"?>
<!DOCTYPE toplink-ejb-jar PUBLIC "-//Oracle Corp.//DTD TopLink CMP WebLogic 10.0.3 Developer
Preview//EN" "toplink-wls-ejb-jar 10 0 3.dtd"s
<toplink-ejb-jar>
<session>
<name>ejb20_ EmployeeDemo</name>
<project-xml>Employee.xml</project-xml>
<login>
<datasource>jdbc/JTSTopLinkDS</datasource>
<non-jts-datasource>jdbc/TopLinkDS</non-jts-datasource>
</login>
<customization-class>
oracle.toplink.demos.ejb.cmp.wls.employee.EmployeeCustomizer
</customization-class>
</session>
</toplink-ejb-jars>

For BEA WegLogic Server, you can specify an optional deployment customization
class (that implements oracle.toplink.ejb.cmp.DeploymentCustomization
interface) used to allow deployment customization of TopLink mapping and run-time
configuration. In Example 8-2, the deployment customization class is named
EmployeeCustomizer. This deployment customization class must be fully qualified
by its package name and included in the deployment JAR.

At deployment time, the TopLink runtime creates a new instance of this class and
invokes its methods beforeLoginCustomization (before the TopLink runtime logs
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in to the session) and afterLoginCustomization (after the TopLink runtime logs
in to the session), passing in the TopLink session as a parameter.

Use your implementation of the beforeLoginCustomization method to configure
session attributes not supported by the pm-properties, including the following:

= cache coordination

= parameterized SQL

s native SQL

= batch writing /batch size

= byte-array/string binding
= EISlogin

= event listeners

= table qualifier

= sequencing

In Example 8-2, notice the <non-jts-datasource> element. The usage of this
element is not limited to BEA WebLogic Server toplink-ejb-jar.xml file. Any
time you use cache coordination with Java Transaction API (JTA), you need to
configure this element through TopLink Workbench (see "Configuring a
Nontransactional Read Login" on page 86-3). This enables TopLink to do the
out-of-context read operations and optimization of the sequencing assignments (see
"Externally Managed Transactional Data Sources" on page 81-1).

For more information about session configuration, see Chapter 74, "Configuring a
Session".

IBM WebSphere Application Server and the toplink-ejb-jar.xml File

When deploying a CMP application to IBM WebSphere application server, the
toplink-ejb-jar.xml file is the name used for the sessions.xml file and
contains a reference to the project .xml file.

To create the toplink-ejb-jar.xml file in this case, simply rename your
sessions.xml file. For more information, see "sessions.xml File" on page 8-4.

Java Applications

In a Java application, TopLink does not use a J2EE container for deployment. Instead,
it relies on TopLink mechanisms to provide functionality and persistence. The key
elements of this type of application are the lack of a J2EE container and the fact that
you deploy the application by placing the application JAR file on the classpath.

Java applications require the following deployment files:
= project.xml File

m  sessions.xml File

JavaServer Pages and Servlet Applications

Many designers build TopLink applications that use JavaServer Pages (JSP) and Java
servlets. This type of design generally supports Web-based applications.

JSP and servlet applications require the following deployment files:
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= project.xml File

s sessions.xml File

Session Bean Applications

Session beans generally model a process, operation, or service and as such, are not
persistent. You can build TopLink applications that wrap interaction with TopLink in
session beans. Session beans execute all TopLink-related operations on behalf of the
client.

This type of design uses JTS and externally managed transactions, but does not incur
the overhead associated with CMP applications. Session bean applications also scale
and deploy easily.

Session bean applications require the following deployment files:
= project.xml File

m sessions.xml File

CMP Applications

Many applications use the persistence mechanisms a J2EE container offers. TopLink
provides full support for this type of application.

You can only use one persistence manager for all the entity beans with
container-managed persistence in a JAR file.

CMP applications require the following deployment files:
= ejbjar.xml File
= <J2EE-Container>-ejb-jar.xml File

= toplink-ejb-jar.xml File

BMP Applications

If you choose to write your own persistence code with BMP, you can take advantage
of the classes in oracle.toplink.ejb.bmp package. Whether or not you use these
classes, BMP applications require the following deployment files:

= project.xml File
= sessions.xml File

= ejb-jar.xml File

Configuring the orion-ejb-jar.xml File for 0C4J

To deploy a TopLink application to OC4J 10g (10.1.3.1.0) or later, modify the
orion-ejb-jar.xml file as follows:

s Configuring persistence-manager Entries

If you are migrating an application from a previous release of OC4], you can use the
TopLink migration tool to automatically migrate persistence information from your
orion-ejb-jar.xml file to a new toplink-ejb-jar.xml. For more information,
see "Migrating OC4]J Orion Persistence to OC4] TopLink Persistence" on page 7-5.
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Configuring persistence-manager Entries

If you are using TopLink as your OC4] persistence manager, the default persistence
manager in 10g (10.1.3.1.0), you can configure the persistence-manager subentry
(see Table 8-2) in the orion-ejb-jar.xml file. For more information on the
scenarios in which you would want to modify orion-ejb-jar.xml, see "OC4J and
the orion-ejb-jar.xml File" on page 8-6.

If you are not using TopLink as your OC4] persistence manager, do not modify the
persistence-manager subentries.

0OC4] 10¢ (10.1.3.1.0) and later do not support ent ity-deployment attribute
pm-name. Use persistence-manager attribute name instead (see Table 8-2). When
OC4] parses the orion-ejb.jar.xml file, if it finds a pm-name attribute, OC4]
ignores its value and logs the following warning message:

WARNING: Use of pm-name is unsupported and will be removed
in a future release. Specify pm usage using
<persistence-managers> ‘'name’ instead.

Table 8-2 orion-ejb-jar.xml File persistence-manager Entries

Entry Description

name The name of the persistence manager to use. Set this value to toplink.

If you set the name property to toplink, you may also configure
pm-properties (see "Configuring pm-properties” on page 8-10).

class-name Do not configure this attribute. If name is set to toplink, then
class-name is set correctly by default.

descriptor This property applies only when name is set to toplink.

If you export your TopLink mapping metadata to a deployment XML file,
set this property to the name of the deployment XML file (default:
toplink-ejb-jar.xml).

Do not set this property if you are using a TopLink project class instead of
a mapping metadata file (see project-class in Table 8-3).

Configuring pm-properties

When you select TopLink as the persistence manager (see name in Table 8-2), use the
persistence-manager subentries for pm-properties (see Table 8-3) to configure
the TopLink session that the TopLink run time creates and uses internally for CMP
projects. The persistence-manager subentries take the place of a sessions.xml
file in a CMP project.

Note: You can only configure a subset of session features using
these properties and in most cases, default configuration applies. To
configure all session features and to override defaults, you must use a
customization class (see customization-class in Table 8-3).
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Table 8-3 orion-ejb-jar.xml File persistence-manager Subentries for pm-properties

Entry

Description

session-name

Unique name for this TopLink-persisted EJB deployment JAR file. Must be
unique among all TopLink-persisted deployed JAR files in this application
server instance.

When the TopLink run time internally creates a TopLink session for this
TopLink-persisted deployed JAR file, the TopLink session manager stores
the session instance under this session-name. For more information
about the session manager, see Chapter 75, "Acquiring and Using Sessions
at Run Time").

If you do not specify a name, the TopLink runtime will generate a unique
name.

project-class

If you export your TopLink mapping metadata to a Java class (that
extends oracle.toplink.sessions.Project), set this property to
the name of the class, fully qualified by its package name. Be sure to
include the class file in the deployable JAR file.

Do not set this property if you are using a mapping metadata file (see
descriptor in Table 8-2).

customization-class

Optional Java class (that implements
oracle.toplink.ejb.cmp.DeploymentCustomization) used to
allow deployment customization of TopLink mapping and run-time
configuration. At deployment time, the TopLink run time creates a new
instance of this class and invokes its methods
beforeLoginCustomization (before the TopLink run time logs into
the session) and afterLoginCustomization (after the TopLink
runtime logs into the session), passing in the TopLink session as a
parameter.

Use your implementation of the beforeLoginCustomization method
to configure session attributes not supported by the pm-properties
including: cache coordination (see also "Configuring
cache-synchronization Properties" on page 8-11), parameterized SQL,
native SQL, batch writing/batch size, byte-array/string binding, EIS
login, event listeners, table qualifier, and sequencing. For more
information about session configuration, see Chapter 74, "Configuring a
Session".

The class must be fully qualified by its package name and included in the
deployment JAR file.

db-platform-class

Optional TopLink database platform class (instance of
oracle.toplink.platform.database or
oracle.toplink.platform.database.oracle) containing TopLink
support specific to a particular database.

Set this value to the database platform class that corresponds to the
database that your application uses. The class must be fully qualified by
its package name.

remote-relationships

Optional flag to allow relationships between remote objects. Valid values
are:

= true: All relationships will be maintained through the remote
interfaces of the entity beans

. false: Disables this feature.

cache-synchronization

See "Configuring cache-synchronization Properties" on page 8-11.

default-mapping

See "Configuring default-mapping Properties" on page 8-12.

Configuring cache-synchronization Properties

When you select TopLink as the persistence manager (see name in Table 8-2), use the
pm-properties subentry for cache-synchronization (see Table 8—4) to
configure TopLink cache coordination features of the session that the TopLink run time
uses internally for CMP projects. For more information about TopLink cache
coordination, see "Understanding Cache Coordination" on page 87-10.

When this subentry is present, you must use a customization class (see
customization-class in Table 8-3) to complete cache coordination configuration.
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For more information about TopLink cache coordination configuration, see Chapter 88,
"Configuring a Coordinated Cache".

Table 8—-4 orion-ejb-jar.xml File pm-properties Subentries for cache-synchronization

Entry

Description

mode

An indicator of whether or not cache coordination updates should be propagated
to other servers synchronously or asynchronously. Valid values are as follows:

. asynchronous (default)

. synchronous

server-url

For a JMS coordinated cache: assuming that you are using the Oracle Application
Server Containers for J2EE (OC4J) JNDI naming service and that all the hosts in
your coordinated cache can communicate using OC4] proprietary RMI protocol
ORMI, use a URL like:

ormi://<JMS-host-IP>:<JMS-host-port>

where JMS-host - IP is the IP address of the host on which the JMS service
provider is running and JMS-host -port is the port on which the JMS service
provider is listening for JMS requests.

For an RMI or CORBA coordinated cache: assuming that you are using the OC4]
JNDI naming service and that all the hosts in your coordinated cache can
communicate using OC4J proprietary RMI protocol ORMI on OC4] default port
23791, use a URL like:

ormi://<session-host-IP>:23791

where session-host-IP is the IP address of the host on which this session is
deployed.

Server-user

Optional username required to log in to the J]NDI naming service.

Configuring default-mapping Properties

When you select TopLink as the persistence manager (see name in Table 8-2), use the
pm-properties subentry for default-mapping (see Table 8-5) to configure the
TopLink default mapping and automatic table generation feature.

For more information about TopLink default mappings, see "Default Mapping in CMP
Projects Using OC4] at Run Time" on page 30-4.

For more information about TopLink automatic table generation, see "Automatic
Database Table Creation" on page 5-6.

8-12 Oracle TopLink Developer’s Guide



Configuring the weblogic-ejb-jar.xml File for BEA WebLogic Server

Table 8-5 orion-ejb-jar.xml File pm-properties Subentries for default-mapping

Entry Description

db-table-gen Optional element that determines what TopLink will do to prepare the
database tables that are being mapped to. Valid values are:

= Create (default): This value tells TopLink to create the mapped
tables during the deployment. If the tables already exist, TopLink
will log an appropriate warning messages (such as "Table already
existed...") and keeps processing the deployment.

=  DropAndCreate: This value tells TopLink to drop tables before
creating them during deployment. If a table does not initially exist,
the drop operation will cause anSQLException to be thrown through
the driver. However, TopLink handles the exception (logs and
ignores it) and moves on to process the table creation operation. The
deployment fails only if both drop and create operations fail.

=  UseExisting: This value tells TopLink to perform no table
manipulation. If the tables do not exist, deployment still goes
through without error.

If no orion-ejb-jar.xml file is defined in your EAR file, the OC4J
container generates one during deployment. In this case, to specify a value
for db-table-gen, use the TopLink system property
toplink.defaultmapping.dbTableGenSetting. For example:
-Dtoplink.defaultmapping.dbTableGenSetting="DropAndCre
ate".

The orion-ejb-jar.xml property overrides the system property. If
both the orion-ejb-jar.xml property and the system property are
present, TopLink retrieves the setting from the orion-ejb-jar.xml file.

This setting overrides autocreate-tables and autodelete-tables
configuration at the application (EAR) or system level. For more
information, see "Automatic Database Table Creation" on page 5-6.

extended-table-names An element used if the generated table names are not long enough to be
unique. Values are restricted to true or false (default). When set to
true, the TopLink run time will ensure that generated tables names are
unique.

In default mapping, each entity is mapped to one table. The only
exception is in many-to-many mappings where there is one extra relation
table involved in the source and target entities.

When extended-table-names is set to false (the default), a simple
table naming algorithm is used as follows: table names are defined as TL_
<bean_names. For example, if the bean name is Employee, the
associated table name would be TL._EMPLOYEE.

However, if the same entity is defined in multiple JAR files in an
application, or across multiple applications, table-naming collision is
inevitable.

To address this problem, set extended-table-names to true. When
set to true, TopLink uses an alternative table-naming algorithm as
follows: table names are defined as <bean name> <jar name>_ <app
name>. This algorithm uses the combination of bean, JAR, and EAR
names to form a table name unique across the application. For example,
given a bean named Employee, which is in Test . jar, which is in
Demo. ear (and the application name is "Demo"), then the corresponding
table name will be EMPLOYEE_TEST DEMO.

If there isno orion-ejb-jar.xml file defined in the EAR file, the OC4]
container generates one during deployment. In this case, to specify a value
for extended-table-names, use the TopLink system property
toplink.defaultmapping.useExtendedTableNames. For example:
-Dtoplink.defaultmapping.useExtendedTableNames="true".

The orion-ejb-jar.xml property overrides the system property. If
both the orion-ejb-jar.xml property and the system property are
present, TopLink retrieves the setting from the orion-ejb-jar.xml file.

Configuring the weblogic-ejb-jar.xml File for BEA WebLogic Server

To deploy a TopLink application to a BEA WebLogic Server, modify the
weblogic-ejb-jar.xml file as described in:
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s Configuring persistence-descriptor Entries

Avoid the weblogic-ejb-jar.xml tags that TopLink either does not support or
does not require (see "Unsupported weblogic-ejb-jar.xml File Tags" on page 8-15).

If you are migrating a BEA WEbLogic Server application to OC4]J, you can use the
TopLink migration tool to automatically migrate persistence information from your
weblogic-ejb-jar.xml file to a new toplink-ejb-jar.xml file. For more
information, see "Migrating BEA WebLogic Persistence to OC4J TopLink Persistence'
on page 7-16.

1

Configuring persistence-descriptor Entries

Within the weblogic-ejb-jar.xml file, each bean must have a
persistence-descriptor entry with subentries, as follows:

= Configure the persistence-descriptor entry with subentries that indicate
TopLink is available and should be used:

- If you deploy to WebLogic 6.1 (Service Pack 4), include a
persistence-type element and a persistence-use element. Both
elements require a type-identifier and a type-version tag. Table 8-6
lists the options for the type-identifier tag, and Table 8-7 lists the options
for the type-version tag.

- If you deploy to WebLogic 7.0 or 8.1, include a persistence-use element
with a type-identifier and a type-version tag. Table 8-6 lists the
options for the type-identifier tag, and Table 8-7 lists the options for the
type-version tag.

s If you use WebLogic 6.1, add the element type-storage to the
persistence-type element, and set it to META-INF\toplink-ejb-jar.xml.

s If you use WebLogic 7.0 or 8.1, add the element type-storage to the persistence-use
element, and set it to META-INF\toplink-ejb-jar.xml.

s Setthe enable-call-by-reference element to TRUE to enable
call-by-reference:

<weblogic-enterprise-bean>
<ejb-name>AccountBean</ejb-name>

<enable-call-by-reference>True</enable-call-by-reference>

</weblogic-enterprise-beans

Table 8-6 WebLogic type-identifier Settings
EJB Version XML Elements

2.0 <type-identifier>TopLink CMP_2 O</type-identifiers>

Table 8-7 WebLogic type-version Settings

WebLogic EJB Version XML Elements

6.1 <type-version>4.0</type-versions>
7.0 <type-version>4.5</type-version>
8.1 <type-version>9.0.4</type-version>
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Unsupported weblogic-ejb-jar.xml File Tags

The weblogic-ejb-jar.xml file includes several tags that TopLink either does not
support or does not require:

concurrency-strategy: This tag specifies how WebLogic manages concurrent
users for a given bean. Because TopLink manages concurrent access internally, it
does not require this tag.

For more information about the TopLink concurrency strategy, see "Configuring
Locking Policy" on page 25-64.

db-is-shared: Because TopLink does not make any assumptions about the
exclusivity of database access, TopLink does not require this tag. TopLink
addresses multiuser access issues through various locking and refreshing policies.

delay-updates-until-end-of-tx: TopLink always delays updates until the
end of a transaction, and does not require this tag.

finders-load-bean: TopLink always loads the bean upon execution of the
finder, and does not require this tag.

pool: TopLink does not use a pooling strategy for entity beans. This avoids
object-identity problems that can occur due to pooling.

lifecycle: This element manages beans that follow a pooling strategy. Because
TopLink does not use a pooling strategy, TopLink ignores this tag.

is-modified-method-name: TopLink does not require a bean
developer-defined method to detect changes in the object state.

isolation-level: Because isolation level settings for the cache or database
transactions are specified in the TopLink project, TopLink ignores this tag.

cache: Because you define TopLink cache properties in TopLink Workbench, this
tag is unnecessary.
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Packaging a TopLink Application

How you package the components of your application depends on the type of
application and how you plan to deploy it.

This section describes TopLink-specific details applicable to the common packaging
strategies used for the following types of application:

= Java Applications
= JavaServer Pages and Servlet Applications

= Session Bean Applications

CMP Applications

BMP Applications

Note: If you are using EJB 3.0, you may be using annotations instead
of some deployment files. Include deployment descriptors to override
annotations or specify options not supported by annotations.

For information, see the following:

» 'Integrating TopLink With an Application Server" on page 7-1
s "Creating TopLink Files for Deployment" on page 8-1

s "Deploying a TopLink Application" on page 10-1

Java Applications

For non-J2EE Java applications, it is common to package the application in a single
JAR file as Figure 9-1 shows.

Figure 9—1 Packaging a non-J2EE Java Application

domain_module.jar
Java classes that represent the objects mapped
project.xml
session.xml
META-INF
Manifest.mf

This JAR contains the TopLink files and domain objects required by the application,
including:
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s sessions.xml File

s project.xml File (or the compiled project class file if you are not using XML files for
deployment)

= The mapped classes required by the application, in a fully-resolved directory
structure

When you create the JAR file, the JAR building utility automatically creates a directory
structure within the JAR. Ensure that the sessions.xml file and the project .xml
file (or project class file) appear at the root of the JAR file. Ensure that the class
directory structure starts at the root of the JAR.

If you do not store the project .xml or sessions.xml files at the root of the JAR
file, see "Packaging With TopLink Metadata File Resource Paths" on page 9-7.

JavaServer Pages and Servlet Applications

For simple J2EE applications without EJB, it is common to package the application in
an Enterprise Archive (EAR) file made up of various J2EE application component
archives as Figure 9-2 shows.

Figure 9-2 Packaging a J2EE JSP or Servilet Application Without EJB

appname.ear
META-INF
application.xml
orion-application.xml
domain_module.jar
Java classes that represent the objects mapped
projectxml
session.xml
META-INF
Manifest.mf
web_module.war
html pages, JSP's, etc.
META-INF
web.xml|
orion-web.xml|
classes
serviet classes
lib
client_module.jar
Client classes
META-INF
application-client.xml
orion-application-client.xml

The component archives with TopLink dependencies include the following:

»  TopLink Domain JAR

TopLink Domain JAR

The domain JAR contains the TopLink files and domain objects required by the
application, including;:

m  sessions.xml File

= project.xml File (or the compiled Project class file, if you are not using XML files
for deployment)
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=  The mapped classes required by the application, in a fully resolved directory
structure

When you create the JAR file, the JAR building utility automatically creates a directory
structure within the JAR. Ensure that the sessions.xml file and the project .xml
file (or project . class file) appear at the root of the JAR file. Also ensure that the
class directory structure starts at the root of the JAR.

If you do not store the project .xml or sessions.xml files at the root of the JAR
file, see "Packaging With TopLink Metadata File Resource Paths" on page 9-7.

Session Bean Applications

For J2EE applications with session beans, it is common to package the application in
an Enterprise Archive (EAR) file made up of various J2EE application component
archives as Figure 9-3 shows.

Figure 9-3 Packaging a J2EE Application With Session Beans

appname.ear
META-INF
application.xml
orion-application.xml
ejb_module_Xjar
EJB classes - session and non-entity beans
META-INF
ejb-jarxml
orion-ejb-jarxml - no persistence-manager subentries
domain_modulejar
Java classes that represent the objects mapped
projectxml
session.xml
META-INF
Manifest.mf
web_module.war
html pages, JSP's, etc.
META-INF
web.xml
orion-web.xml
classes
servlet classes
lib
client_module jar
Client classes
META-INF
application-client.xml
orion-application-client.xml

The component archives with TopLink dependencies include the following:
s TopLink Domain JAR
» EJBJAR

TopLink Domain JAR

The domain JAR contains the TopLink files and domain objects required by the
application, including the following:

s sessions.xml File

= project.xml File (or the compiled project.class file if you are not using XML files for
deployment)
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EJB JAR

= The mapped classes required by the application, in a fully-resolved directory
structure

When you create the JAR file, the JAR building utility automatically creates a directory
structure within the JAR. Ensure that the sessions.xml file and the project .xml
file (or project.class file) appear at the root of the JAR file. Also ensure that the
class directory structure starts at the root of the JAR.

If you do not store the project .xml or sessions.xml files at the root of the JAR
file, see "Packaging With TopLink Metadata File Resource Paths" on page 9-7.

In this type of application, the EJB JAR contains session beans. Consequently, its
orion-ejb-jar.xml file does not contain persistence-manager or
pm-properties entries. These entries apply only to CMP applications.

CMP Applications

For J2EE applications that use CMP to persist entity beans, it is common to package
the application in an Enterprise Archive (EAR) file made up of various J2EE
application component archives as Figure 9-4 shows.

Figure 9-4 Packaging a J2EE Application With Entity Beans With Container-Managed
Persistence

appname.ear
META-INF
applicationxml
orion-application.xml
cmp_ejb_module_1 jar
EJB classes - cmp entity beans
META-INF
ejb-jarxml
orion-ejb-jarxml - includes persistence-manager properties
toplink-ejb-jar.xml
ejb_module_Xjar
EJB classes - non-entity beans
META-INF
ejb-jarxml
orion-ejb-jarxml - no persistence-manager subentries
web_module.war
html pages, J5P's, etc.
META-INF
web.xml
orion-web.xml
classes
servlet classes
lib
client_module,jar
Client classes
META-INF
application-client.xml
orion-application-client.xml

The component archives with TopLink dependencies include the following:
= EJBJAR
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EJB JAR

In this type of application, the EJB JAR file specifically service both non-entity and
entity EJB. It includes the following:

s The home and remote, and all implementation code for all mapped beans in the
application.

= All mapped non-EJB classes from the TopLink Workbench project

s The home and remote, and all implementation code for any session beans
included in the application.

= Helper classes that contain TopLink amendment methods, and any other classes
the application requires.

For example, an instance of
oracle.toplink.ejb.cmp.DeploymentCustomization (for more
information, see customization-class in Table 8-3 in "Configuring
persistence-manager Entries" on page 8-10).

Store the following XML files in the E]B JAR \meta-inf directory:
= ejb-jar.xml File
= <J2EE-Container>-ejb-jar.xml File

= toplink-ejb-jar.xml File

Note: If you do not use XML files for deployment, include your
compiled oracle.toplink.sessions.Project file at the root of
the EJB JAR (not in the \meta-inf directory).

Because the E]JB JAR contains both session and entity beans, if you are using OC4]J or
BEA WebLogic (WLS), the <J2EE-Container>-ejb-jar.xml file must contain
persistence-manager and pm-properties entries. For more information, see
"Configuring persistence-manager Entries" on page 8-10.

You must persist all of the entity beans to the same data source. For a CMP
application, TopLink does not support the session broker functionality (see "Session
Broker and Client Sessions" on page 72-26).

BMP Applications

For J2EE applications that use BMP to persist entity beans, it is common to package the
application in an Enterprise Archive (EAR) file made up of various J2EE application
component archives as Figure 9-5 shows.
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Figure 9-5 Packaging a J2EE Application With Entity Beans With Bean-Managed
Persistence

appname.ear
META-INF
application.xml
orion-application.xml
bmp_gjb_module_1.jar
EJB classes - bmp entity beans
META-INF
ejb-jarxml
orion-ejb-jarxml - includes persistence-manager properties
toplink-ejb-jar.xml
ejb_module_X jar
EJB classes - non-entity beans
META-INF
ejb-jarxml
orion-ejb-jar.xml - no persistence-manager subentries
domain_module.jar
Java classes that represent the objects mapped
projectxml
session.xml
META-INF
Manifest.mf
web_module.war
html pages, JSP's, etc.
META-INF
web.xml
orion-web.xml
classes
servlet classes
lib
client_module.jar
Client classes
META-INF
application-client.xml
orion-application-client.xml

The component archives with TopLink dependencies include the following:
s TopLink Domain JAR
= EJBJAR

TopLink Domain JAR

The domain JAR contains the TopLink files and domain objects required by the
application, including the following:

m  sessions.xml File

= project.xml File (or the compiled project.class file if you are not using XML files for
deployment)

= The mapped classes required by the application, in a fully resolved directory
structure

When you create the JAR file, the JAR building utility automatically creates a directory
structure within the JAR. Ensure that the sessions.xml file and the project .xml
file (or project.class file) appear at the root of the JAR file. Also ensure that the
class directory structure starts at the root of the JAR.

If you do not store the project .xml or sessions.xml files at the root of the JAR
file, see "Packaging With TopLink Metadata File Resource Paths" on page 9-7.
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EJB JAR

In this type of application, the EJB JAR file specifically services both session and entity
beans. It includes the following:

s The home and remote, and all implementation code for all mapped beans in the
application

= All mapped non-EJB classes from the TopLink Workbench project

s The home and remote, and all implementation code for any session beans
included in the application

= Helper classes that contain TopLink amendment methods, and any other classes
the application requires

Store the following XML files in the E]B JAR \meta-inf directory:
= ejb-jar.xml File
= <J2EE-Container>-ejb-jar.xml File

Because the E]JB JAR does not contain entity beans with container-managed
persistence, its orion-ejb-jar.xml file must not contain persistence-manager
or pm-properties entries.

For more information, see "Configuring persistence-manager Entries" on page 8-10.

Packaging With TopLink Metadata File Resource Paths

If you do not store the project .xml or sessions.xml files at the root of the JAR
file, then you must provide the full resource path to the files when accessing them.
Ensure that you use "/" in resources paths, not "\". Using "\" will not work in Java.

For example, in the jar element, reference the project .xml and sessions.xml
files as follows:

<jar>/myapp/ordersys/persist/sessions.xml
<jar>/myapp/ordersys/persist/project.xml
In the sessions.xml file, reference the project .xml as follows:

myapp/ordersys/persist/project.xml

To acquire the session, use the following:

SessionManager.getManager () .getSession (
new XMLSessionConfigLoader ("myapp/ordersys/persist/sessions.xml"),
"OrdersysSession",
getClass () .getClassLoader ()

)i

For more information about acquiring sessions at run time, see "Acquiring a Session
From the Session Manager" on page 75-3.
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Deploying a TopLink Application

This chapter includes deployment information on the following TopLink applications:

Java Applications

» JavaServer Pages and Servlets

= Session Bean Applications

= CMP Applications

= BMP Applications

For more information, see the following:

» 'Integrating TopLink With an Application Server" on page 7-1
s "Creating TopLink Files for Deployment" on page 8-1

» '"Packaging a TopLink Application" on page 9-1

Java Applications
Build the JAR file (see "Java Applications" on page 9-1) and place it on the classpath.

For more information on accessing TopLink from your client application, see
Chapter 75, "Acquiring and Using Sessions at Run Time".

JavaServer Pages and Servlets

After you build the WAR and JAR files (see "JavaServer Pages and Servlet
Applications" on page 9-2), build them into an EAR file for deployment. To deploy the
EAR to your JSP servlet server, copy the EAR to a commonly used directory. You may
also need to use server-specific deployment tools. For more information, see the server
documentation.

For more information on accessing TopLink from your client application, see "Loading
a Session From sessions.xml With an Alternative Class Loader" on page 75-4.

Session Bean Applications

After you build the WAR and JAR files (see "Session Bean Applications" on page 9-3),
build them into an EAR file for deployment. To deploy the EAR file to your J2EE
server, copy the EAR to a commonly used directory. You may also need to use
server-specific deployment tools. For more information, see the server documentation.

For more information on accessing TopLink from your client application, see "Loading
a Session From sessions.xml With an Alternative Class Loader" on page 75-4.
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Optionally, you may also consider "Hot Deployment of EJB" on page 10-4.

CMP Applications

After you build the WAR and JAR files (see "CMP Applications" on page 9-4), build
them into an EAR file for deployment. To deploy the EAR file to your J2EE server,
copy the EAR to a commonly used directory. You may also need to use server-specific
deployment tools. For more information, see the server documentation.

This section describes the following:

= Deploying a CMP Application to OC4]J

= Deploying a CMP Application to BEA WebLogic Server

= Deploying a CMP Application to IBM WebSphere Application Server 4.0

For additional information on server-specific configuration, see Chapter 7, "Integrating
TopLink With an Application Server".

Optionally, you may also consider "Hot Deployment of EJB" on page 10-4.

Deploying a CMP Application to OC4J

The most efficient way to deploy a CMP application to OC4] is using Oracle Enterprise
Manager 10g. For more information, see Oracle Application Server Administrator’s Guide.

When you deploy a CMP application to OC4J, the following happens:

s OC4] performs a partial EJB conformance check on the beans and their associated
interfaces.

= OC4] builds the internal OC4]J classes that manage security and transactions, as
well as the RMI stubs and skeletons that enable client access to the beans.

s TopLink builds concrete bean subclasses and EJB finder method implementations.

Deploying a CMP Application to BEA WebLogic Server

TopLink CMP support includes integration for BEA WebLogic Server. To enable
TopLink CMP for BEA WebLogic entity beans, use the WebLogic EJB Compiler (ejbc)
to compile the EJB JAR file, as follows:

= Run ejbc from the command line. Include the EJB JAR file as a command line
argument. ejbc creates an EJB JAR file that contains the original classes as well as
all required generated classes and files.

When you run ejbc, the following happens:

= ejbc performs a partial EJB conformance check on the beans and their associated
interfaces.

= ejbc builds the internal BEA WebLogic classes that manage security and
transactions, as well as the RMI stubs and skeletons that enable client access to the
beans.

s TopLink builds concrete bean subclasses and EJB finder method implementations.

For more information about running ejbc, see the BEA WebLogic Server
documentation.
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Troubleshooting ejbc

When you start ejbc, it processes the data in a series of stages. If errors occur while
running ejbc, attempt to determine which stage causes the problem. Common
problems include the following;:

= Bean classes that do not conform with the EJB specification

»  Classes missing from the classpath (all domain classes, required TopLink classes,
and all required BEA WebLogic classes must be on the classpath)

= Java compiler (javac) problems, often caused by using an incorrect version of the
JDK

= A failure when generating the RMI stubs and skeletons (a failure of RMI compiler
(rmic))

Refer to Chapter 15, "Troubleshooting Application Deployment" for additional
information.

Deploying a CMP Application to IBM WebSphere Application Server 4.0

TopLink CMP support includes an integration for IBM WebSphere application server
4.0. Use the following procedure to deploy your application to WebSphere applicaton
server:

1. Use the TopLink Deploy Tool for WebSphere to compile the EJB JAR file. For more
information, see "Using the WebSphere Deploy Tool" on page 10-5.

2. Start the WebSphere Administration Server.
3. Start the Administration Console and deploy the compiled JAR file.

For more information about deploying the JAR file, see the IBM WebSphere
application server documentation.

Note: When you deploy an application that contains an entity bean,
set up a data source and associate it with the bean. For more
information about how to create and associate data sources, see the
IBM WebSphere application server documentation.

It is not necessary to deploy the EJB JAR file in WebSphere Studio Application
Developer (WSAD), because deployment is carried out using the Deploy Tool (see
"Using the WebSphere Deploy Tool" on page 10-5).

Starting the Entity Bean
You can start the bean in either the WebSphere application server or in WSAD.

To start the bean in IBM WebSphere application server, do the following:
1. Select the application that contains the entity beans.
2. Right-click and choose Start.

A message dialog box appears if the bean starts successfully. If an error occurs, consult
Part V, "Troubleshooting a TopLink Application” for troubleshooting information.

To start the bean in WSAD, do the following:
1. Right-click the EJB project, and choose Run on Server.

2. To view the status of the process, open the Console tab of the Server view.
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BMP Applications

After you build the WAR and JAR files, build them into an EAR file for deployment.
To deploy the EAR file to your J2EE server, copy the EAR to a commonly used
directory. You may also need to use server-specific deployment tools. For more
information, see the server documentation.

For additional information on server-specific configuration, see Chapter 7, "Integrating
TopLink With an Application Server".

Optionally, you may also consider "Hot Deployment of EJB" on page 10-4.

Hot Deployment of EJB

Many J2EE containers support hot deployment, a feature that enables you to deploy EJB
on a running server. Hot deployment allows you to do the following;:

= Deploy newly developed EJB to a running production system.
= Remove (undeploy) deployed EJB from a running server.

= Modify (redeploy) the behavior of deployed EJB by updating the bean class
definition.

The client receives deployment exceptions when attempting to access undeployed or
re-deployed bean instances. The client application must catch and handle the
exceptions.

How you configure hot deployment of EJB depends on the type of J2EE application
you are deploying;:

= Hot Deployment in a CMP Application

= Hot Deployment in a non-CMP Application

For more information about hot deployment, see the J2EE container documentation.

Hot Deployment in a CMP Application

When you take advantage of hot deployment in a CMP application, consider the
following:

= You must deploy all related beans (all beans that share a common TopLink
project) within the same EJB JAR file. Because TopLink views deployment on a
project level, deploy all the project beans (rather than just a portion of them) to
maintain consistency across the project.

= When you redeploy a bean, you automatically reset its TopLink project. This
flushes all object caches and rolls back any active object transactions associated
with the project.

Hot Deployment in a non-CMP Application

When you take advantage of hot deployment in a non-CMP application, you must
refresh the TopLink session using the SessionManager method getSession with
the appropriate arguments (see "Refreshing a Session When the Class Loader
Changes" on page 75-6.

If you do not use this SessionManager method, then your application is responsible
for destroying or refreshing the session when a hot deployment (or hot redeployment)
occurs.
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Using the WebSphere Deploy Tool

TopLink integration for IBM WebSphere application server includes a deployment
tool that helps you deploy your projects to WebSphere. The Deploy Tool for
WebSphere is a graphical tool that makes project deployment to WebSphere easier to
configure and execute. The Deploy Tool also includes a command-line option that lets
you deploy your project while bypassing the graphical interface element of the tool.

You can use the Deploy Tool on its own (see "Using the Deploy Tool on its Own" on
page 10-5) or with the WebSphere Studio Application Developer (see "Using the
Deploy Tool With WebSphere Studio Application Developer" on page 10-5).

Using the Deploy Tool on its Own
To deploy a JAR file, use this procedure:

1. Start the WebSphere Deploy Tool by executing the appropriate < TOPLINK
HOME>/bin/wasDeployTool script: on Windows, execute
wasDeployTool . cmd; on UNIX, execute wasDeployTool . sh.

The WebSphere Deploy Tool dialog box appears (see Figure 10-1).

Figure 10-1 The Deploy Tool Set Up for Use with WSAD

EBE

Source EJB Jar File: |C:IEJEIJarSLAccountEJEI.jar | = Open

File

Deploy EJB Jar File: |C:IE.JEI.JarSIDepIoyedAccountEJEl.jar | = Open
Working Directonys: |C:1temp | = Open

e Home: |C:1Pr0gram Filesiibrmiapplication DeveI0penpIugins\c0m.ibm.etools.websphere.runtirﬂ = Open |

WehSphere JDK Home: |C:1Pr0gram FilesiibrmApplication Developenpluginsicam.ibm.etools server jdk | D"'Open

Classpath: |C:1Pr0gram Filesiibrmiapplication DevelopenpluginSlc0m.ibm.etools.webSphere.runtime‘tliblappltoplink.]

[v] Copy generated source to directory. (Useful for copying into WSAD project working directory.)

Copy generated source to: |C:1Pr0gram FilelihmiApplication DevelopmentAccountProjectiejbhaodule | = Open

[_] AnalyzeMferify enterprise beans only [_] Don't deploy if EJB .jar already deployed
[_] Generate EJB server implementation classes only [_] Don't compress deployed jar file

[_] lgnore verification errors [_] Skip RMIC stubsities generation

[_] Preserve the working directory and generated classes [¥] Turn on tracing

[_] Options for the Java WM use to invoke the RMIC compiler:

% Deploy EJB Jar

2. Enable the Copy generated source to directory option to save a copy of the
generated code in the specified directory. This is a quick and efficient way to copy
the files into a WSAD project working directory.

3. Enable the Turn on tracing option if you want to see the details of the process.

4. Click Deploy EJB.

Using the Deploy Tool With WebSphere Studio Application Developer
The Deploy tool is compatible with the WSAD.
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To deploy from the Deploy Tool to WSAD, do the following:

1.
2.

Select the E]B Project in WSAD and choose to generate Deploy and RMIC Code.

Export the EJB Project to an EJB JAR file, making sure that the TopLink project and
toplink-ejb-jar.xml files are included in the EJB JAR file.

Start the WebSphere Deploy Tool by executing the appropriate < TOPLINK
HOME>/bin/wasDeployTool script: on Windows, execute
wasDeployTool. cmd; on UNIX, execute wasDeployTool. sh.

The WebSphere Deploy Tool dialog appears (see Figure 10-1).

Choose the E]B Project working directory so that TopLink overrides the WSAD
deploy code with the TopLink deploy code.

If the source is copied to a directory other than the WSAD EJB Project directory,
manually copy the source files to the WSAD E]B Project under the ejpModule
directory of the project.

Enter appropriate directories in the fields of the Deploy Tool.
Choose Deploy EJB JAR to create the deployed EJB JAR file.

Choose Rebuild all from the Project menu to compile the deploy code to
incorporate CMP.

Troubleshooting

The most common error you might encounter when you use the Deploy Tool is the
NoClassDefFoundError exception. To resolve this error condition, add the required
resources to the Classpath. The Turn on tracing option also helps to debug errors
during deployment code generation.

When an obscure error appears during the generating stub phase, copy the Java
command and run it at the command prompt. This gives a more detailed error
message.

See Chapter 7, "Integrating TopLink With an Application Server" for additional
information.
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Part IV

Optimizing and Customizing a TopLink

Application

This part describes how to optimize and customize a TopLink application. It contains
the following chapters.

Chapter 11, "Optimization"

This chapter contains information on the diverse set of features TopLink provides
to optimize performance.

Chapter 12, "Customization"

This chapter describes how to customize various aspects of TopLink, based on
your application’s specific needs.
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Optimization

TopLink provides a diverse set of features to measure and optimize application
performance. You can enable or disable most features in the descriptors or session,
making any resulting performance gains global.

This chapter includes the following sections:

= Understanding Optimization

= Sources of Application Performance Problems

= Measuring TopLink Performance With the TopLink Profiler

= Measuring TopLink Performance With the Oracle
Dynamic Monitoring System (DMS)

Understanding Optimization

Performance considerations are present at every step of the development cycle.
Although this implies an awareness of performance issues in your design and
implementation, it does not mean that you should expect to achieve the best possible
performance in your first pass.

For example, if optimization complicates the design, leave it until the final
development phase. You should still plan for these optimizations from your first
iteration, to make them easier to integrate later.

The most important concept associated with tuning your TopLink application is the
idea of an iterative approach. The most effective way to tune your application is to do
the following:

1. Measure application performance using the TopLink profiler (see "Measuring
TopLink Performance With the TopLink Profiler" on page 11-2) or the Oracle
Dynamic Monitoring System (DMS) profiler (see "Measuring TopLink
Performance With the Oracle Dynamic Monitoring System (DMS)" on page 11-4)

2. Modify application components (see "Sources of Application Performance
Problems")

3. Measure performance again.

To identify the changes that improve your application performance, modify only one
or two components at a time. You should also tune your application in a
nonproduction environment before you deploy the application.

Optimization 11-1



Sources of Application Performance Problems

Sources of Application Performance Problems

For various parts of a TopLink enabled application, this section describes the
performance problems most commonly encountered and provides suggestions for
improving performance. Areas of an application where performance problems can
occur include:

= General Performance Optimization

= Schema Optimization

= Mapping and Descriptor Optimization
= Session Optimization

s Cache Optimization

s Data Access Optimization

s Query Optimization

= Unit of Work Optimization

= Application Server and Database Optimization

Measuring TopLink Performance With the TopLink Profiler

The most important challenge to performance tuning is knowing what to optimize. To
improve the performance of your application, identify the areas of your application
that do not operate at peak efficiency. The TopLink performance profiler helps you
identify performance problems by logging performance statistics for every executed
query in a given session.

Note: You should also consider using general performance profilers
such as JDeveloper or JProbe to analyze performance problems. These
tools can provide more detail that may be required to properly
diagnose a problem.

The TopLink performance Profiler logs the following information to the TopLink log
file (for general information about TopLink logging, see "Logging" on page 72-7):

= Query class

= Domain class

= Total time, total execution time of the query (in milliseconds)

= Local time, the amount of time spent on the user’s workstation (in milliseconds)
= Number of objects, the total number of objects affected

= Number of objects handled per second

= Logging, the amount of time spent printing logging messages (in milliseconds)

= SQL prepare, the amount of time spent preparing the SQL script (in milliseconds)
= SQL execute, the amount of time spent executing the SQL script (in milliseconds)

= Row fetch, the amount of time spent fetching rows from the database (in
milliseconds)

»  Cache, the amount of time spent searching or updating the object cache (in
milliseconds)
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s Object build, the amount of time spent building the domain object (in
milliseconds)

= Query prepare, the amount of time spent to prepare the query prior to execution
(in milliseconds)

= SQL generation, the amount of time spent to generate the SQL script before it is
sent to the database (in milliseconds)

This section includes information on the following topics:
s Configuring the TopLink Performance Profiler

= Accessing the TopLink Profiler Results

Configuring the TopLink Performance Profiler

To enable the TopLink performance profiler, select the TopLink profiler option when
configuring your session (see "Configuring a Performance Profiler" on page 74-10).

The TopLink performance profiler is an instance of
oracle.toplink.tools.profiler.PerformanceProfiler class. It provides
the following public API:

s logProfile—enables the profiler
s dontLogProfile-disables the profiler

s logProfileSummary-organizes the profiler log into a summary of all the
individual operation profiles including operation statistics like the shortest time of
all the operations that were profiled, the total time of all the operations, the
number of objects returned by profiled queries, and the total time that was spent
in each kind of operation that was profiled.

» logProfileSummaryByQuery—organizes the profiler log as query summaries.
This is the default profiler behavior.

s logProfileSummaryByClass—organizes the profiler log as class summaries.
This is an alternative to the default behavior implemented by
logProfileSummaryByQuery method.

Accessing the TopLink Profiler Results

The simplest way to view TopLink profiler results is to read the TopLink log files with
a text editor. For general information about TopLink logging, such as logging file
location, see "Logging" on page 72-7.

Alternatively, you can use the graphical performance profiler that the TopLink Web
client provides. For more information, refer to the Web client online Help and
READMEE files.

Example 11-1 shows an example of the TopLink profiler output.

Example 11-1 Performance Profiler Output

Begin Profile of{

ReadAllQuery (oracle.toplink.demos.employee.domain.Employee)

Profile (ReadAllQuery,# of obj=12, time=1399,sql execute=217, prepare=495, row
fetch=390, time/obj=116,0bj/sec=8)

} End Profile

The second line of the profile contains the following information about a query:
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m ReadAllQuery(oracle.toplink.demos.employee.domain.Employee):
specific query profiled, and its arguments.

s Profile (ReadAllQuery: start of the profile and the type of query.
s # of obj=12:number of objects involved in the query.

= time=1399: total execution time of the query (in milliseconds).

s sgl execute=217: total time spent preparing the SQL script.

s prepare=495: total time spent preparing the SQL script.

s row fetch=390: total time spent fetching rows from the database.
s time/obj=116:number of milliseconds spent on each object.

m obj/sec=8) */:number of objects handled per second.

Measuring TopLink Performance With the Oracle
Dynamic Monitoring System (DMS)

Oracle DMS is a library that enables application and system developers to use a
variety of DMS sensors to measure and export customized performance metrics for
specific software components (called nouns).

TopLink includes DMS instrumentation in essential objects to provide efficient
monitoring of run-time data in TopLink-enabled applications, including both J2EE and
non-J2EE applications.

By enabling DMS profiling in a TopLink application (see "Configuring the Oracle DMS
Profiler" on page 11-6), you can collect and easily access run-time data that can help
you with application administration tasks and performance tuning.

Note: You should also consider using general performance profilers
such as JDeveloper or JProbe to analyze performance problems. These
tools can provide more detail that may be required to properly
diagnose a problem.

Table 11-1 lists the many performance and status metrics TopLink provides through
DMS.

Table 11-2 lists the various profiling levels you can use to adjust the level of profiling
to the amount of monitoring information you require. Levels are listed in order of
increasing system overhead.

You can easily access DMS data at run time using a management application that
supports the Java Management Extensions (JMX) API (see "Accessing Oracle DMS
Profiler Data Using J]MX" on page 11-7) or using any Web browser and the DMS Spy
servlet (see "Accessing Oracle DMS Profiler Data Using the DMS Spy Servlet" on
page 11-7).
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Table 11-1  TopLink DMS Metrics

DMS Noun Name'  Sensor Name Level?  Description

Cache CacheHits HEAVY  Number of times an object looked up in the cache
was found.

CacheMisses HEAVY  Number of times an object looked up in the cache
was not found.

Caching ALL Time spent adding, looking up, and removing
objects in the cache.

rRCM3 ChangesNotProcessed ALL Number of coordinated cache
ObjectChangeSets discarded because the object
was not found in the cache and was not merged.

ChangesProcessed ALL Number of coordinated cache
ObjectChangeSets for which an object was
found in the cache and merged.

MessagesReceived HEAVY  Number of cache coordination messages received.

MessagesSent HEAVY  Number of cache coordination messages sent.

RemoteChangeSets HEAVY  Number of change sets received from remote
machines and processed.

RCMStatus HEAVY  Cache coordination status: one of not
configured, started, or stopped.

Connection ConnectCalls HEAVY  Total number of connect calls made.

ConnectionsInUse (POOL_NAME) HEAVY  Number of connections in use for the given
connection pool.

DisconnectCalls HEAVY  Total number of disconnect calls made.

ConnectionManagement ALL Time spent managing connections including
connecting, reconnecting, and disconnecting from
a data source.

Query DatabaseExecute ALL Time spent in calls to the JDBC Statement.
Includes time spent in calls to: close,
executeUpdate, and executeQuery.

DeleteQueries HEAVY  Time spent executing delete queries, including
time spent in JDBC calls.

ObjectBuilding ALL Time spent building persistent objects from
database rows.

QueryPreparation ALL Time spent preparing a query. Does not include
time spent doing SQL prepare.

ReadQueries HEAVY  Time spent executing read queries, including time
spent in JDBC calls.

RowFetch ALL Time spent fetching the JDBC result set from the
database and building DatabaseRecord objects
from the JDBC result set. Includes regular SQL
calls and stored procedure calls.

SglGeneration ALL Time spent generating SQL. In the case of TopLink
expressions, includes time spent converting
Expression to SQL.

SqlPrepare ALL Time spent in JDBC preparing the Statement.
Includes the time spent in EIS creating an
Interaction associated with a connection, and
creating input and output Record objects.

UpdateQueries HEAVY  Time spent executing update queries, including

time spent in JDBC calls.
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Table 11-1 (Cont.) TopLink DMS Metrics

DMS Noun Name'  Sensor Name Level>  Description
WriteQueries HEAVY Time spent executing write queries, including time
spent in JDBC calls.
Session ClientSession HEAVY  Number of ClientSessions currently logged in.
loginTime NORMAL  Time at which the session was logged in. Once the
session is logged out, the sensor no longer appears.
SessionName NORMAL Name of the session.
UnitOfWork HEAVY  Number of UnitOfWork objects acquired from

this session.

Transaction DistributedMerge ALL Time spent merging remote transaction changes
into the local shared cache.
JtsAfterCompletion ALL Time spent on JTS afterCompletion method.
JtsBeforeCompletion ALL Time spent on JTS beforeCompletion method.
MergeTime ALL Time spent merging changes into the shared cache.
OptimisticLocks HEAVY Number of optimistic lock exceptions thrown.
Sequencing ALL Time spent maintaining the sequence number
mechanism and setting the sequence number on
objects.
UnitOfWorkRegister ALL Time spent in registering objects with the
UnitOfWork.
UnitOfWorkCommits ALL Time spent in the UnitOfWork commit process.
UnitOfWorkRollBacks HEAVY  Number of UnitOfWork commits that were rolled
back.
Miscellanous DescriptorEvents ALL Time spent by the DescriptorEventManager
executing a descriptor event.
Logging ALL Time spent logging TopLink activities.
SessionEvents ALL Time spent by the SessionEvent manager executing

a session event.

1 DMS noun names are followed by the name of the session to which they belong. For example, Cache (SESSION NAME) .

2 See Table 11-2 for a description of each level setting.
3 Cache Coordination

Table 11-2 DMS Metric Collection Levels

Level Description

NONE Disable collection of all DMS metrics.

NORMAL Enable collection of TopLink DMS metrics. Adds very low overhead. This is the
default setting.

HEAVY Enable collection of basic TopLink DMS metrics. Adds about 1 percent overhead.

ALL Enable all possible TopLink DMS metrics. Adds about 3 percent overhead.

Configuring the Oracle DMS Profiler

You configure DMS support in your TopLink application differently depending on the
type of application it is:

s OC4J Applications
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= Non-OC4] Applications

0C4J Applications

By default, DMS metric collection is enabled for TopLink CMP applications deployed
to OC4]J. For BMP or non-CMP applications deployed to OC4J, you must configure
DMS metric collection (see "Configuring a Performance Profiler" on page 74-10).

TopLink E]JB deployed in OC4J are subject to the DMS configuration specified by the
OC4] command line-property -Doracle.dms.sensors=<level> where <level>
is one of the values listed in Table 11-2.

Non-OC4J Applications

To enable DMS metric collection for TopLink applications deployed to an application
sever other than OC4] do the following:

1. Ensure that the dms . jar file is in your application classpath.
By default, the dms . jar file is located in <ORACLE HOME>\1ib directory.

2. Set system property oracle.dms.sensors=<level> where <levels> is one of
the values listed in Table 11-2.

3. To enable the DMS profiler, select the DMS profiler option when configuring your
TopLink session (see "Configuring a Performance Profiler" on page 74-10).

Accessing Oracle DMS Profiler Data Using JMX

Using the Java Management Extensions (JMX) API, you can publish DMS profiler
run-time data from a managed application (TopLink) to a JMX-compliant management
application, by way of EJB-like MBean components.

When you configure your TopLink application to enable run-time services (see
"Configuring a Performance Profiler" on page 74-10) and you deploy your application
to OC4], the TopLink runtime will deploy a JMX MBean so that a JMX management
application can access the DMS profiler run-time data your application publishes.

For code examples that illustrates how to use DMS and JMX, see
http://www.oracle.com/technology/tech/java/oc4j/1003/how
to/jmx-enabled-demo.html.

Accessing Oracle DMS Profiler Data Using the DMS Spy Servlet

Once your DMS enabled TopLink application is running, you can access the DMS data
i